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Предисловие
Мобилография — это новое направление в искусстве, которое возникло там, где
встречаются технологии фотографии и связи.

Телефоны, оборудованные фотокамерой, как правило, оснащаются поддержкой
MMS и GPRS. Это означает возможность мгновенного обмена графическими со-
общениями с другими владельцами сотовых. Часто фотография способна расска-
зать гораздо больше, чем многочасовой телефонный разговор или лавина SMS-co-
общений.

Людей, которые фотографируют мобильниками, называют мобилографами. Стать
мобилографом очень просто — сделайте снимок камерой вашего мобильника.

Мобилография — это среда свободных личностей, легко воспринимающих все но-
вое, интересное, ведущее за горизонты сегодняшних представлений о мире, вещах
и людях. Она превращает технически несовершенные фотоснимки, полученные с
маленьких матриц сотовых, в нечто весьма привлекательное. Иногда эти кадры
можно смело назвать произведениями искусства.

Как сравнительно новое явление в искусстве Мобилография вызывает много спо-
ров. Она неоднозначна и не все могут ее воспринять сразу. Но те, кто понял, что
Мобилография — их стихия, приносят в свою жизнь много красивого и интерес-
ного.

Эта книга призвана помочь всем тем, кто нашел в своей душе место для мобило-
графии и хочет сделать свои снимки лучше. Ведь Мобилография все же пошла от
фотографии, а это значит, что приемы фотокомпозиции вполне применимы к
мобилографиям. Только здесь надо уточнить, что одним из родоначальников
мобилографии является также цифровая фотография. Поэтому мобильные фото-
графии вполне поддаются цифровым приемам обработки графики. Всем этим
мы и займемся на страницах книги, которую вы сейчас читаете. Без долгих пре-
дисловий позвольте начать наше путешествие в мобилографию. Надеюсь, будет
интересно.



От издательства
Ваши замечания, предложения и вопросы отправляйте по адресу электронной по-
чты shakhov@piter.msk.ru (издательство «Питер», компьютерная редакция).

Мы будем рады узнать ваше мнение!

На сайте издательства http://www.piter.com вы найдете подробную информацию
о наших книгах.



Часть 1

Мобильники
и камеры

Глава 1. Технические средства и искусство
мобилографии



10 * Часть 1. Мобильники и камеры

Зачем мобильному телефону камера? На этот вопрос можно найти множество от-
ветов. Очень часто ее рассматривают лишь как средство для создания картинок-
заставок, которые можно поместить на экран телефона. Порой фотографии друзей,
которые делаются при помощи мобильной камеры, ассоциируют с их телефонами
в адресной книге. Иногда на этом все заканчивается — телефон звонит, выдает
фотографию друга и кажется, что иного применения камере не найти.

А ведь на самом деле мобильная камера — это своего рода чудо техники, которое
мы, избалованные прогрессом, просто не замечаем. И, кроме всего прочего, доволь-
но мощный инструмент, с помощью которого можно создавать прекрасные кадры.



ГЛАВА 1 Технические средства
и искусство
мобилографии

Q Объектив
Q Альтернатива выдержке
G Видоискатель
Q Вспышка
Q Светочувствительная матрица
О Память и коммуникации
Q Выбор фототелефона
О Компьютер для мобилографа
Q Фотография и мобилография
Q «Недостатки» мобилографии
G Выводы
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«Какие тут еще могут быть технические средства», — скажут скептики, имея в виду
простенькую на первый взгляд камеру мобильника. Но на самом деле мобильная
камера может быть описана вполне конкретными понятиями, которые помогут
мобилографу сделать свою творческую деятельность более продуктивной.

Мобилография возникла совсем недавно, в 2004 году Всемирное Общество Моби-
лографов (World Mobilography Society, www.mobilography.com) основал российский
фотограф, член Союза художников России Дмитрий Резван.

Посмотрите на рис. 1 цветной вклейки. Здесь вы можете видеть первую, знаковую
мобилографию, которая натолкнула его на мысль о том, что мобильный телефон с
камерой — это художественный инструмент. Дмитрий считает эту фотографию
одной из лучших в своей карьере фотографа, именно этот снимок был напечатан
в свое время в формате 160x120 и выставлялся в Союзе художников.

Теперь переходим к техническим средствам мобильной фотографии. Здесь мы
рассмотрим некий обобщенный случай, не останавливаясь на конкретных моделях
телефонов, оснащенных камерами. Дело в том, что все камеры, встроенные в мо-
бильники, очень похожи друг на друга. Различия между ними не носят принципи-
ального характера, поэтому все нижесказанное можно отнести практически к лю-
бому аппарату.

1.1. Объектив
Итак, как и в обычном цифровом фотоаппарате, основой камеры мобильника яв-
ляется ее оптическая система, или объектив. Как правило, он имеет очень малень-
кие размеры (рис. 1.1-1.3).

Рис. 1.1. Объектив Motorola C650 крупным планом

Это, однако, не мешает объективам мобильных телефонов обладать сравнительно
неплохими характеристиками.

До сих пор все без исключения доступные на рынке камерофоны (это альтерна-
тивное название мобильника с камерой, произошедшее от английского «camera-
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phone»), комплектуются объективами с постоянным фокусным расстоянием и фик-
сированным фокусом. Эти объективы сфокусированы таким образом, что предме-
ты, находящиеся на некотором расстоянии от них, выходят резкими.

Точно такие же по логике работы объективы устанавливаются в дешевые цифро-
вые и пленочные мыльницы. Очень часто около объектива камеры можно увидеть
гордую надпись вроде «4-х ZOOM». Правда, ничего кроме того, что камера обла-
дает цифровым зумом, это не обозначает. Цифровой зум — это программная обра-
ботка фотографии, при помощи которой увеличивается некоторая центральная
область кадра и выводится туда, куда ранее в/ыводился весь кадр.

Рис. 1.2. Объектив Sony Ericsson K700

То есть, например, в режиме обычной съемки на экран мобильника выводится ка-
кая-то картинка. Если задействовать цифровое зуммирование, то из первоначаль-
ной картинки будет взята ее центральная часть и увеличена до размеров экрана.
Цифровое зуммирование сродни увеличению размеров изображения в графиче-
ском редакторе. Такое увеличение не проходит даром для качества изображения.
Качество, как правило, страдает. Если вы планируете использовать ваши мобило-
графии вне сотового телефона, о цифровом зуме лучше забудьте, так как вы смо-
жете увеличить ваши кадры более продвинутыми методами на ПК.

Однако эту возможность не стоит отбрасывать совсем, особенно для чисто мобиль-
ного применения. Так, функция зуммирования, если вы планируете применять от-
снятые кадры только на мобильнике, способна достаточно сильно расширить гра-
ницы вашего творчества.

Продолжая разговор об объективах мобильных камер, нельзя не отметить тот факт,
что объективы эти, в большинстве своем, являются короткофокусными. Это зна-
чит, что объектив настроен таким образом, чтобы «захватить» как можно большую
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часть пространства. Такие объективы особенно полезны при съемке, например,
пейзажей, групп людей и так далее. Мобильник же очень часто применяют, кроме
всего прочего, для съемок портретов.

Портретная съемка имеет одну особенность — если снимать лицо человека со слиш-
ком маленького расстояния, начинают проявляться довольно сильные перспек-
тивные искажения. Дело в том, что при съемках, скажем, с расстояния в полметра,
те части лица, которые расположены ближе к камере, могут получиться немного
больше чем те, что находятся дальше — таковы законы перспективы. Если вы пла-
нируете применять снятый портрет, скажем, в адресной книге телефона, то это как
раз повод для того, чтобы при его съемке воспользоваться цифровым зумом аппа-
рата. Вы сможете получить изображение того же размера, что и при съемке в обыч-
ном режиме, но сделанное с большего расстояния.

Рис. 1.3. Nokia 6600 — вид сзади

Следующей деталью, без которой не обходится ни один объектив, является диа-
фрагма, то есть регулируемое отверстие в объективе, через которое проходит свет,
попадающий на светочувствительный материал. Естественно, есть она и в мобиль-
ной камере, правда, о регулируемости диафрагмы говорить пока не приходится. От
того, насколько сильно открыта диафрагма, зависит глубина резко изображаемого
пространства и количество света, попадающего на светочувствительную матрицу.
Чем сильнее открыта диафрагма — тем меньше глубина резкости, но больше ко-
личество света, проходящее сквозь объектив. Мобильники просто не могут обла-
дать маленькой глубиной резкости, поэтому производителям приходится как мож-
но сильнее закрывать диафрагму. Одной из характеристик объектива является
диафрагменное число. Диафрагменное число — это отношение фокального рассто-
яния объектива к диаметру эффективной диафрагмы. Чем меньше диафрагменное
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число, тем сильнее открыта диафрагма, тем больше света она может пропустить.
Это значит, что снимать можно будет в более сложных световых условиях и ис-
пользовать более короткие выдержки при съемке (в нашем случае, конечно, поня-
тие «выдержка» является условным). Это снижает риск «смазать» кадр.

Максимальная диафрагма, которую можно установить, обычно указана в названии
объектива — например, f/2,8. Как правило, объектив сотового характеризуется од-
ним-единственным диафрагменным числом.

Мобильники удивительно хорошо снимают в плохих условиях освещенности. Так,
когда я только начинал заниматься мобилографией, у меня был один интересный
случай. Мобильник, а именно Motorola C650, я пытался сравнить с неплохим
цифровиком Nikon Coolpix 3100. Когда цифровиком (без вспышки, естественно, и
на автоматических установках выдержки и диафрагмы) с рук снять что-либо было
довольно сложно, мобильник довольно хорошо делал свою работу. Конечно, если
сравнивать общее качество снимков, то цифровик будет впереди, но конкретные
результаты съемки в сопоставимых условиях показали, что камерофон является
вполне адекватным устройством для фотографических целей.

1.2. Альтернатива выдержке
Немного выше мы затронули такой вопрос, как установка выдержки. Традицион-
ной выдержки, регулируемого затвора, например, в мобильнике нет. Выдержку,
видимо, заменяет частота сканирования светочувствительной матрицы. К такому
выводу можно прийти, если понаблюдать за практически любым телефоном, на-
ходящимся в режиме ночной съемки. В таком режиме изображение в видоискате-
ле мобильного фотоаппарата, о котором будет сказано ниже, становится весьма
сильно замедленным. А если попытаться сделать снимок, то после нажатия на
кнопку съемки пройдет иногда даже пара секунд до того, как фотография будет
получена. Такая реализация выдержки расширяет творческие возможности моби-
лографа.

Традиционно «смазанность» кадров, вызванная движениями фотоаппарата в мо-
мент спуска затвора, считается недостатком, с которым борются различными спо-
собами, самым эффективным из которых является использование штатива при
съемке. В случае же с мобилографией возможность легко и динамично управлять
движением аппарата в момент съемки открывает мобилографу дополнительные
творческие горизонты.

1.3. Видоискатель
Как уже было сказано, видоискателем при мобильной съемке выступает дисплей
телефона. Даже средние по стоимости современные аппараты имеют дисплей, ко-
торый часто позволяет сносно снимать в уличных условиях освещения. Конечно,
на ярком солнце такой экран неминуемо «ослепнет», но этот недостаток свойстве-
нен и для не самых плохих TFT-дисплеев дорогих цифровиков.
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Подавляющее большинство фототелефонов позволяет довольно комфортно пользо-
ваться дисплеем-видоискателем.

Скажем, при частоте обновления 15 кадров в секунду вы уже вряд ли заметите се-
рьезное отставание картинки на дисплее от реальности.

1.4. Вспышка
Следующим техническим средством мобилографии можно назвать вспышку. Она
пока нечасто встречается в камерофонах, да и сама вспышка, по сути, вспышкой
не является. Обычно в качестве вспышки используется достаточно сильная лам-
почка постоянной подсветки или группа из нескольких светодиодов (рис. 1.4).

Рис. 1.4. Siemens CFX 65 со встроенной светодиодной вспышкой

К некоторым телефонам можно приобрести внешнюю вспышку в качестве допол-
нительного аксессуара, подключаемого к интерфейсному разъему, на мой взгляд,
полезность такого аксессуара весьма сомнительна, так как вспышка это достаточ-
но слабая. Однако по аналогии с цифровым зумом она все же может расширить
творческие границы мобилографа.

Кстати, некоторые модели телефонов, не имеющие камеру, по-моему, среди совре-
менных моделей такое практически не встречается, могут быть оснащены внеш-
ней камерой. Как правило, такая камера никаких принципиальных преимуществ
перед встроенной камерой не имеет. Обсудив внешние особенности камер, пере-
ходим ко внутренним, а именно к такой, на первый взгляд, важной характеристи-
ке камеры, как разрешение светочувствительной матрицы.
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1.5. Светочувствительная матрица
Светочувствительная матрица современных сотовых имеет, как правило, разреше-
ние от 0,1 до 1 и даже более мегапикселов. Сейчас создаются мобильники с 3- и
более мегапиксельными матрицами, которые оснащают неплохой оптикой. Эти со-
товые телефоны уже сложно классифицировать как «телефон со встроенной ка-
мерой», так как, честно говоря, не совсем понятно, что во что встроено.

В этом издании мы будем ориентироваться на 0,3-мегапиксельные камерофоны.
Это разрешение, которое может быть представлено как 640x480, еще называемое
VGA, является, видимо, самым распространенным сегодня. Некоторые телефоны
еще комплектуются матрицами с меньшим разрешением — обычно это 288x352.
Данные аппараты позволяют заниматься мобилографией без каких-либо принци-
пиальных ограничений, но 640x480 все же предпочтительнее.

Посмотрите на рис. 1.5. Здесь для наглядности приведены различные разрешения
матриц современных цифровых фотоустройств.

352x288
•:;• •:. •••••,, • -
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Рис. 1.5. Разрешения светочувствительных матриц

В одной из следующих глав будет показано, как при помощи средств Photoshop
можно довольно качественно интерполировать VGA-кадры до 2-мегапиксельного
разрешения. В данном случае все зависит от сюжета фотографии — пейзаж вряд



18 •:• Глава 1. Технические средства и искусство мобилографии

ли удастся качественно интерполирвать, а вот портрет крупным планом вполне
можно попытаться увеличить.

1.6. Память и коммуникации
Следующим элементом камерофона, имеющим важное значение для съемок, явля-
ется объем встроенной памяти. Как правило, достаточно сильно сжатый (640x480)
снимок может занимать 20-100 Кбайт памяти.

На практике для разных аппаратов этот показатель может колебаться между
30-60 Кбайт на снимок. Один и тот же уровень сжатия на разных изображениях
приводит к различному размеру выходного файла.

Лишней памяти не бывает, но даже на телефоне со, скажем, 800 Кбайт свободной
памяти можно сохранить до 40 кадров. Пятимегабайтный объем уже просто нере-
ально «забить» фотографиями даже в очень фотоинтересный день.

Раз уж речь зашла об объеме встроенной памяти, уместно будет упомянуть сред-
ства для передачи отснятых кадров на ПК.

Существует несколько способов такой передачи. Это может быть дата-кабель, ин-
фракрасный порт, Bluetooth-соединение или передача файлов по MMS на e-mail.

Наиболее адекватными способами являются первые три, так как они позволяют
передавать между мобильником и компьютером неограниченные объемы инфор-
мации, однажды купив коммуникационное оборудование. Подробности об ис-
пользовании различных средств коммуникации между ПК и сотовым читайте
в приложении.

1.7. Выбор фототелефона
Обсудив особенности технического оснащения фототелефонов, попытаемся нари-
совать портрет «идеального» сотового со встроенным цифровым фотоаппаратом.

Для начала хочу сказать, что уже довольно скоро подавляющее большинство со-
товых телефонов будет оснащено встроенными камерами.

Если посмотреть на сотовые стоимостью от примерно 5000 рублей или даже де-
шевле, то окажется, что практически все они оснащены камерами. Без камер се-
годня остались лишь самые дешевые модели, которые предназначены исключи-
тельно для обеспечения доступной связи.

Итак, с ценовым диапазоном мы определились. А теперь я скажу достаточно пара-
доксальную, но тем не менее справедливую фразу по поводу выбора камерофона.
Выбирая телефон, обратите внимание на его дизайн, эргономичность, функцио-
нальность, стоимость, а на камеру внимания можете не обращать — отметьте для
себя ее наличие и этим ограничьтесь.
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Почему же? Все очень просто. Если начать сравнивать камеры разных мобильни-
ков, то получится примерно одно и то же. Единственно, посмотрите на разреше-
ние сенсора, все же, желательно, чтобы это было 640x480. Правда, если вам нра-
вится телефон, камера которого имеет разрешение 288x352 — берите его и, уверен,
вы останетесь довольны.

По поводу производителя телефона — от комментариев по этому поводу позволю себе
воздержаться, так как сотовые это весьма противоречивые устройства. Все они
примерно одинаковы по реализации типичных функций, качеству связи и фото-
графий. Единственно, довольно часто у людей складываются определенные пред-
почтения, которые они волей-неволей навязывают другим. Всегда можно найти
как фанатов, так и ярых ненавистников тех или иных фирм-производителей. По-
этому предлагаю вам быть выше всего этого и выбирать то, что вам нравится, невзи-
рая на предрассудки. Уже одно то, что фирма-производитель смогла вывести свой
продукт на рынок, позволяет говорить о достаточном качестве этого продукта.

Кстати, если вы ищете идеальный телефон с идеальной камерой — тогда вы риску-
ете остаться вовсе без покупки. Идеальных телефонов, равно как и других уст-
ройств, попросту не существует — при желании можно раскритиковать или захва-
лить любой аппарат. Ищите компромиссы, на которые вы готовы пойти, и тогда,
уверен, ваш камерофон будет только радовать вас.

Но мобилография состоит не только из съемки кадров фототелефоном. Немалое
значение имеет и выбор компьютера для редактирования мобилографий. Некото-
рые соображения по этому поводу читайте ниже.

1.8. Компьютер для мобилографа
Для редактирования мобилографий нужен персональный компьютер. Ниже я по-
стараюсь дать некоторые общие рекомендации по его выбору. Собственно говоря,
если у вас есть компьютер, на котором установлен и успешно работает Photoshop
CS, это значит, что вы и сами прекрасно знаете, чего вам не хватает. А если же вы
только собираетесь стать владельцем этого электронного помощника — тогда чи-
тайте дальше.

Для начала хочу сказать, что для редактирования мобилографий подойдет прак-
тически любой современный компьютер. Наибольшую важность для приложений,
работающих с растровой графикой, к которым относится и Photoshop, играют та-
кие компоненты ПК, как процессор и оперативная память. Если говорить о про-
цессоре, то вы можете выбирать из очень широкого спектра. Это может быть
Pentium 4, Celeron разных модификаций от Intel или изделия от AMD.

О борьбе этих двух процессорных гигантов написано уже очень много, поэтому
я лишь хочу сказать, что выбрав процессор любой из двух компаний, вы не пожа-
леете. Теперь о частоте процессора. Она, для комфортной работы в современных
приложениях, должна находиться где-то в районе 2 ГГц, вполне допустимо отступ-
ление от этой величины мегагерц на 500 в меньшую сторону. Как вы понимаете,
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чем больше частота процессора — тем выше итоговая производительность вашей
системы. Поэтому если в названии вашего процессора будет фигурировать цифра
в районе 3 ГГц, то это будет только плюс.

Оперативная память также является важнейшим элементом нашей графической
системы. Фактически, она подбирается под процессор, поэтому рассуждать о том,
какая память лучше, особого смысла нет. А вот ее объем — это вопрос весьма акту-
альный. 256 Мбайт являются тем показателем количества памяти, на который есть
смысл идти, только если вы хотите сэкономить.

Вы сможете работать в Photoshop CS, довольно комфортно использовать компью-
тер для других целей, но при обработке достаточно масштабных проектов памяти
не хватит однозначно. В процессе работы будет интенсивно использоваться файл
подкачки Windows, что гарантированно превратит часть вашей деятельности в
ожидание выполнения следующей операции. Поэтому постарайтесь, чтобы ваш
новый ПК содержал по крайней мере 512 Мбайт ОЗУ. Больше тоже можно, но это
уже не так принципиально.

Жесткий диск является достаточно противоречивым устройством — с одной сто-
роны вы можете взять практически любой винчестер гигабайт так на 80 и наслаж-
даться жизнью — он вряд ли вас разочарует в плане производительности. С дру-
гой стороны, если вы особо не стеснены в средствах, есть смысл задуматься о
системе как минимум с 2 винчестерами. Нужно это для того, чтобы разместить на
разных жестких дисках файл подкачки Windows и Scratch-файл Photoshop.

Сколько бы ни было оперативной памяти, эти файлы все равно активно использу-
ются, поэтому такое распределение нагрузки пойдет на пользу общей производи-
тельности системы. А пара винчестеров — это уже тема для разговора о RAID-мас-
сиве.

Следующим компонентом ПК является видеокарта. В нашем случае этот компонент
совершенно некритичен. Photoshop работает в основном с достаточно простой ра-
стровой графикой, для вывода которой на экран не нужно особых видеомощно-
стей. Вы с чистой совестью можете сэкономить на видеокарте, взяв карточку сред-
него уровня. В принципе, практически все современные видеокарты подходят для
наших целей — проще говоря, если видеокарта стоит примерно от 1400 рублей —
это значит, что она вам подойдет.

Объем видеопамяти, учитывая то, что сейчас очень трудно найти видеокарту
с меньшей, чем 32 Мбайт видеопамятью, так же некритичен. Еще один важный мо-
мент при покупке видеокарты (это требование, как правило, выполняется по умол-
чанию). Проследите за тем, чтобы выбранная вами видеокарта «держала» рабочее
разрешение вашего будущего монитора как минимум при 85 кадрах в секунду.

Если говорить о других важных компонентах системы, то здесь можно отметить
наличие CD- или DVD-RW-дисковода. Вообще, такой дисковод не помешает не
только тем, кто работает с графикой. На тех же CD-RW-дисках очень удобно хра-
нить резервные копии ваших фотоархивов, записывать файлы для демонстрации
их вашим друзьям и так далее. Жесткие диски, конечно, достаточно надежные уст-
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ройства для хранения информации, но только представьте себе ваши ощущения,
если вдруг ваш цифровой фотоархив года так за полтора окажется безвозвратно
утраченным. Поэтому я прямо-таки настоятельно рекомендую вам обзавестись
подобным дисководом и спать спокойно, не опасаясь потери данных.

Кстати, данные могут быть потеряны не только в результате «железного» сбоя.
Вирусы, которые то и дело заставляют говорить о себе, — это тоже одна из возмож-
ных причин потери информации. Да что там вирусы — уверен, практически у каж-
дого из вас бывали случаи случайного удаления важных данных. Поэтому CD- или
DVD-RW — это очень важная деталь вашего будущего компьютера. Обсудив внут-
реннюю часть ПК, переходим к внешней, а именно к монитору.

Если вы не профессиональный фотограф, то вы вряд ли будете покупать про-
фессиональный монитор, который может стоить в районе $1000. Однако предла-
гаю принять как данность тот факт, что на мониторе лучше не экономить. Пусть у
вас будет не самый быстрый процессор, мало оперативной памяти и маленький же-
сткий диск, но монитор должен быть лучшим из того, что вы можете себе позво-
лить.

Если говорить о размерах монитора, то 17-дюймового CRT или 15- (а то и 14-дюй-
мового) LCD вполне хватит для работы с графикой. Вы, конечно же, можете по-
смотреть и на большие по диагонали мониторы.

О выборе технологии изготовления монитора надо сказать особо. В данный мо-
мент вы можете выбирать из CRT-мониторов, сделанных по электронно-лучевой
технологии и LCD-мониторов, то есть мониторов на жидких кристаллах.

Мое субъективное мнение заключается в том, что предпочтительнее ориентиро-
ваться на LCD-мониторы. По этому поводу ведутся жаркие споры, я спорить и пе-
реубеждать кого-то не хочу, просто приведу факты, подсказанные мне практикой.

Во-первых, ЖК-мониторы не мерцают. Технология их изготовления предусматри-
вает статичность выводимого изображения. ЭЛТ же мониторы, в противовес это-
му, по технологии своей работы, выводят на экран изображение с какой-то конеч-
ной частотой кадров. Считается, что после 85 Гц, то есть 85 кадров в секунду,
мерцания уже не видно. Да, это так, но если вы привыкли к LCD и вдруг попада-
ете к CRT-монитору, почти наверняка его изображение покажется вам слегка мер-
цающим. Мерцание можно увидеть боковым зрением, если смотреть как бы поверх
монитора. Далее, жидкокристаллические мониторы считаются более безопасны-
ми для здоровья. Для меня, например, это решающий параметр.

LCD экономнее используют электроэнергию и меньше по размерам, чем CRT. Это,
видимо, не самые важные показатели, но и их нельзя сбрасывать со счетов. Конеч-
но, LCD имеют не только отличия в лучшую от CRT-мониторов сторону.

Так, под разными углами зрения изображение на практически любом ЖК-мони-
торе слегка изменяется. У LCD-мониторов меньшие углы обзора, чем у CRT, од-
нако если работать с жидкокристаллическим монитором на достаточном расстоя-
нии, то данный эффект особо жить не мешает.
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Как правило, подобные недостатки видны лишь при тестировании монитора. При
практической же работе происходит довольно быстрое привыкание к этим свой-
ствам, их компенсация (все же наша зрительная система способна и к более серь-
езной адаптации), и все выглядит отлично.

Иногда LCD ругают за их цветопередачу — ругают не всегда обоснованно, особен-
но в применении к домашнему использованию монитора. Конечно, для работы с
графикой наиболее предпочтительными являются профессиональные мониторы,
но стоимость одного такого монитора с лихвой перекроет цену всей нашей фото-
студии.

Изображение на LCD не подвержено геометрическим искажениям в противо-
вес CRT, но это непринципиально, так как является лишь вопросом настройки
CRT-монитора.

Далее, недостатком жидкокристаллических мониторов называют инерционность
их матриц — движущиеся объекты могут оставлять за собой шлейф. На самом деле
это не такая большая проблема — по крайней мере, в обычном применении. Если
же вы собираете игровой компьютер, то вполне возможно, что легкая инерцион-
ность будет вам мешать, в нашем же случае это не слишком важно.

Приведя все эти рассуждения, я никоим образом не настаиваю на том, что LCD-
мониторам должно быть отдано безусловное предпочтение. Решайте сами. Но по-
старайтесь, чтобы в любом случае вы взяли лучший монитор из тех, что можете
себе позволить. А если уж вы работаете на CRT-мониторе, проследите за тем,
чтобы частота его развертки была хотя бы на 85 Гц при вашем рабочем разре-
шении.

Из других важных деталей вашего будущего ПК хочу отметить UPS — источник
бесперебойного питания. Если в вашей местности случаются внезапные отключе-
ния электроэнергии, или кто-нибудь любит побаловаться с распределительным
щитком в вашем подъезде — обязательно обзаведитесь UPS.

Кстати, вы вполне можете остановить свой выбор на ноутбуке. «Общая теория
выбора» для ноутбуков ничем не отличается от настольных компьютеров. Разве
что монитор будет по умолчанию LCD.

Когда компьютер и фототелефон готовы к работе, самое время приступить к про-
цессу съемок. А начнем мы со сравнения обычной фотографии и обсуждения не-
которых особенностей мобилографии как таковой.

1.9. Фотография и мобилография

Съемка обычным фотоаппаратом — неважно, цифровым или пленочным, подразу-
мевает использование достаточно громоздкого устройства, специальную органи-
зацию съемочного процесса. Например, возьмем элементарную съемку домашних
фотографий. При виде пленочной мыльницы многими людьми овладевает чувство
скованности. На лицах оказываются дежурные улыбки. Снимаемые застывают
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в наиболее выгодных на их взгляд позах, замирают, ожидая щелчка затвора, а по-
том с облегчением начинают заниматься своими делами. Если даже попробовать
более подвижный стиль съемки при помощи той же домашней мыльницы — обыч-
но ничего хорошего не выходит. После первой же неожиданной вспышки ориги-
нальных кадров уже может и не получиться, так как к вашему появлению успеют
подготовиться.

Носить с собой немаленький фотоаппарат, даже цифровой, в надежде увидеть что-
нибудь интересное, красивое, и снять это на память, мало кто станет. И карманы
оттопыриваются неслабо, и весят фотоаппараты, в лучшем случае, грамм под 300.
Какой вывод можно сделать из всего вышесказанного? Да очень простой — все
неувязки вышеописанных моментов легко и непринужденно решает мобило-
графия.

Мобильник никто не воспринимает как серьезное средство для съемок. И для фо-
тографа, и для снимаемых он сродни игрушке, с которой спрос невелик. Раз так,
значит фотограф начинает снимать легко и непринужденно, а снимаемые переста-
ют позировать. В целях эксперимента наведите на кого-нибудь из близких объек-
тив обычного фотоаппарата и объектив мобильника. Почувствовали разницу?

А как насчет уличных съемок, разных интересных моментов и других подобных
вещей? Здесь все так же очень просто — мобильник уже стал для многих постоян-
ным спутником, который большую часть дня находится на расстоянии вытянутой
руки. Кстати, по поводу постоянного «общения» с мобильником сейчас существу-
ет множество споров. Речь идет о возможном влиянии излучения мобильного те-
лефона на здоровье человека. До сих пор никто не доказал, что это излучение вред-
но, но нет и доказательств его безвредности. Нужно знать, что воздействие есть и,
думается, есть смысл сводить его к минимуму. Например, старайтесь не носить те-
лефон в карманах, на поясе, на шее и так далее — в сумку его, и все будет хорошо.
Но вернемся к мобилографии.

Так как телефон постоянно находится на расстоянии вытянутой руки — это зна-
чит, что снимок вы можете сделать в любой нужный для вас момент. К тому же,
многие модели камерофонов имеют специально выделенные или запрограммиро-
ванные кнопки для быстрого доступа к функциям камеры. Это значит, что сделать
снимок вы сможете очень быстро и оперативно, в любом месте и в любое время.

Иногда мобилографию критикуют именно за эту оперативность, говоря о том, что
таким образом можно делать различные компрометирующие снимки, снимать в
раздевалках, бассейнах и так далее. Но это, на мой взгляд, проблема не мобилогра-
фии, и не фотографии вообще, а лишь тех людей, которые занимаются подобными
съемками, их моральных правил и воспитания.

То есть в результате можно сказать, что фундаментальное отличие мобилографии
от обычной фотографии заключается в изменении стиля съемок, отношения к ней
фотографа и тех, кого он снимает. Далее, как уже упоминалось, мобилография —
это все же не только синтез устройств, но и синтез технологий. Кстати, мобило-
графия как явление вполне подпадает под модное сегодня понятие «конвер-
генция». В данном случае это конвергенция мобильной связи и фотографии. На
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базе мобилографии могут быть созданы СМИ будущего. Например, что-то вроде
«живой ленты новостей», когда люди со всего мира имеют возможность присылать
свежие фото с мобильника, снабженные текстовыми комментариями на опреде-
ленные сайты. Нечто подобное, правда в несколько ином виде, сейчас существует
на сайте Всемирного Общества Мобилографов.

Мобилография позволяет создавать прекрасные кадры буквально всем жела-
ющим. Если вы сняли кадр мобильником, а потом увидели, что смотрится-то он
здорово, вполне возможно, что так оно и есть. «Виновата» в этом все та же внут-
ренняя раскрепощенность вас как фотографа в момент съемки. Продолжая срав-
нение, нельзя не вспомнить о техническом качестве мобилографии и различных
условиях съемочного процесса, влияющих на результат.

1.10. «Недостатки» мобилографии

Слово «недостатки» в заголовке этого пункта не случайно взято в кавычки. На са-
мом деле это далеко не недостатки, а очень интересные, часто уникальные и непов-
торимые особенности мобилографии как нового вида фотоискусства.

Если рассматривать мобилографии с формальной точки зрения, то весьма часто их
техническое качество оказывается весьма низким. Виноваты в этом простенький
объектив, маленькая, иногда, несмотря на низкую светочувствительность, доволь-
но шумная матрица. Я даже не говорю о довольно низком по современным меркам
разрешении матрицы и сильном JPEG-сжатии. Но это все формальности. На са-
мом же деле все вышеперечисленные, а так же некоторые другие «недостатки» ча-
сто являются очень интересными особенностями или даже достоинствами моби-
лографии.

Так, снимки, сделанные мобильником, практически все без исключения подверга-
ются довольно сильному JPEG-сжатию. Так называемые артефакты сжатия хоро-
шо заметны на этих фотографиях. Причем, если на экране мобильного телефона
все может выглядеть довольно пристойно, при рассматривании того же снимка на
компьютере может оказаться, что изображение довольно сильно попорчено. Тут
же возникает вопрос: а недостаток ли это? Для чисто утилитарных целей — да.
И ниже мы рассмотрим способы улучшения внешнего вида фотографий именно с
позиций повышения качества изображения. А вот с художественной точки зрения
артефакты сжатия — это особенность, интересная и практически недостижимая
какими-либо другими средствами.

Что интересно, разные мобильники дают разную «картину артефактов». Видимо,
это вызвано тем, что вместе со вполне стандартным алгоритмом сжатия исполь-
зуются различные фирменные технологии улучшения качества изображения.
Комбинация этих фактов и приводит к своеобразности фотоснимков, сделанных
разными мобильниками.

Мобилография активно использует смазанность кадров, которая в традиционной
фотографии обычно рассматривается как недостаток.
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Посмотрите на рис. 1.6 (Дмитрий Резван, «Мобилография»). Здесь смазанность
главного объекта съемки добавляет снимку динамизма, определяет направление
и характер движения.

Рис. 1.6. Дмитрий Резван, «Мобилография»

Это отличный пример того, как использование длинных «выдержек» мобильного
телефона может быть использовано в художественных целях.

Заметьте, это необработанный снимок, полученый прямо с матрицы мобильника.

Как уже было сказано, артефакты сжатия в данном случае не являются недостат-
ками — как раз наоборот.

Двигаться при съемке может не только ее объект, но и сам мобильник.

Представьте себе фотографа, который пытается совместить движение фотоаппа-
рата и спуск затвора — у меня это не получается.

С одной стороны возникает образ случайно разбитого фотоаппарата, а с другой —
такой стиль съемок абсолютно не вяжется с образом традиционной фотографии.

В мобилографии же возможность движения, наоборот, очень ценна. Во-первых,
движение мобильника способно весьма интересно «искривлять» пространство.
Посмотрите на рис. 1.7 (фото автора, съемка в движении).
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Рис. 1.7. Фото автора, съемка при движении аппарата

Здесь пространство не только искривлено, но и смазано. К тому же кадр сделан
в несколько необычном ракурсе. Кстати, интересного эффекта можно добиться,
вращая мобильник вокруг какой-то оси, параллельной оси камеры в момент съем-
ки. Рисунок 1.7 сделан с использованием подобной техники, только здесь враще-
ние было скомбинировано со сдвигом.

Помимо вращения и сдвигов, интересные эффекты получаются в результате при-
ближения или удаления телефона от объекта съемки в момент «спуска затвора».
Вообще, для достижения наибольшей эффективности вышеописанных эффектов
желательно перевести мобильник в режим ночной съемки. Тогда матрица будет
экспонироваться достаточно долго, что и позволит делать эффектные смазанные
кадры.

Техника приближения или удаления телефона от объекта съемки позволяет де-
лать достаточно интересные кадры, иногда карикатурного характера. Если попы-
таться снимать таким образом освещенные предметы в темноте, то результаты
могут быть весьма красивыми и неожиданными.

Интересными получаются кадры, изображающие людей, — нечто вроде портрет-
ного крупного плана. Техника их исполнения такова: переведя фотоаппарат в ре-
жим ночной съемки надо, начав съемку примерно сантиметров с 30 от снимаемо-
го, быстро отвести или приблизить к нему фотокамеру, постаравшись совместить
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момент экспонирования матрицы с движением. В результате камера зафиксиру-
ет образ, являющийся измененным изображением снимаемого.

Вряд ли это у вас получится сразу, но немного попрактиковавшись, вы сможете
делать такие снимки. Единственно, не советую фотографировать таким образом
людей без чувства юмора. Посмотрите на рис. 1.8 (фото автора, съемка с прибли-
жением).

Рис. 1.8. Съемка с приближением

Камерофоны, как правило, содержат программное обеспечение начального уров-
ня для работы с фотографиями. Обычно оно позволяет тонировать изображения в
различные цвета (обычно в синий, зеленый и красный), иногда кадрировать и при-
менять различные спецэффекты, вроде создания рамок.

Эти эффекты имеют значение для мобильного использования, если же вы хотите
редактировать ваши мобилографии на компьютере, самое лучшее, что вы можете
сделать — оставить их в оригинальном виде.

1.11. Выводы

Техническую сторону и особенности мобилографии мы с вами обсудили. К неко-
торым вопросам мы будем возвращаться по ходу повествования. Дальше нас ждет
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очень важный и интересный раздел, посвященный вопросам композиции в моби-
лографии.

То, что громоздкий фотоаппарат был заменен легким и маленьким мобильником,
не отменяет веками сложившихся правил композиции.

На первый взгляд может показаться, что мобилография свободна от таких «услов-
ностей», как правило золотого сечения, ритмические построения или законы пер-
спективы.

Но на самом деле это далеко не так — просто законы в случае с мобилографией
превращаются в приятное дополнение к свободному от предрассудков процессу
съемок.
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Мобшюграфия отличается от традиционной фотографии, даже от цифровой, дос-
таточно сильно. Если же сравнить пленочную и цифровую фотографию, то ока-
жется, что между ними немного принципиальных различий. Конечно, меняются
способы получения изображения, светочувствительная матрица и флэш-карта
заменяют фотопленку, но в целом все остается точно так же. Те же сравнительно
громоздкие фотоаппараты, тот же стиль съемок и те же правила.

Естественно, мобилография не может, да и не должна отказываться от всего того,
что было наработано в области фотографии. Правила композиции, например, никто
не отменял. Однако мобильная фотография имеет множество новых черт, которые
отличают ее от других видов искусства съемки. Мы уже обсудили некоторые из
них. А сейчас я предлагаю вашему вниманию рассказ о композиции применитель-
но к мобилографии.
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Фотографировать можно по-разному. Можно делать серии случайных снимков,
снимать почти «не целясь». А потом, разбирая десятки или сотни отснятых кад-
ров, находить среди них настоящие сокровища, поражающие своей красотой и
живостью. Такой подход к съемке вполне имеет право на жизнь. Но думается, что
гораздо лучше хоть как-то планировать съемочный процесс, каким бы неуместным
это ни казалось в применении к мобилографии.

Фотография, чем бы она ни была сделана, всегда останется фотографией, а значит,
к ней можно применять обычные для фотоискусства художественные методы и вы-
разительные средства.

Мобилография при всей своей авангардности ничуть не отрицает художественных
правил, которые находят применение в обычной фотографии. Поэтому далее
мы поговорим о композиции. Будут даны некоторые универсальные соображения,
проиллюстрированные обычными фотографиями и мобилографиями. Это нужно
для того, чтобы сделать данный раздел подходящим для всех владельцев мобиль-
ников — ведь ни для кого не секрет, что уже сейчас создаются (фактически, уже
существуют) мобильники, фотовозможности которых вплотную подходят к воз-
можностям обычных цифровых камер. Поэтому обратите особое внимание на про-
должение данной главы, проиллюстрированное фотографиями нескольких фото-
графов.

Среди них Эрнест Брендель, Михаил Рейфман, Александр Каасик, здесь же вам
попадется пара моих фотографий и мобилографии основателя Всемирного Общества
Мобилографов Дмитрия Резвана. Вы без труда сможете использовать большин-
ство из описанных приемов в своей мобильной фотопрактике. Разве что некото-
рые вещи сегодня с трудом доступны мобильникам. Но это — дело поправимое.
Поэтому позвольте начать.

2.1. Выразительные средства фотографии,
композиция
Композицией в фотографии, а значит, и в мобилографии, называется объединение
отдельных частей, элементов в единое художественное целое. «Композиция» в пе-
реводе с латинского означает сочинение, составление, соединение, связь. В нашем
случае это означает построение изображения, поиск оптимального соотношения
отдельных его частей, которые, в конечном счете, образуют единое изображение.

Композиционный замысел фотографа связывает отдельные части снимка воеди-
но. Композиция отражает реальную действительность, которая преломляется в
сознании автора фотографии, его понимании темы, осмыслении им окружающего
мира.

Создавая композицию, фотограф, основываясь на объектах реального мира, при-
дает им определенную смысловую направленность, используя различные вырази-
тельные средства фотографии. Это может быть использование света и тени, цвета,
перспективы, различных точек съемки, ритмические построения и так далее.
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Главная задача фотографа, мобилографа заключается в том, чтобы видеть в про-
исходящих вокруг него явлениях что-нибудь необычное, красивое, трогательное.
Фотограф, придав увиденному выразительную окраску, покажет это тем, кто уви-
дит в будущем его фотографии. Выразительные средства фотографии и работа над
композицией помогают сделать снимки лучше.

Я не берусь утверждать, что фотографические правила обязательны для точного
и неукоснительного следования им. Если вы видите, что отступление от класси-
ческих правил композиции пойдет снимку на пользу, — не сомневаясь экспери-
ментируйте. Вполне возможно, что именно нарушение правил позволит вам сде-
лать уникальный снимок. Однако правила нужно, по крайней мере, знать для того,
чтобы сознательно нарушать их.

Кстати, практически любой удачный фотоснимок можно «прочесть», увидев в нем
замысел фотографа и его композиционные построения. Даже если случайный кадр
кажется вам очень удачным — присмотритесь к нему повнимательнее — с очень
высокой долей вероятности вы сможете увидеть в нем законы композиции. Здесь
я предлагаю вашему вниманию краткий курс композиции, который, все же, помо-
жет вам снимать хорошие, а возможно, даже очень хорошие мобилографии.

2.2. Работа над композицией

Композиция кадра может быть построена на симметрии и асимметрии, статике
и динамике, на контрастах и аналогиях, композиция должна учитывать особенно-
сти восприятия снимка зрителем, удерживать взгляд внутри кадра, не давать ему
повода «выйти за рамки фотографии», хотя при определенных условиях такое по-
строение кадра, когда что-то преднамеренно остается недосказанным, является
оправданным.

Такие «кадры с продолжением» очень часто получаются у мобилографов. Порой
кажется, еще немного, и картинка оживет, превратившись из фотографии в видео-
клип, или даже «затянет наблюдателя», с головой погрузив его в события, изобра-
жаемые на ней.

Работая над композицией того или иного кадра (мобилографу очень часто на эту
работу отводится меньше секунды), важно представлять себе то, какое впечатле-
ние этот кадр должен оказать на зрителя. Кадры не рекомендуется перегружать
деталями — стремитесь к четким и лаконичным композиционным решениям. Это
не значит, что все ваши снимки должны состоять из какого-то одного предмета,
изображенного на однородном размытом фоне.

Напротив, многоплановая композиция, выверенная фотографом, позволяет доби-
ваться очень хороших результатов, иногда потрясая зрителя красотой и живостью
полученного снимка. Но композиция лаконичная доступна даже начинающему
фотографу, которому часто бывает сложно отделить главное от второстепенного.
А если сам фотограф не знает, зачем ему тот или иной объект на фотографии, —
как узнают об этом зрители?
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Мобилография очень динамична, и мобилографии тем и ценны, что позволяют
передавать различные интересные моменты жизни, как бы замораживая их. На
каждой фотографии, сделанной мобильником, ценно абсолютно все — каждая ме-
лочь может вызвать множество ассоциаций и повлиять на восприятие фотосним-
ка зрителем только в лучшую сторону. Но, опять же, посмотрите на удачную мо-
билографию — она, как правило, лаконична и достаточно строга.

2.3. Золотое сечение, восприятие снимка
зрителем
Для правильного построения сложной композиции может быть использовано
правило золотого сечения. Золотое сечение — это такое деление отрезка на ча-
сти, при котором весь отрезок так относится к большей части, как сама боль-
шая часть относится к меньшей. Значение золотого сечения приблизительно
равно 0,618. В приближенном виде это будет 5/8 или, чего вполне достаточно для
фотографии, 2/3-

Кадры, построенные с применением правила золотого сечения, выглядят гармо-
нично. Это явление до сих пор не объяснено, но золотое сечение чрезвычайно рас-
пространено в природе.

Применение золотого сечения внутри кадра заключается в том, чтобы располагать
значимые его элементы примерно на расстоянии '/3 от края. Это широко извест-
ное, применяемое в фотографии правило третей. Если сместить элементы выше
или ниже крайних точек, то кадр потеряет равновесие, будет дисгармоничным,
хотя это может быть использовано в качестве специального художественного при-
ема. А если же объект будет смещаться к центру композиции, она приобретет ста-
тичный, иногда даже скучный, хотя и устойчивый вид.

В частности, снимая пейзаж, надо постараться разместить линию горизонта при-
мерно на У3 от края кадра от верхнего или нижнего — это уже зависит от того, что
важнее в кадре — небо или земля. Если разбить кадр на части параллельными его
сторонам линиями, как показано на рис. 2.1 (фото автора, мобилография), тогда
на их пересечении мы получим так называемые «активные точки», зрительные
центры.

Если разместить элементы композиции около зрительных центров, это, с одной
стороны, делает кадр динамичнее, а с другой, оказывает сильное психологическое
влияние на человека, рассматривающего фотографию.

Кадр можно сделать динамичнее, если заставить взгляд зрителя перемещаться по
фотографии. Добиться этого можно, используя различные изобразительные сред-
ства фотографии и композиционные приемы. Так, диагональное построение ком-
позиции, направление основных линий кадра, способствует усилению его про-
странственности и динамизма.

Существуют определенные закономерности восприятия снимков зрителем. Учи-
тывая эти особенности, можно добиваться нужных результатов, выделяя в прямом
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и переносном смысле те детали снимка, на которых должно быть акцентировано
внимание зрителя.

Рис. 2.1. Разбиение кадра в соответствии с правилами золотого сечения

В частности, принято считать, что осмотр кадра обычно идет в направлении зри-
тельных центров, о которых мы уже упоминали. Если глазу не за что «зацепить-
ся», то человек останавливает свой взор в центре кадра, внимание привлекают глу-
бокие тени и более резкие, контрастные участки изображения.

Рассмотрим рис. 2 цветной вклейки (Эрнест Брендель, «Beautiful Stranger»). Это
сложный и красивый пейзаж, динамичный, пространственный и уравновешенный
в композиционном плане. Центральной фигурой пейзажа является небольшая
яхта, плывущая по озеру. Обратите внимание на то, как фотограф пользуется пра-
вилом золотого сечения в применении к данному снимку.

Во-первых, отчетливо видна линия, разделяющая небо и воду. Между небом и вод-
ной гладью можно увидеть небольшое количество деревьев, но они относятся к
верхней части. Это разделение кадра происходит практически точно на его одной
трети.

Во-вторых, яхта, показанная в правой части фотографии, расположена весьма
близко к одному из зрительных центров. Но она находится не в самом зрительном
центре, а немного ближе к краю фотографии. Это придает снимку больше дина-
мизма, так как зритель невольно пытается продолжить движение объекта справа
налево. На самом деле на одном этом снимке можно показать огромное количество
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композиционных приемов, мы вернемся к нему немного позже на страницах этой
книги.

Посмотрите на рис. 2.2 (Михаил Рейфман, «Хозяйка города»).

Рис. 2.2. Объект съемки находится в зрительном центре

Это, видимо, пример классической компоновки кадра. Обратите внимание на то,
как лаконично композиционное решение. Весь кадр построен вокруг чайки, кото-
рая летит на фоне небоскребов, олицетворяющих в этой фотоработе город. Ниче-
го лишнего. Кстати, как вы можете видеть, чайка расположена в одном из зритель-
ных центров, что придает кадру определенную устойчивость и в то же время делает
его динамичным в силу подвижности сюжета.

Если сравнить два вышеописанных снимка (рис. 2 цветной вклейки и рис. 2.2), то
окажется, что центральной композиционной идеей обеих работ является правило
золотого сечения. Но посмотрите, как различны эти кадры, несмотря на схожесть
в плане композиционного приема.

Первый сложен, насыщен деталями, но в то же время удивительно привлекателен
и проработан. О втором же можно сказать, что он максимально прост и строг, но,
согласитесь, выглядит он так же превосходно. Это пример того, как правило золо-
того сечения может быть использовано для построения разноплановых снимков.

Пользуясь этим правилом, или хотя бы имея его в виду при съемке, вы сможете
лучше понимать, как управлять пространством вашего кадра. Как уже было сказа-
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но, различные отклонения от зрительных центров и других опорных линий кадра
вполне допустимы, если вы преследуете особые художественные цели.

2.4. Акценты
Немного выше мы с вами уже затрагивали вопрос о закономерностях восприятия
кадра зрителем. Собственно говоря, одной из целей фотографа является демонст-
рация фотографий другим людям. Поэтому вполне объяснимо его желание сде-
лать наиболее важные объекты фотографии более заметными, притягивающими
внимание зрителя, а менее важные, наоборот, скрыть. Этой цели служат различ-
ные способы расстановки акцентов.

Так, внимание может быть привлечено к наиболее резкому объекту на снимке —
этот прием применяют, например, при съемке портретов, когда фон уходит в не-
резкость. То же самое можно встретить и на макроснимках, хотя в таких случаях
причина увода фона в нерезкость практически не зависит от воли фотографа.

Если говорить о применении выделения с помощью повышения резкости главно-
го объекта съемки в мобилографии, то здесь эта методика пока недостижима по
причинам, о которых сказано уже достаточно. Объективы, применяемые сейчас в
мобильных устройствах, не позволяют менять глубину резкости. Но мы все же
рассмотрим пример такого фото. Посмотрите на рис. 2.3 (Михаил Рейфман, «Fresh
News»).

Рис. 2.3. Акцент с использованием резкости
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Здесь главный объект съемки — человек с газетой — сделан резким, а фон уве-
ден в сильную нерезкость. Кстати, обратите внимание — снимаемый не замеча-
ет, что его фотографируют, поэтому фотоснимок получился достаточно живым
и непосредственным. Кроме того, это еще и пример съемки движущегося объекта
с проводкой. Об этом мы поговорим ниже, здесь я хочу лишь обратить ваше вни-
мание на то, что фон не только нерезок, но и за счет движения камеры слегка
смазан.

Посмотрите на рис. 1 цветной вклейки. Фотограф, движущийся в момент съемки,
снял кадр, главный объект которого оказался резким, а фон, который двигался от-
носительно фотографа, вышел смазанным и нерезким.

Акцентирование внимания зрителя возможно не только с помощью резкости, но
и при помощи освещения. Если осветить центральный объект фотокомпозиции силь-
нее, чем остальные, внимание гарантированно будет привлечено именно к нему.

Посмотрите на рис. 3 цветной вклейки (Эрнест Брендель, «StilLife»). Это натюр-
морт, выполненный в темных тонах. Некоторые его части, а именно, орехи, нахо-
дящиеся справа, освещены сильнее, чем остальные детали снимка. Поэтому вни-
мание зрителя невольно притягивается к ним.

Пространственности снимку добавляет стеклянная основа, на которой расположены
снимаемые предметы. Они, мягко отражаясь в стекле, уходят в его глубину, делая
фотографию многомерной, давая возможность рассматривать предметы с разных
сторон и убирая границы снимка. Очень темный фон, совершенно стирающий гра-
ницы между вертикальными и горизонтальными плоскостями, удачно контрасти-
рует со сравнительно сильно освещенными предметами.

Сегодняшней мобилографии вполне доступны такие эффекты — освещенный
объект на темном фоне будет смотреться весьма интересно. Но интересно могут
выглядеть не только освещенные, но и светящиеся объекты. Многие мобильники
имеют функцию съемки в ночное время суток, предусматривающий режим, кото-
рый напоминает по сути своего действия длинные выдержки. Ночные кадры по-
рой получаются достаточно интересными.

Посмотрите на рис. 2.4 (фото автора, «Ночная дорога»). Этот ночной снимок', сде-
ланный из окна движущегося автомобиля, привлекает внимание в первую очередь
за счет ярко выраженной перспективы, рисуемой уходящими вдаль фонарями. Их
свет является как бы центральной деталью мобилографии, которая организует
вокруг себя снимаемое пространство. Данная мобилография представлена здесь
без обработки — в данном случае артефакты сжатия, которые довольно хорошо
заметны, добавляют фотографии ночного настроения.

Кстати, эта фотография раскрывает себя именно в черно-белом виде — рассмотрев
ее в разных вариантах, я остановился именно на том, который представлен ваше-
му вниманию.

Продолжая разговор об акцентах, нельзя не сказать о цветовых акцентах — внима-
ние зрителя наверняка будет привлечено к наиболее ярко окрашенному объекту
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или объекту неожиданного цвета. Здесь практически невозможно давать какие-то
определенные рекомендации. Правда, если говорить о передаче цветов в мобило-
графии, то часто она весьма далека от идеала. Эта ее особенность, кстати, тоже мо-
жет рассматриваться как художественное средство.

Рис. 2.4. Светящиеся объекты привлекают внимание зрителя

В чисто утилитарных целях мы можем провести цветокоррекцию неудачной
в этом плане мобилографии. Однако довольно часто цветовой недостаток мо-
бильных фотографий как-то не хочется править, так как он кажется вполне соот-
ветствующим свободному и эмоциональному духу мобилографии. Это спорный
вопрос, но, на мой взгляд, задача передать эмоции, настроение, чувство останов-
ленного момента жизни для мобилографии гораздо важнее, чем точная цветопе-
редача и другие атрибуты качественной в обычном понимании фотографии.

Целям привлечения внимания служит уже известное вам правило третей — объект
можно поместить в одну из активных точек изображения или в его центр.

Интересными бывают композиции, когда центральный объект съемки находится
в обрамлении, скажем, окна, дверной рамы, арки, веток деревьев и так далее. Если
«вписать» объект в такую «рамку», особенно движущийся, то вы практически га-
рантированно сделаете снимок оригинальным и привлечете внимание зрителя
к снятому объекту.

Однажды мне пришлось пожалеть о том, что камера мобильника не позволяет за-
ниматься ручной фокусировкой, и о том, что она, как минимум, не пятимегапик-
сельная. Была полная луна, не слишком высоко поднявшаяся над горизонтом.
Небо было покрыто легкими полупрозрачными облаками, подсвеченными луной.
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Такие вещи практически невозможно снять мобильником (хотя, возможно, уже
довольно скоро и подобные кадры будут для них обычным делом). Здесь нужна
длинная выдержка, не слишком высокая светочувствительность матрицы (для как
можно меньшего уровня шумов), возможность ручной фокусировки, управления
диафрагмой и штатив.

Но пока я наблюдал за луной, просвечивающей через облака, я стал свидетелем
еще одной картины, которую не увидеть солнечным днем — на пути лунного света
оказалась группа деревьев. Их толстые ветки, сплетясь причудливым образом,
создали рамку, ограничивающую луну, устанавливающие ее в правую верхнюю ак-
тивную точку изображения. Тонкие же ветки, подсвеченные луной, создали совер-
шенно невероятную картину, которую не передать словами. Все это сопровожда-
лось изображением полупрозрачных облаков и уже упомянутой луны.

В результате получилась удивительно красивая картина. Луна, вписанная в рам-
ки дерева, выглядела настолько необыкновенно, что прямо таки просилась на мно-
гомегапиксельную фотографию. Рамка из ветвей создала практически готовый
снимок, который нужно было лишь зафиксировать.

Понятно, что все вышесказанное вовсе не означает, что вы должны вписывать все
объекты в какие-либо рамки. Но фотография, которая сочетает удачное обрамле-
ние главного объекта с другими композиционными приемами, смотрится весьма
оригинально.

Акцентировать внимание зрителя на главном объекте можно, применив такое ли-
нейное построение кадра, когда основные линии сходятся к главному объекту. Это
может быть какая-нибудь дорога, тропинка, стены коридора и так далее.

Посмотрите на рис. 2.5 (Дмитрий Резван, «Метро»). Этот снимок сделан в темном
коридоре метро, освещенном сравнительно редкими фонарями.

Фотография достаточно динамична и, что вполне соответствует духу мобилогра-
фии, слегка смазана. Перспективные сходы стен коридора ведут взгляд зрителя к
главному объекту съемки — чьей-то темной фигуре в глубине коридора. Как и
практически все мобилографии, эта мобилография выглядит не как застывший
снимок, а как «история с продолжением». Кто идет далеко в темном коридоре? Что
сулит мобилографу встреча с этим человеком? Может быть, она изменит его
жизнь, или незнакомец пройдет мимо, и на этом все закончится? Каждый зритель
даст на эти вопросы свои ответы.

Этот снимок похож на рассмотренный на рис. 2.4, с той только разницей, что там
больше внимания уделяется деталям, окружению, передаче настроения ночной до-
роги, а акцентирование внимания зрителя на удаляющемся автомобиле, едва вид-
ном в глубине снимка, не является первоочередной задачей.

Помимо чисто композиционных и фотографических приемов, для акцентирова-
ния внимания зрителя на сюжетно-композиционном центре изображения могут
быть применены цифровые приемы обработки фотографий. О них читайте в соот-
ветствующей главе.
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Рис. 2.5. Дмитрий Резван, «Метро»

2.5. Гармония, равновесие, симметрия,
динамика
Гармония, гармоническое единство — это одно из требований фотокомпозиции.
Понятие «гармония» весьма широко и может включать в себя гармонию красок,
линий, света и тени и так далее.

Различные элементы фотоснимка зрительно взаимодействуют со своими соседя-
ми. Такое взаимодействие, при правильном подходе к композиции кадра, приво-
дит к уравновешенности, дополнению их друг другом. Посмотрите на рис. 2 цвет-
ной вклейки. При всей своей сложности, это гармоничный и уравновешенный
снимок.

Если смотреть на него, не задумываясь о технике съемки и композиционных пост-
роениях фотографа, он выглядит гармоничным, у зрителя не возникает желания
«раскладывать» снимок на части. Но если попытаться это сделать, окажется, что
находящаяся справа яхта очень светлая, уравновешена светлыми же облаками в
левой части изображения, она же смягчает темный фон в правой части изображе-
ния, а водная гладь, в которой отражаются многие предметы этого прекрасного
снимка, лишь делает его более выразительным.

Посмотрите на рис. 4 цветной вклейки (Эрнест Брендель, «September»). Здесь тем-
ная по тональности земля уравновешена темной верхней частью неба, покрытого
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облаками. Дерево, находящееся в районе сразу нескольких зрительных центров,
очень хорошо вписывается в общую картину, окрашенную в теплые осенние тона.

Это уравновешенный снимок — нижняя часть уверенно «перетягивает» верхнюю,
снимок не «переворачивается» и не стремится принять другое положение. В про-
тивовес уравновешенным снимкам существуют снимки искусственно неуравнове-
шенные. Равновесие нарушается для того, чтобы лучше передать динамику снято-
го момента.

Если говорить о применении симметричного построения композиции, то данный
прием чем-то похож на вышеописанные методы «вписывания» объектов в различ-
ные естественные рамки. Симметрия — это интересно, но подобное композицион-
ное решение встречается сравнительно редко, так как требует довольно удачного
стечения обстоятельств.

Например, посмотрите на рис. 2.6 (Александр Каасик, «Модели из деревушки»).
Две коровы расположились практически симметрично, это придало снимку инте-
ресный колорит. Полная симметрия в природе встречается весьма редко, но даже
то, что вы видите на рис. 2.6, выглядит весьма интересно.

Рис. 2.6. Симметрия

Симметрия и асимметрия одинаково хороши для построения кадра. Симметрия,
как правило, вызывает ощущение строгости, четкости композиции. А вот асиммет-
рия, когда такой снимок построен правильно, прекрасно смотрится в любых про-
явлениях, делая снимки более разнообразными и интересными. Равновесие кадра
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может быть достигнуто как в результате симметричного, так и асимметричного
построения фотоснимка.

Если в случае симметрии все понятно — кадр как бы автоматически получается
достаточно адекватным, то асимметрия диктует свои законы построения. В част-
ности, не рекомендуется перегружать правый нижний угол кадра или верх изоб-
ражения по сравнению с низом — такие перегрузки могут создавать впечатление
неуравновешенности. Но заметьте, никто не говорит о том, что сюжетно-компози-
ционный центр фотографии, смещенный к правому нижнему углу, смотрится не-
уравновешенно — все зависит от каждого конкретного снимка.

Так же нижняя часть кадра интуитивно воспринимается нами как более тяжелая,
а значит, более темная, чем верхняя, которая ассоциируется с небом — оно обычно
светлее, чем земля. Равновесие по горизонтали достигается и традиционно перпен-
дикулярной по отношению к сторонам кадра линии горизонта.

Но уравновешенные композиции, хотя и являются доминирующими среди прочих,
не являются единственно возможными. Право на жизнь имеют и неуравновешен-
ные композиции, когда требуется передать движение, динамику, остроту ситуации
или даже видение фотографом того или иного события. Неуравновешенная ком-
позиция сложнее в построении, чем уравновешенная, так как здесь на первый план
выходят характеристики снимаемых объектов, ситуация, в которой они сняты.
Такая композиция, если она удачна, добавляет живости, динамизма, остроты изоб-
ражению. В то же время, очень легко сделать неуравновешенный снимок неудач-
ным — такова особенность всех сильных приемов фотографии, которые значитель-
но меняют внешний вид фотоснимков.

Композиционная идея кадра претерпевает определенные изменения, если в кадре
требуется передать движение. Если, скажем, движущийся объект движется спра-
ва налево, то в левой части изображения имеет смысл оставить пустое простран-
ство — оно будет восприниматься вполне естественно, как место, необходимое для
продолжения движения. Если «поместить» в это пустое пространство какие—либо
предметы, то возникнет ощущение препятствия, остановки движения, это уже бу-
дет выглядеть неестественным, хотя, повторюсь, это лишь общие соображения.

Посмотрите на рис. 2 цветной вклейки. Яхта движется по водному пространству
справа налево, и для ее движения оставлено довольно большое пространство. Так
же на рис. 2.2,2.3 по направлению движения объекта съемки оставлено свободное
пространство.

При съемке быстро движущихся объектов возможны несколько общих подходов.
При первом фотоаппарат (мобильник — аналогично) остается неподвижным —
тогда фон фотографии оказывается резким, по крайней мере, если фон уведен в
нерезкость, он не смазан. А объект при таком стиле съемок выходит практически
всегда смазанным.

Степень смазанности зависит от выдержки (или ее аналога в мобилографии)
и скорости движения объекта. При другом способе, который называется «съемка
в проводку», аппарат двигается, как бы «следя» за объектом, и экспозиция свето-
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чувствительного материала производится в движении. В результате фон оказыва-
ется смазанным, иногда довольно сильно, а объект съемки, в идеальных условиях,
выходит достаточно резким.

Точно так же, сообразно идеям передачи движения в кадре, есть смысл оставлять
пустое пространство по направлению взгляда снимаемого. При съемке портретов
место, оставленное по направлению взгляда, не создает диссонанса и выглядит
оправданно, делая снимок естественнее. Посмотрите на рис. 2.7 (Эрнест Брендель,
«Шулер»).

Рис. 2.7. Эрнест Брендель, «Шулер»

Это прекрасная иллюстрация к вышеописанной рекомендации, касающейся остав-
ления свободного места по направлению взгляда снимаемого. В данном случае
портретируемый смотрит несколько вбок. Этот портрет замечателен еще и потря-
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сающей игрой света и тени, которая придает изображенному на нем человеку нео-
быкновенную выразительность.

Следующим вопросом, который мы разберем, будет использование ритмических
построений в композиционных решениях кадров.

2.6. Ритм

Одним из элементов композиции снимка, одним из выразительных средств фото-
графии является ритм — закономерное чередование элементов композиции, их
повторение, порядок их сочетания. Ритм помогает организовать пространство и
подчинить его замыслу фотографа. Ритмический ряд может основываться как на
повторении или чередовании соразмерных элементов композиции, так и на исполь-
зовании таких свойств предметов, как форма, объем, цвет, фактура и так далее.

Ритмический рисунок кадра очень часто бывает подсказан самим объектом съем-
ки, он может основываться на повторении, чередовании сопоставимых элементов
композиции или даже на свойствах предметов: объеме, форме, цвете. Ритм, напри-
мер, в природе — это повторяющиеся лепестки цветка, волны на воде, стволы де-
ревьев, лучи света и так далее.

Аналогичные примеры ритмических рисунков можно найти и, скажем, в город-
ском пейзаже — вертикальные, горизонтальные, наклонные линии зданий, фонар-
ных столбов, оконные решетки, жалюзи, да абсолютно все, что угодно. Причем
ритмика кадра определяется не только его линейным рисунком. Ритм — это еще и
цветовые, световые особенности кадра, ритм может выражаться в передаче объе-
мов и расстояний.

Цель ритмических построений — выявление характерных особенностей объекта
съемки, раскрытие смысла и содержания фотографии. Так, ритмически организо-
ванный фон часто очень удачно контрастирует с основным объектом съемки, с од-
ной стороны являясь естественным, а с другой, подчеркивая, например, свободу и
независимость объекта съемки. Посмотрите на уже не раз упоминавшийся рис. 2.2 —
слегка размытый фон четко, ритмично расчерчен линиями зданий, на фоне кото-
рых изображена чайка в свободном полете.

На рис. 5 цветной вклейки (Эрнест Брендель, «Every time») мы видим ритмично
повторяющийся рисунок ступенек, который организует вокруг себя снимаемое
пространство и уводит взгляд в глубину кадра, за горизонт. Аналогично на рис. 5
цветной вклейки можно заметить ритмически выстроенные облака.

Необычная игра цвета притягивает внимание зрителя к рис. 6 цветной вклейки
(Дмитрий Резван, «Мобилография»). Здесь мы можем видеть яркие, острые, рит-
мичные лучи света и цветовой ореол, который стал результатом их взаимодей-
ствия с оптикой камеры. Эти эффекты создают необычное настроение, делая фо-
тографию весьма интересной.

Посмотрите на рис. 2.8 (Эрнест Брендель, «Don't cry»).
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Рис. 2.8. Эрнест Брендель, «Don't cry»

Это довольно строгий пейзаж. Море занимает большую часть кадра Его волны рит-
мически организованы. Как вы понимаете, море и небо служат лишь фоном для изоб-
ражения главного героя кадра - девушки, которая идет по берегу и, видимо пла-
чет. Автор фотографии предлагает ей не плакать, назвав свою работу «Don't cry"

я ' М°ЖН° П°КазаТЬ множество компози.
в. Здесь есть и правило третей, и передача движения, и уводящие

лубь кадра линии. Но в данном случае мне хочется обратить ваше внимание
именно на ритмику морских волп. Рисунок волн, при кажущейся хаотичности „е

поипоТ У ЗРИТеЛЯ ЧУВСТВа Несоответ™* «ли неправильности - всему" виной
" В е Н Н ° С Т Ь П°С ™*,̂  вовсе не случайных

Р г А Ы П°ГОВОрИМ ° ^отношении объекта и фона, сюжетно-композиционном
центре фотоснимка и внутрикадровых связях

2.7. Сюжетно-композиционный центр
Сюжетно-композиционный центр является одним из основных элементов
торых строится фотоснимок. Обычно он акцентирован

'
ицион

" ЭТ° °СНО'а К°НСТРУКЦИИ Фотоснимка. То есть для того, чтобы создать

наибольтГГаЮи?ИЙСЯ СНИМ°К' Ф°ТОГРаФУ необходимо найти об^кты, которые
наибольшей силой характеризует изображаемое явление
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Мобилография в этом плане весьма зависима от выбора сюжетно-композицион-
ного центра. Ведь мобилографии вызваны к жизни эмоциональным воздействием
тех или иных явлений на человека. Как правило, это воздействие можно передать
во вполне осмысленном фотоснимке, который автоматически строится вокруг
сюжетно-композиционного центра.

Когда фотограф нашел главные объекты, ему необходимо лишь сделать на них
акцент, выделить при помощи любых выразительных средств фотографии. Осталь-
ные элементы фотографии могут подчеркивать главный замысел фотографа, ак-
компанируя сюжетно-композиционному центру. Ненужные же элементы, меша-
ющие восприятию основного объекта, могут быть «уведены» в сторону, для того
чтобы не смещать акцентов, которые расставил фотограф.

На каждой фотографии значение имеет абсолютно все. Конечно, если вы снимае-
те, скажем, на вечеринке, то здесь ваша главная цель — фото на память. Основная
ценность таких фотографий — именно в их документальности, хотя и здесь можно
сделать очень хорошие снимки.

А вот если вы снимаете пейзаж, портрет, когда у вас есть время для того, чтобы
тщательно поразмыслить над композицией будущего снимка, тогда докумен-
тальность фотографии отходит на второй план, а на первое место выступает имен-
но художественность исполнения. Однако фотография практически всегда оста-
ется документальной, а удачные кадры лишь показывают нам прекрасный мир
вокруг нас.

Что может послужить сюжетно-композиционным центром в мобилографии? Да
все, что угодно. Если вы хотите сохранить в памяти вид из окна, пробегающую
мимо собаку или ваше настроение, все, что вам нужно сделать — это взять мобиль-
ник и снять кадр. Вы можете поместить в ваш фотоснимок любые объекты, пред-
меты фона, которые в обычных условиях не находят должного внимания на фото-
графиях. В мобилографии главное — эмоции и передача настроения, поэтому здесь
возможно все.

Посмотрите на рис. 7 цветной вклейки (Дмитрий Резван, «Мобилография»). Здесь
вы можете видеть прекрасную балерину, снятую в ее рабочем окружении. Балери-
на — это сюжетно-композиционныи центр фотографии, а различные детали инте-
рьера дополняют картину, оживляя ее и добавляя ей правдоподобности. Как и
многие мобилографии, эта фиксирует один из моментов жизни, заставляя его ожи-
вать, перенося зрителя в атмосферу съемок. Посмотрите на рис. 2.9 (Дмитрий Рез-
ван, «Мобилография»).

Сюжетно-композиционныи центр этой фотографии — девушка, находящаяся в ле-
вой части кадра. Эта Мобилография сочетает в себе двойную динамику. Во-первых,
движется девушка, а во-вторых — камера фотографа. Динамичные эффекты моби-
лографии мы уже обсуждали, но здесь еще раз наглядно продемонстрирована эта
ее особенность.

Если вы посмотрите на любой из уже обсужденных нами снимков, вы легко сможе-
те увидеть их сюжетно-композиционныи центр. На рис. 2.1 сюжетно-композици-
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онным центром является цветок на переднем плане. На рис. 2.2 — чайка, на
рис. 2.4 — фонари, уходящие в даль, и ночная дорога. Это две коровы с рис. 2.6 и
девушка, идущая по берегу моря, с рис. 2.9. Каждая фотография имеет что-то глав-
ное, без чего ее смысл кардинально изменился бы. Собственно говоря, сюжетно-
композиционный центр и есть то самое главное, что автор хотел донести до зрителя.

Рис. 2.9. Дмитрий Резван, «Мобилография»

2.8. Внутрикадровые связи, соотношение
объекта и фона

Внутрикадровые связи — это то, что связывает кадр, различные предметы, его со-
ставляющие, в единую картину. Внутрикадровые связи можно легко разрушить,
если допустить некоторые типичные, часто опасные для композиции ошибки.

Так, линия горизонта не должна делить кадр строго пополам. Такое деление мо-
жет разрушить его, превратив в две самостоятельные картинки. Композиционное
единство кадра может быть разрушено в том случае, если имеется два главных
объекта, которые разнесены слишком далеко по краям кадра, а между ними нахо-
дится значительное свободное пространство.

Композиционная целостность может быть разрушена четкими линиями, проходящи-
ми через весь кадр, параллельными его границам. Особенно это опасно в тех слу-
чаях, когда эти линии совпадают с центральными осями кадра. Однако, говоря о
подобных «разрушителях» композиции, нельзя не сказать о том, что все это в из-
вестной мере условно. Можно найти прекрасные пейзажи, вовсе не разрушающие-
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ся от линии горизонта, делящей кадр пополам, и другие подобные снимки. По-
смотрите, например, на рис. 2.2 — масса линий, параллельных краям кадра, ничуть
не нарушают его композиционной целостности. Все это вполне применимо к мо-
билографии.

Важную роль при съемке играет соотношение снимаемого объекта и фона. Фон,
с одной стороны, не должен отвлекать внимание зрителя от основного объекта
съемки. С другой же — фон очень часто играет весьма активную роль и порой до-
вольно сложно выделить его однозначно. Анализируя некоторые фотографии,
уместнее говорить о разных планах фотоснимка, часто равноправных, чем о явно
выраженном фоне.

Например, фон может быть размыт — как, например, на рис. 1 цветной вклейки.
Такой фон не привлекает к себе внимание зрителя, он способен передавать дина-
мику движения, не выделяясь и служа именно фоном для снимаемых объектов.
Подобный фон хорош для портретов.

Мобилография лишь отчасти позволяет создавать размытый фон при съемках.
Объективы мобильников, как уже было сказано, не поддерживают ни возможно-
сти фокусировки, ни регулировки диафрагмы. Однако,, как это видно на рис. 1
цветной вклейки, подобный фон вполне реально получить, если снимок делается
в движении.

Если же вам очень хочется создать размытый фон на статичном портрете, сделан-
ном мобильным телефоном, знайте, что это возможно, но лишь средствами Photo-
shop CS, о чем читайте дальше. Если продолжить разговор о смазанном фоне, то
можно отметить, что он способен передавать динамику, например на рис. 2.3 фон
размыт и слегка смазан.

Естественно, наряду с размытым, право на жизнь вполне имеет и резкий фон.
Например, такой как на рис. 2.7. Здесь резкий фон, достаточно однородный по
фактуре, совершенно не мешает восприятию главного объекта съемки, лишь играя
на улучшение восприятия фотографии. Рисунок 2.1 наглядно демонстрирует
особенности фона, получаемого при съемках неподвижным мобильником — цве-
ты на заднем плане вышли достаточно резкими. Однако это не выглядит не-
естественным.

Фон может быть, как уже отмечалось, лишь задним планом фотографии, который
так же важен для восприятия, как и все остальное. Например, посмотрите на рис. 5
цветной вклейки. Этот пейзаж замечателен просто огромной глубиной резкости,
которая позволила показать на фотоснимке большое открытое пространство. Как
видите, на данном снимке важно все — от небольших травинок вблизи фотографа
до дальних групп деревьев на горизонте, которые вышли резкими.

На рис. 3 цветной вклейки фон играет весьма важную роль, в данном случае уве-
дение его в нерезкость не способствовало бы улучшению восприятия снимка.

Посмотрите на рис. 2.10 (Эрнест Брендель, «Baltic Morning»). Здесь вы может ви-
деть весьма необычный пейзаж — несколько полусгоревших бревен на фоне моря.
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Несмотря на то что море в этом снимке является как бы фоном, оно все же играет
здесь главную роль. А камни, бревна и другие окружающие его предметы лишь
дополняют общую картину балтийского утра.

Рис. 2.10. Эрнест Брендель, «Baltic Morning»

В целом же можно сказать, что фон имеет такое же значение, как и объект съемки,
но в общем случае он должен лишь помогать восприятию главного объекта, не от-
влекая от него внимания зрителя.

2.9. Масштабность и перспектива
Как и в обычной фотографии, в мобилографии соблюдение масштаба нужно для
того, чтобы зритель имел возможность реально воспринимать величину изобража-
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емого предмета. Для этих целей возможно введение в композицию элементов, хо-
рошо знакомых зрителю для сопоставления. Надо учитывать и то, что, например,
объект съемки, окруженный большими по размерам предметами, кажется меньше,
и наоборот.

В специальных целях можно искусственно изменять масштаб предметов, напри-
мер, при определенных условиях можно добиться интересного эффекта, при кото-
ром предметы, расположенные на разном расстоянии от фотографа, кажутся на-
ходящимися на одинаковом удалении от него. Думаю, многим приходилось видеть
кадры, на которых один человек «держит на ладони» другого. Правда, такой кадр
вряд ли получится одним из современных мобильников.

Дело здесь в том, что подобные кадры надо снимать длиннофокусным объективом
или объективом с переменным фокусным расстоянием в длиннофокусном режи-
ме. Так как длиннофокусный объектив эффективно скрадывает расстояния, он
идеально подходит для кадров, «изменяющих» размеры реальных предметов. А ко-
роткофокусные объективы мобильников пока такого не могут. Хотя на близком
расстоянии можно попытаться что-то такое скомбинировать, однако без особой
надежды на удачу.

Далее, продолжая разговор о масштабе предметов, нельзя не упомянуть о переда-
че расстояний на фотоснимках, то есть перспективе. Даже чисто зрительно при
изменении расстояния до предмета меняется форма, размеры, интенсивность
окраски последнего. Как вы понимаете, уменьшение масштабов изображаемых
предметов пропорционально их удалению от зрителя. Это свойство линейной пер-
спективы.

Перспективу можно подчеркнуть включением в композицию кадра параллельных
линий — дорог, линий электропередач, заборов, стен домов и так далее. Такие ли-
нии стремятся сойтись в одной точке. Если показать в кадре точку схода этих ли-
ний, можно значительно увеличить эффект перспективы. Ярко выраженную ли-
нейную перспективу можно увидеть на довольно большом количестве снимков.
Посмотрите на рис. 2.11 (Эрнест Брендель, «Together»).

Линейная перспектива весьма ярко выражена на этом снимке. Фактически, сю-
жетно-композиционный центр снимка — нечто вроде плотины из камней, отгоро-
женных от моря забором из деревянных кольев, — развернут при помощи линей-
ной перспективы. Обратите внимание на то, как сходятся вдали края плотины, как
уменьшается размер камней. Аналогично, на рис. 5 цветной вклейки мы можем
видеть сужающуюся дорожку, вымощенную деревянными брусками и маленькие
деревья вдали.

Линейная перспектива легко прослеживается на рис. 2.1, добавляя довольно
простой мобилографии объема. На этом рисунке все цветы примерно одинаково-
го размера, но за счет большей удаленности некоторых они выглядят значительно
меньше, чем тот, который расположен на переднем плане. Посмотрите на рис. 2.4.
Весь кадр построен вокруг уходящих вдаль придорожных фонарей. Перспекти-
ва здесь выражена так же весьма ярко. Все это были примеры линейной перспек-
тивы.
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Рис. 2.11. Эрнест Брендель, «Together»

Но помимо линейной существует еще и перспектива тональная — отдаленные
предметы кажутся менее четкими, чем находящиеся вблизи. Окраска отдаленных
предметов становится мягче. Разновидностью тональной перспективы является
воздушная перспектива. Она особенно активно участвует в композиционных по-
строениях фотографа тогда, когда в воздухе есть туман, легкая воздушная дымка
и так далее.

Воздушная перспектива актуальна при съемках пейзажей, особенно в утренние
и вечерние часы. Посмотрите на рис. 2.12 (Александр Каасик, «Скоро придется
проститься»).

Этот пейзаж снят рано утром. Деревья и аисты освещены светом низко располо-
женного восходящего солнца, с полей еще не сошел ночной туман. Туман завола-
кивает далеко расположенные предметы, становясь все более глубоким с увеличе-
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нием расстояния. Воздушная перспектива выражена на этом снимке достаточно
сильно. Если говорить о подобных эффектах в мобилографии, то они также воз-
можны.

Рис. 2.12. Александр Каасик, «Скоро придется проститься»

2.10. Точки съемки, ракурс, передача
объема на фотографии, кадрирование
Точка съемки — это место, где установлен фотоаппарат. Точки съемки бывают
нормальными (это справедливо, например, при съемке пейзажей, людей в полный
рост и так далее). Эти точки съемки находятся примерно на уровне глаз человека.
Предметы, снятые с нормальной точки, кажутся нам такими, какими мы их при-
выкли видеть, сохраняется привычная перспектива и зрительное взаимодействие
предметов.

Помимо нормальных, существуют высокие и низкие точки съемки, которые помо-
гают достичь некоторых художественных эффектов. Так же близки к нормальным
точки съемки, расположенные, например, достаточно высоко в том случае, когда
объект съемки находится на достаточно большом расстоянии от точки съемки.
При таком соотношении объекта и точки съемки оказывается, что дальние и ближ-
ние предметы расположены на примерно одинаковом расстоянии, не наблюдается
резких перспективных сходов. Например, это может быть пейзажная съемка, вы-
полненная из окна здания, и так далее.
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Однако верхние и нижние точки влияют на восприятие снимка зрителем. Так, при
съемке с нижней точки изменяется соотношение предметов на переднем и заднем
плане фотографии. Невысокие объекты переднего плана выглядят достаточно
внушительными, проецируясь на небо и зрительно сравниваясь, например, с вы-
сокими объектами на заднем плане. Например, если при съемке леса надо подчерк-
нуть его высоту, то здесь отлично подойдет нижняя точка съемки. На снимке по-
чти не будет видно земли, зато деревья будут казаться вытянутыми, высокими на
фоне неба. Аналогично можно снять, например, заросли травы, которые с низкой
точки съемки выглядят очень внушительно.

Если опустить или приподнять точку съемки, находящуюся вблизи объекта, тогда
мы получим интересный фотоэффект, называемый ракурсом. Масштаб объектов
переднего плана кажется увеличенным, заднего — уменьшенным, наблюдаются
нехарактерные для естественных условий перспективные сходы, линии, уходящие
в глубину, сокращаются.

Посмотрите на рис. 2.13 (Александр Каасик, «Картинки из детства»). Он иллюст-
рирует вышеприведенный пример низкой точки съемки.

Рис. 2.13. Александр Каасик, «Картинки из детства»

Кадр достаточно лаконичен — кроме колосьев на нем ничего нет. Но они даны на
фоне неба, причем с очень низкой точки съемки. Это невольно заставляет зрителя
сопоставлять их с теми объектами, которые обычно приходится видеть в реальной
жизни в подобных обстоятельствах. Очевидно, идет подсознательное сопоставле-
ние, например, с деревьями.
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Такой снимок нельзя сделать, например, с высоты человеческого роста — трава
и низкие цветы слились бы в единый ковер, который уже не произвел бы должно-
го впечатления на зрителя.

Посмотрите на рис. 2.14 (Михаил Рейфман, «Wrigley at fall»). Здесь мы видим
высокое здание, которое кажется еще выше и внушительнее благодаря низкой точ-
ке съемки.

Рис. 2.14. Михаил Рейфман, «Wrigley at Fall»

В противовес низким точкам съемки, высокие точки занижают реальный размер
объектов переднего плана, позволяя отобразить на снимке большие пространства
и точно показать расположение объектов съемки на снимаемом пространстве.

На рис. 2.15 (Михаил Рейфман, «Two for twelve?») мы видим как раз такой ра-
курс — снимок сделан с верхней точки съемки и на нем хорошо видны все детали
рыболовецкой лодки — рассортированная рыба, пластиковые ящики у бортов
и сам рыбак.
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Рис. 2.15. Михаил Рейфман, «Two for twelve?»

Ракурс — это особый взгляд на окружающий мир, на предметы и людей. Как один
из художественных приемов фотографии ракурс очень интересен, так как позво-
ляет более полно раскрыть сущность снимаемого предмета. Однако это в то же
время и очень сильный прием, который значительно меняет внешний вид кадра,
что может привести к непредсказуемым результатам, особенно при съемке порт-
ретов.

Если говорить о ракурсе в мобилографии, то создается впечатление, что это —
один из наиболее естественных ее приемов. Посмотрите, например, на рис. 2.16
(фото автора в соавторстве с А. Дмитренко, «Собака»).

Передача объемов на фотографии неразрывно связана со всеми вышеописанными
художественными средствами. Например, делу передачи объема может очень помочь
удачно выбранное боковое освещение объекта съемки, как на рис. 2.7 или на 2.12.
Как правило, удачный свет, когда возникают не только четко очерченные тени, но
и полутени как переходы между ярко освещенными участками и теневыми, удач-
ное освещение позволяет очень хорошо передать объемность предмета. Этой же
цели служит уже обсужденное нами свойство перспективы, сходов параллельных
линий, иногда удачно выбранный ракурс позволяет сделать предмет необыкновен-
но объемным и почти осязаемым на фотографии.

Кадрирование — это отсечение рамкой кадра того, что не входит в снимок. Обыч-
но кадрирование происходит в момент построения композиции фотоснимка. Ви-
доискатель довольно хорошо справляется с этой ролью. Однако порой возникает
необходимость дополнительного кадрирования снимков после съемки. Обычно
это «отрезание лишнего» в графическом редакторе.
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Рис. 2.16. Ракурс

При дополнительном кадрировании желательно придерживаться правила золото-
го сечения — длинная сторона кадра должна быть примерно в полтора раза длин-
нее короткой. Однако это правило не является непреложным — если ваши худо-
жественные замыслы реализуются в формате кадра, отличающемся от золотого
сечения (например, это может быть панорама), — можете смело делать то, что счи-
таете нужным.

Достаточно распространенным является кадрирование в квадрат. Как правило,
такое кадрирование неплохо подходит для достаточно статичных снимков, хотя
здесь тоже не может быть жестких правил. Обычно каждый снимок сам подскажет,
нуждается ли он в дополнительном кадрировании или нет. Единственно, кадри-
руя снимки после съемки, надо учесть, что неудачное кадрирование способно за-
губить даже самый удачный снимок.

Если говорить о форматах кадров, то вертикальный и горизонтальный формат рав-
ноправны, хотя последний встречается чаще. Вертикальный формат чаще исполь-
зуется для портретов в полный рост, некоторых пейзажей, съемок высоких зданий,
в других же случаях горизонтальный формат наиболее органичен.

2.11. Свет и цвет как выразительные
средства

Фотографию недаром иногда называют «светописью». Фотоснимки «нарисованы»
светом, а без света фотография просто невозможна. Другой вопрос — при каком
свете. В любительской фотопрактике чаще всего можно встретить естественное и
искусственное освещение. Как правило, и в том и в другом случае предваритель-
ная подготовка света практически отсутствует.
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Если говорить о естественном освещении, то здесь единственная доступная фото-
графу возможность управлять им — это подбирать подходящее место съемки и
ждать определенного времени суток или каких-либо погодных условий. А искус-
ственный свет обычно создается разного рода лампами, которые так же редко ког-
да специально устанавливаются и настраиваются.

От вида света и от того, каким образом он освещает объект съемки, зависит очень
многое. Например, объект съемки может быть освещен рассеянным дневным све-
том. Такой свет является результатом многократного преломления лучей солнца
в атмосфере. Рассеянный свет освещает все предметы, в том числе находящиеся в
тени. Характер этого освещения равномерен. Он не дает резко светотеневого ри-
сунка.

В противовес рассеянному свету, прямое солнечное освещение дает четкий свето-
теневой рисунок. В природе существует и отраженный свет, который отражается
от снега, воды, других объектов. Как вы понимаете, в реальных условиях можно
говорить лишь о преимущественном влиянии того или иного вида света на резуль-
тат. Так, если вы снимаете в облачный день, то почти наверняка преобладающим
светом будет рассеянный, не дающий резких теней.

Помимо вида света существует еще и такое понятие, как направление основного
светового потока. Если основной поток света направлен на объект съемки, так на-
зываемый «фронтальный свет», тогда предметы получаются плоскими, невырази-
тельными, практически нет теней и игры светотени. Близкие и отдаленные пред-
меты освещены одинаково хорошо, все цвета яркие и насыщенные.

В обычной фотографии частным случаем фронтального света является свет вспыш-
ки фотоаппарата. Мобилографу же обычно приходится использовать источники
света, ие зависящие от аппарата.

Если рассматривать различные направления света, то, в сравнении со фронталь-
ным, гораздо более интересен боковой свет. Этот свет выявляет рельефность
объекта съемки. Снимаемые объекты приобретают объемность, а снимок — про-
странственность. Посмотрите на рис. 2.7. Этот портрет снят при боковом освеще-
нии. Не правда ли, свет позволил открыть много интересного?

Попытайтесь снять пару кадров — один при фронтальном свете, другой — при
боковом, — тогда вы почувствуете разницу, что называется, на себе. Переднебо-
ковой солнечный свет принимает активное участие в создании утреннего пейзажа
на рис. 2.12. Посмотрите на рис. 2.10. Здесь боковой свет весьма четко выявляет
объем и фактуру изображенных на фотографии камней и бревен. Конечно, фрон-
тальный свет нельзя однозначно считать неудачным — все зависит от ваших худо-
жественных целей.

Посмотрите на рис. 8 цветной вклейки (Эрнест Брендель, «Onlytime»). Потряса-
ющий снимок, выполненный в темных тонах, выделяется удачно подобранным
боковым светом, который рельефно обрисовывает дерево в правой части кадра.

Далее, свет бывает контровым — направленным в объектив со стороны объекта
съемки. Такой свет также весьма интересен, создавая на фотографии, с одной сто-
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роны, более глубокие тени, которые направлены от источника света к фотоаппа-
рату, а с другой — ярко очерчивая контуры предметов. Задний план фотографии
при таком освещении обычно получается более ярким, чем передний, что также
достаточно интересно.

Посмотрите на рис. 2.17 (Михаил Рейфман, «Сказка и ее жители»).

Рис. 2.17. Михаил Рейфман, «Сказка и ее жители»

Этот снимок выполнен при контровом свете. Задний план фотографии значитель-
но светлее переднего, к тому же здесь мы видим интересный эффект, вызванный
комбинацией сразу нескольких факторов. На рис. 2.17 представлен не просто кон-
тровой свет, а рассеянный контровой свет, однако достаточно яркий для того, что-
бы задавать тон всей фотографии. Туман, подсвеченный солнцем, сам как бы яв-
ляется источником достаточно яркого света. На фоне этого яркого тумана видны
силуэты деревьев, на некоторых из них можно даже заметить птиц.

Контровой свет обычно хуже передает объемы, если сравнивать его с боковым све-
том, хотя вышеописанная фотография, видимо, невозможна при другом освеще-
нии. По крайней мере, в таком виде.

Посмотрите на рис. 9 цветной вклейки (Эрнест Брендель, «Old Country»). Этот
снимок выполнен при контровом солнечном свете. Свет достаточно ярок, поэтому
тени от деревьев вышли достаточно резкими. Силуэт старинного здания вышел не
слишком темным на светлом фоне неба и каким-то таинственным в скрывающих
его деревьях.

При искусственном освещении, если оно специально не предназначено для съем-
ки, что довольно часто бывает в любительской фотографии и мобилографии, на-
блюдаются те же эффекты, что и при естественном.
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Помимо света, весьма серьезное участие в создании целостной композиции игра-
ет цвет объектов. Если говорить об общей тональности фотографий, можно ска-
зать, что тени или черный цвет обычно ассоциируются с ночью, чем-то таинствен-
ным, загадочным. Светлые тональности связывают с солнечным светом, хорошим
настроением, открытостью и понятностью.

Если у вас есть желание построить изображение на контрастах, можете поэкспе-
риментировать с цветами, которые расположены друг напротив друга на цветовом
круге (так называемые дополнительные цвета), или, для создания более спокой-
ной цветовой композиции, можно воспользоваться близлежащими цветами — о цве-
товом круге мы подробнее будем говорить в соответствующей главе.

Цветовое решение снимка обычно определяется объектами съемки, влиять на него
можно лишь в плане выбора объектов. Например, в случае с натюрмортами фото-
граф получает полную свободу выбора. При съемках на природе единственное, что
ему остается, — это ждать подходящей погоды. Еще один вариант, который будет
рассмотрен в соответствующей главе, — это работа над фотографиями в Photoshop.

Цвета в мобилографии играют не меньшую роль, чем в традиционной цветной
фотографии. Но здесь мы вталкиваемся с массой интересных с творческой точки
зрения вещей. Так, камеры сотовых весьма часто передают цвета неправильно.
Снимки то отдают синевой, то выходят совершенно невероятно окрашенными.
С утилитарной точки зрения это плохо, хотя довольно успешно корректируется
при помощи Photoshop. А вот с точки зрения художественной мобилографии -
это еще одна уникальная особенность съемки мобильными устройствами.

Композиционная завершенность, гармоничность, сбалансированность и интерес-
ный сюжет могут быть серьезно подпорчены в глазах зрителя или самого автора
фотографии неинтересным цветом. Цвет может быть правильным, но неинтерес-
ным. В этом случае иногда очень помогает конверсия фотографий в черно-белый
формат или тонирование, например, в сепию.

Как правило, поэкспериментировав с разными вариантами окраски фотоснимка,
вы сами поймете, что ему нужно. Единственно, если вы хотите править фотогра-
фию, снятую мобильником, в том же Photoshop — постарайтесь не применять к
ней эффектов при съемке, иначе править будет уже особо нечего, так как цветовая
информация будет утеряна.

2.12. Выводы
В этой главе мы рассмотрели некоторые приемы и законы композиции, которые,
надеюсь, помогут вам сделать ваши кадры лучше. После того как кадры сняты,
пришло время Photoshop CS.
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После того как снимки выгружены из мобильного телефона на компьютер, прихо-
дит время Photosop CS. С помощью этого графического редактора можно, без пре-
увеличений, сделать с мобилографиями все, что душе угодно. Этому-то и бу-
дет посвящен наш дальнейший разговор.



ГЛАВА 3 Основные навыки
работы в Photoshop CS

Q Установка Photoshop CS

01 Интерфейс программы

Q Работа с файлами

Q Слои, инструменты рисования,
фильтры

О! Работа с выделениями

Q Инструменты коррекции и ретуши

Q Работа с текстом

Q Actions

Q Выводы
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Эта глава предназначена в основном для тех, кто только начинает свое знакомство
с Photoshop CS. На самом деле работать с изображениями в Photoshop CS не
слишком сложно. Я не хочу сказать, что вы будете профессионально править гра-
фику через пять минут после начала чтения. Однако вдумчивый читатель доста-
точно скоро научится пользоваться этой программой для решения своих задач.
Получать основные навыки работы в Photoshop я предлагаю вам на небольшом
условном практическом примере. Мы попытаемся создать с вами поздравитель-
ную открытку, пользуясь средствами Photoshop и попутно рассмотрим его основ-
ные функции. Но начнем мы с краткого описания установки программы.

3.1. Установка Photoshop CS
Установка Photoshop CS — это стандартная операция, которая у человека, знако-
мого с компьютерами, затруднения не вызовет. Если вы еще не приобрели про-
грамму, вы можете скачать бесплатную, так называемую Trial-версию с официаль-
ного сайта Adobe (http://www.adobe.com). Дистрибутив этой бесплатной версии
занимает около 150 Мбайт. В силу своей бесплатности программа имеет одно огра-
ничение — срок ее работы равен 30 дням. Но и за этот срок вы вполне успеете по-
нять, стоит ли Photoshop CS того, чтобы купить его полную версию.

Рис. 3.1. Установка Photoshop CS
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Для установки программы вы должны запустить файл с именем Setup, который
находится в папке с файлами программы. После этого вам придется ответить на
несколько вопросов программы, рис. 3.1 (как правило, достаточно нажимать кноп-
ку Next, оставляя установки по умолчанию), ввести регистрационный номер (при
установке пробной версии делать это не придется) и провести активацию про-
дукта.

Подробные сведения об установке вы можете найти в документации, прилагаемой
к вашей копии Photoshop CS.

Установив программу, вы можете запустить ее, воспользовавшись соответству-
ющим пунктом меню «Пуск» Windows.

3.2. Интерфейс программы
Итак, сейчас мы приступим к изучению функций Photoshop CS на практическом
примере. Для начала предлагаю вам посмотреть на рабочую область и прочесть
несколько скучных, но важных строчек, посвященных основным элементам интер-
фейса Photoshop CS.

Посмотрите на рис. 3.2. Здесь изображено окно программы.
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В верхней части рабочего окна Photoshop CS вы можете видеть строку меню. Эта
строка, уверен, привычная вам по другим программам для Windows, служит для
вызова различных функций программы. Для удобства ниже будет приведен спи-
сок пунктов меню с краткой аннотацией их назначения.

Q В меню File (Файл) собраны средства для работы с файлами.

Q Меню Edit (Правка) дает доступ к инструментам правки изображения.

Q Меню Image (Изображение) содержит различные средства для настройки па-
раметров изображения.

Q Layer (Слой) — здесь собраны средства для работы со слоями.

Q Select (Выделение) — это меню содержит команды для работы с выделениями.

О Filter (Фильтр) дает доступ к набору фильтров Photoshop. Фильтры — это не-
большие программы для обработки изображения по заданному алгоритму.

HI View (Вид) — это меню позволяет управлять внешним видом отображаемого до-
кумента.

Q Window (Окно) — меню для работы с окнами программы.

Q Help (Помощь) — этот пункт предназначен для вызова помощи по программе.

Сразу под строкой меню расположена панель свойств. Она изменяется в зависи-
мости от выбранного инструмента. С ее помощью можно настраивать инструмен-
ты — мы часто будем использовать ее в своей работе.

В левой части рабочего окна программы вы можете видеть панель инструментов.
Эта панель будет нужна нам весьма часто, так как редактирование изображений
неотрывно связано с применением инструментов.

В нижней части окна программы находится строка состояния.

В правой части окна можно видеть несколько палитр инструментов, которые по
логике работы очень похожи на панель инструментов и отчасти дублируют неко-
торые, наиболее часто используемые пункты меню. Палитра может постоянно
находиться на своем месте поверх редактируемого изображения, за счет чего до-
стигается удобство и скорость работы. Палитру инструментов можно в любой мо-
мент закрыть, а при необходимости вызвать снова при помощи соответствующего
пункта меню Window.

Палитры организованы в группы, если «прижать» мышкой корешок палитры
и перетащить ее на группу или в свободное пространство, можно создать пользо-
вательскую группу палитр. Это очень удобно, особенно если у вас сложились опре-
деленные предпочтения в использовании палитр. Посмотрите на рис. 3.3. Здесь
изображен пользовательский набор палитр.

Вся работа с Photoshop CS строится с использованием меню и палитр инструмен-
тов. Здесь надо отметить еще один элемент рабочего окна программы — собствен-
но окно изображения, которое занимает все свободное пространство (см. рис. 3.2).
Открытое изображение и будет подвергаться правке.
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т. в Ф1,
Рис. 3.3. Пользовательский набор палитр

Определившись с основными элементами программы, переходим к нашему при-
меру. Здесь мы создадим небольшую поздравительную открытку, использовав в ка-
честве исходного материала необработанную мобилографию.

3.3. Работа с файлами
Работа с файлами является важной частью любой программы, и Photoshop CS —
не исключение. Основные операции с файлами заключаются в открытии и сохра-
нении различных файлов. Как вы помните, сейчас мы займемся созданием поздра-
вительной открытки.

Начнем с открытия нужного файла. Для этого надо воспользоваться одной из сле-
дующих команд. Во-первых, можно выбрать следующее меню: File > Open. После
этого появится стандартное окно для открытия файлов. Оно довольно удобное —
при выделении графического файла в нижней части окна появляется его миниатю-
ра, есть возможность управления отображением файлов и так далее.

Но есть гораздо более функциональное средство для поиска и открытия файлов.
Оно вызывается при помощи команды File > Browse (рис. 3.4).

Окно File Browser устроено стандартным образом. Оно имеет строку меню, панель
инструментов, содержащую кнопки для быстрого доступа к часто используемым
функциям, и несколько панелей инструментов. Панель Folders служит для работы
с файловой системой вашего компьютера, она очень похожа на Проводник Win-
dows. С ее помощью осуществляется навигация по папкам. Содержимое текущей
папки отображается в рабочем окне File Browser, которое еще называют панелью
эскизов.

Панель Preview служит для предварительного просмотра выбранного изображения.
В панели Metadata можно увидеть различную информацию о просматриваемом сним-
ке. В общем случае — это данные о размере изображения в пикселах, разрешении.
Если кадр снят цифровой камерой (именно такой снимок активен на рис. 3.4), то в
панели Metadata, помимо общих данных, вы увидите так называемую EXIF-инфор-
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мацию о снимке. Эта информация позволяет получить подробную информацию
о снимке, установках камеры в момент съемки и так далее.

•& Adobe Photoshop - £ГЙе Browser]

Ffe Edit tmege 1&ук £elect Filter Vie» grate»

fi* Eda *nw»»!« Son «•«

Рис. З.4. Окно File Browser

Кадры, снятые мобильником, не содержат EXIF-данных, хотя, возможно, уже доволь-
но скоро эта ситуация изменится. Наличие EXIF-данных позволяет фотографу глу-
боко анализировать снимки и, в конечном счете, совершенствовать свои навыки.

Окно просмотра эскизов служит для совершения различных операций с выделен-
ными файлами. Файлы можно открывать для редактирования в Photoshop CS
(собственно, та операция, ради которой мы запустили File Browser), осуществлять
простейшее редактирование — повороты, например. Для открытия файла доста-
точно сделать на нем двойной щелчок или, выделив файл или группу файлов, на-
жать клавишу Enter на клавиатуре.

При помощи строки меню средства File Browser можно осуществлять тонкую настрой-
ку этого средства под нужды пользователя. Так, наиболее полезное меню View слу-
жит для управления размером и представлением эскизов изображений в рабочем
окне. В частности, полезен режим View > Details. В этом режиме эскизы файлов снаб-
жаются довольно подробной информацией, за которой в обычном режиме прихо-
дится обращаться к панели инструментов. Интересен пункт меню Sort > R a n k -
если его выбрать, файлы будут отсортированы по так называемому рангу, который
может быть присвоен каждому файлу. Посмотрите на пункт Rank, расположенный
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в верхней части каждого окна с дополнительной информацией о файле в режиме
Details (рис. 3.5).
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Рис. З.5. Настройка параметра Rank

В данном случае активному файлу присвоен Rank, выраженный текстовой строкой
«Good», то есть хороший. Для присвоения ранга служит соответствующий пункт
выпадающего меню, изображенного на том же рис. 3.5. Использование ранжиро-
вания — это удобное средство для сортировки файлов. Например, хорошим сним-
кам можно присвоить ранг «А» или «Good», как в нашем примере. Изображениям
немного похуже — «В», а самым плохим — кандидатам на удаление (хотя, между
нами говоря, лучше не удалять свои фотографии — иногда самый плохой снимок
может сослужить вам хорошую службу) — «С».

Если отредактировать таким или подобным ему способом параметр Rank всех фо-
тографий в папке, а потом включить сортировку по рангу, файлы, содержащиеся в
папке, будут отсортированы в соответствии с общепринятыми правилами сорти-
ровки.

File Browser позволяет удалять ненужные файлы — для этого надо воспользоваться
клавишей Del на клавиатуре или соответствующим пунктом меню. Для выделения
нескольких файлов в произвольном порядке может использоваться щелчок мы-
шью в комбинации с клавишей Ctrl клавиатуры. Для выделения непрерывного бло-
ка файлов — щелчком в комбинации с клавишей Shift.
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Итак, обсудив особенности работы с File Browser, все же откроем с его помощью
одну из мобилографий, для того чтобы поработать над ней в Photoshop. Для пол-
ноты изложения информации о работе с файлами отмечу здесь, что для сохране-
ния файла служит команда меню Photoshop File > Save. Если выбрать этот пункт
меню, то вместо старого открытого файла будет записан новый файл с тем же име-
нем. Оригинальные данные будут утеряны. В наши планы по созданию открытки
из мобилографий это явно не входит. Так как, выполнив команду File > Save, мы
уничтожим оригинальную фотографию. Пункт File > Save полезен в процессе теку-
щей работы над проектом — чем чаще вы будете сохраняться, тем меньше работы
будет потеряно в случае возможного сбоя системы.

Открыв файл для редактирования, первым делом имеет смысл выполнить коман-
ду File > Save As... По этой команде появится диалоговое окно для сохранения фай-
лов (рис. 3.6), в котором нужно ввести информацию об имени и формате файла.

Валка

Имя «яйла: JGreelingCaitf

Format: Photoshop f .PSD:*. FDD) Отмена

Save Options •
Save:

Cofor:

Г" Asa Сад: П A;-CiOt.afotu

Г sjph3;Charwels rspprOaofc
Г yvsrs

Г Use Proof Setup: fekirg CMfК

Г I£C Proffe: Adobe RGB {1998}

!У Use Lower Case Extension

Рис. З.6. Окно сохранения файла

В нашем случае в качестве имени выбрано «GreetingCard», а в качестве типа файла —
PSD (Adobe Photoshop Document). Этот формат удобен тем, что позволяет сохра-



Работа с файлами * 71

нять в файле различные объекты Photoshop и лучше всего подходит для сохране-
ния рабочих проектов. Помимо формата PSD существует еще довольно много
файловых форматов, наиболее распространенные из которых будут перечислены
ниже. Фактически, эти типы файлов способны полностью удовлетворить требова-
ния практически любого обычного пользователя, в том числе и наши с вами.

Для начала предлагаю вашему вниманию популярный формат графических фай-
лов JPEG Oomt Photographic Experts Group). Это один из основных выходных
форматов цифровых камер (в том числе и камер мобильников). Изображения хра-
нятся в сжатом виде. При больших уровнях сжатия качество изображения может
довольно сильно пострадать. JPEG — основной формат WWW-графики, JPEG-
файлы прямо-таки созданы для отправки по e-mail и распечатки на цветных прин-
терах.

Если вы работаете с изображение в Photoshop, настоятельно не рекомендуется
сохранять промежуточные результаты работы в формате JPEG. Искажения сжа-
тия каждого следующего сохранения будут накладываться на предыдущее сохра-
нение, что в результате может привести к серьезной порче файла. Как правило,
сохранять в JPEG имеет смысл лишь финальную версию проекта. Мы, например,
сохраним в этом формате нашу поздравительную открытку после всех правок.

Помимо JPEG существует формат TIFF, который замечателен тем, что позволяет
хранить и сжимать файлы без искажений. Но нам, по большей части, хватит фор-
мата JPEG.

Говоря о форматах файлов, нельзя не упомянуть о GIF (Graphics Interchange Format),
который хранит изображения с ограниченным количеством цветов (до 256). GIF-
файлы распространены в Интернете, их основное преимущество перед другими
файловыми форматами — возможность создания анимированных картинок.

Похож на GIF и другой файловый формат — PNG. Он не поддерживает анимацию,
но позволяет хранить полноцветные изображения.

Как видите, алгоритм использования форматов файлов в нашем случае (и в боль-
шинстве других случаев) выглядит так: JPEG > PSD > JPEG. To есть оригинал в
JPEG на стадии промежуточной коррекции обрабатывается в формате PSD, а по-
том снова возвращается в JPEG.

Для того чтобы закрыть тему работы с файлами, упомяну о том, что при помощи
команды File > New можно создать новый файл. Для создания файла с параметра-
ми по умолчанию достаточно нажать на кнопку О К, ничего не изменяя в полях вво-
да появившегося окна (рис. 3.7).

Для того же, чтобы создать файл с собственными параметрами, надо определен-
ным образом заполнить поля окна создания нового файла. Так, список Preset со-
держит некоторые часто используемые предустановки. Поля Width и Height пред-
назначены для ручного ввода ширины и высоты нового изображения, причем
имеется возможность выбирать единицу измерения, в которой указываются эти
значения.
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Рис. З.7. Создание нового документа

Параметр Resolution отвечает за разрешение будущего документа, в нашем примере
оно измеряется в пикселах на сантиметр. Color Mode — при помощи этого парамет-
ра устанавливается цветовой режим, в нашем случае это восьмибитные оттенки
серого. И наконец, поле Background Contents позволяет задать цвет фона будущего
изображения.

Собственно говоря, вышеперечисленного вполне достаточно для того, чтобы эф-
фективно работать с файлами в Photoshop CS. Напомню, что в деле создания на-
шей открытки после использования средств для работы с файлами произошли сле-
дующие изменения: во-первых, командой File > Browse мы запустили File Browser и,
найдя нужное изображение, открыли его для редактирования в Photoshop CS. Во-
вторых, мы сохранили изображение в новый файл формата PSD, присвоив ему имя
GreetingCard. Далее, в рамках работы над открыткой, мы разберем работу со слоями.

3.4. Слои, инструменты рисования,
фильтры

Слои являются одной из важнейших частей идеологии Photoshop. Фактически, ни
один сеанс работы с программой не обходится без них. Слой можно представить
себе в виде абсолютно прозрачного листа бумаги. Этот лист можно окрасить в лю-
бой цвет. На нем можно рисовать и размещать различные изображения. Несколь-
ко слоев, которые расположены друг над другом, напоминают пачку таких про-
зрачных листов бумаги.

Если на нижний слой «положить» еще один, то он закроет то, что было изображе-
но на нижнем, причем, если на верхнем слое будут прозрачные участки, сквозь них
будут «просвечивать» соответствующие части нижнего слоя. Прозрачностью сло-
ев можно управлять, равно как и тем, каким образом нижние изображения «про-
свечиваются» сквозь верхние, то есть режимами наложения слоев.
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Для работы со слоями служит палитра Layers (рис. 3.8).

niicste Layer...

Рис. 3.8. Палитра Layers

Основную часть этой палитры занимают миниатюры слоев — в данном случае это
всего одна миниатюра. В верхней части палитры Layers можно видеть список на-
стройки режимов наложения слоя (с параметром Normal в данном случае), бегунок
для настройки непрозрачности слоя (Opacity), несколько кнопок для блокировки
различных параметров слоя.

В правом верхнем углу палитры, немного ниже кнопки ее закрытия, расположена
кнопка с треугольником — нажав ее, можно вызвать меню палитры. В нижней ча-
сти палитры расположены кнопки, очень важные для работы со слоями. Это, сле-
ва направо, следующие.

1. Эффекты слоя. При помощи этой кнопки можно управлять различными эф-
фектами слоя, такими как тень, прозрачность и так далее. Обратите внимание

, на то, что эта кнопка, равно как и многие другие, заблокирована на рис. 3.8. Это
является следствием того, что здесь изображен фоновый слой, который назы-
вается по умолчанию Background. К другим слоям, которые вы добавите к изоб-
ражению, можно применять все эффекты в полной мере.

2. Создание маски слоя.

3. Создание нового набора слоев. При работе над крупным проектом логически
связанные слои имеет смысл объединять в наборы, с которыми удобно работать.

4. Создание нового корректировочного или заливочного слоя. Здесь можно най-
ти множество полезных инструментов для корректировки цветовых кривых,
настройки яркости, контрастности изображения.
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5. Создание нового слоя. Если щелкнуть мышкой по этой кнопке, то создается
новый пустой слой. Если перетащить на эту кнопку один из слоев изображе-
ния, то будет создана его копия.

6. Удаление слоя. Перетащив мышкой слой на эту кнопку, можно его удалить.

Слева от миниатюры слоя вы можете видеть пару значков. Первый — он сделан
в виде глаза — обозначает видимость слоя. Если он установлен, то слой можно ви-
деть на изображении, если нет, то, соответственно, слой скрывается. Другой зна-
чок — кисточка, указывает на то, какой слой активен в настоящий момент. К нему
и будет применяться редактирование. Например, если вы захотите нарисовать что-
нибудь, то кисть или карандаш будут рисовать именно на активном слое.

Слои можно создавать путем копирования выбранного слоя. Как это делать, вы
уже знаете. Можно так же воспользоваться кнопкой создания слоя. Новый слой
можно создать, если скопировать уже существующий из одного изображения на
другое. Для этого нужно открыть в окне Photoshop два изображения и перетащить
мышью миниатюру нужного слоя из палитры Layers одного изображения на дру-
гое. Тогда он будет скопирован на нужное изображение. Слой можно создать, ис-
пользовав в качестве источника выделенную область текущего слоя. О выделении
мы поговорим ниже, а здесь лишь хочу отметить, что возможно создание нового
слоя копированием выделения, выбором пункта меню Layer > New > Layer Via Copy
и через вырезание фрагмента исходного слоя командой Layer > New > Layer Via Cut.

Посмотрите на рис. 3.9. При помощи кнопки создания нового слоя (то же самое
можно сделать командой меню Layer > New > Layer) был создан новый пустой про-
зрачный слой. Кстати, прозрачные участки отображаются в виде, напоминающем
шахматную доску. Потом на этом слое была нарисована импровизированная ра-
мочка из полупрозрачных листьев. Это делается путем выбора инструмента Brush
(Кисть) на панели инструментов и соответствующей его настройки (выбора нуж-
ного шаблона кисти из списка шаблонов, вызываемого при нажатии на кнопку
Brushes панели свойств инструмента Brush).

Аналогично инструменту Brush работают и другие инструменты Photoshop. Под-
робнее об инструментах мы поговорим в соответствующих главах книги — там, где
будет рассматриваться их применение для тех или иных задач. Обратите внима-
ние на панель свойств инструмента Brush (см. рис. 3.9). Здесь есть возможность
управлять формой кисти (параметр Brushes), режимом наложения (параметр
Mode), непрозрачностью кисти (параметр Opacity), параметр Flow отвечает за раз-
мытость краев кисти. Нажав кнопку с изображением пульверизатора можно пере-
вести кисть в режим распылителя.

В правой части панели свойств кисти расположена кнопка, которая вызывает
очень удобную палитру Brushes, позволяющую управлять множеством свойств ки-
сти. Похожая панель свойств имеется и у других инструментов рисования. Среди
инструментов рисования можно отметить следующие:

Brush Tool — уже известная вам кисть;

Pencil Tool — карандаш;
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Gradient Tool — инструмент для создания градиентов;

Paint Bucket Tool — инструмент заливки;

Rectangle Tool — прямоугольник;

Rounded Rectangle Tool — прямоугольник со скругленными краями;

Ellipse Tool — эллипс;

Polygon Tool — многоугольник;

Line Tool — прямая линия;

Custom Shape Tool — пользовательская фигура;

Pen Tool — инструмент для создания кривых. Он находит широкое применение при
работе с выделениями.

a] Docs 9U5.3K/1.9SM

Рис. 3.9. Работа со слоями

Для рисования достаточно перетащить указатель кисти по нужным участкам изоб-
ражения при нажатой левой кнопке мыши. Как вы можете видеть, рамка создана
на отдельном слое. То есть при желании мы можем легко ее отключить, стереть
ненужные элементы (инструмент Eraser), при необходимости — удалить слой, пе-
редвинуть (инструмент Move), нарисовать еще что-нибудь и так далее. Причем все
это можно сделать без ущерба для исходного слоя.
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Теперь попробуем добавить к нашему изображению фрагмент другой фотографии.
Для этого откроем нужный файл, выделим участок, который нас интересует, ко-
мандой Layer > New > Layer Via Copy создадим новый слой с выделенным участком
и перетащим этот слой на наше изображение (рис. 3.10).

Ш Adobe Photoshop

Рис. 3.10. Копирование слоя из другого изображения

Для того чтобы расположить рядом два окна открытых изображений, можно
воспользоваться командой меню Window t Arrange > Tile. После копирования наше
изображение окажется скомбинированным из трех слоев (рис. 3.11). Первый
слой — фоновый — собственно изображение, второй — рамка из листьев, а тре-
тий — скопированный слой из другого изображения.

Как видите, на рис. 3.11 весьма ярко отражается сходство слоев с пачкой бумаги.
Слой, скопированный из другого изображения, расположен поверх слоя с рамкой.
Поэтому на результирующем изображении рамка находится под изображением со
вставленного слоя. Если прижать мышкой миниатюру нового слоя и переместить
ее ниже слоя с рамкой, тогда порядок изображений на результирующем слое по-
меняется.

Мы не будем рассматривать здесь более сложные аспекты работы со слоями, так
как сейчас самое главное — освоить основные операции с ними.

Итак, теперь переместим скопированный из другого изображения слой под слой
с рамкой и применим к нему фильтр размытия по Гауссу командой Filter > Blur > Gaus-
sian Blur (рис. 3.12).
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Рис. 3.11. Состояние изображения после манипуляций со слоями

т Л**е ЯюйкЬор - [GreellnsCatAiM* ® 10У». (layer г, RGB/8*»
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Рис. 3.12. Перемещение слоя и применение к нему фильтра
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Единственным параметром фильтра Gaussian Blur является радиус размытия (Radius),
который измеряется в пикселах. Чем больше этот параметр, тем сильнее раз-
мытие.

Довольно большое количество фильтров организовано в так называемую галерею
фильтров, вызываемую командой Filter t Filter Gallery. Фильтры здесь организова-
ны в виде древовидной структуры. В правой части окна Filter Gallery расположена
область настройки фильтров, в центральной части окна — область выбора текуще-
го фильтра, а слева — область предварительного просмотра. Ниже приведен спи-
сок пунктов меню Filter — он поможет вам ориентироваться в этом важном меню
Photoshop CS.

Q Artistic — фильтры художественной обработки изображения. Например, фильтр
Paint Daubs придает фотографии вид картины, выполненной маслом, а фильтр
Plastic Wrap как бы «обтягивает» изображение пластиковым пакетом. Не сове-
тую применять фильтр Plastic Wrap к портретам.

Q Blur — фильтры размытия. Они используются для корректировки резкости
изображения, придания ему художественных эффектов и коррекции.

d Brush Strokes — штриховые фильтры, они, как и фильтры художественной обра-
ботки изображений, имитируют различные инструменты для рисования. На-
пример, фильтр Accented Edges позволяет сделать акцент на краях, границах
областей различного цвета в изображении.

Q Distort — фильтры искажений. Позволяют искажать изображение по определен-
ному алгоритму.

Q Noise — фильтры для работы с «шумами» на изображении. Они позволяют как
избавляться от шумов, так и добавлять их.

Q Pixelate — набор фильтров, которые позволяют применять к изображениям раз-
личны» эффекты вроде шума, «увеличения» размера пикселов и так далее.

Q Render — это группа фильтров освещения, визуализации. Например, очень мощ-
ный фильтр Lighting Effect позволяет добавлять эффекты освещения на изобра-
жение, а фильтр Lens Flare — блики.

Q Sharpen — фильтры резкости. Наряду с фильтрами размытия применяются для
коррекции изображений.

Q Sketch — эскизные фильтры — довольно разнообразный набор фильтров, среди
них есть, например, такие как Chrome — он «хромирует» изображение, или
Stamp — создает черно-белое условное изображение на основе исходного.

О Stylize — фильтры для стилизации изображений, придания им особого внешне-
го вида, часто это сопровождается потерей детализации, но в любом случае, эти
фильтры достаточно сильно изменяют внешний вид изображения. Например,
фильтр Glowing Edges делает контуры изображения сияющими, одновременно
затемняя остальные участки. Фильтр Solarize имитирует фотографический
эффект предварительной засветки фотоматериала, фильтр Extrude — разбивает
изображение на прямоугольные или пирамидальные блоки, которые «разлета-
ются» в направлении зрителя.
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Q Texture — фильтры текстурирования изображений. Например, фильтр Mosaic
Tiles делает изображение похожим на сложенное из мозаики, а фильтр Patcwork
«складывает» изображение из цветной плитки.

U Video — видеофильтры, они не слишком интересны.

Q Other — здесь находятся фильтры, не вошедшие в остальные группы. Например,
весьма полезный в определенных условиях фильтр High Pass.

После применения фильтра изображение станет размытым. В довершение всего
уменьшим непрозрачность слоя при помощи перемещения соответствующего бе-
гунка.

Теперь переместим изображение в другое место, более для него подходящее, при
помощи инструмента Move (рис. 3.13).

Ш ЛЛоЬе rtx»to*hot> - (GreetmeOinlpsd » i02«*> (Layer 2, R68/8*)!
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Рис. 3.13. Работа со слоем

После всех этих манипуляций, проводимых исключительно с учебной целью, ока-
залось, что результирующее изображение выглядит не так, как хотелось бы. Мно-
го лишних деталей, какой-то непонятный цветок в правом нижнем углу. Посмот-
рев на него под разными углами, думаю, многие придут к выводу, что по меньшей
мере цветок в правом нижнем углу надо убрать. Что мы и сделаем, отключив его
видимость. Посмотрите на рис. 3.14— здесь вы видите некий промежуточный резуль-
тат нашего учебного примера. Обратите внимание на состояние палитры Layers.
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Рис. 3.14. Отключение видимости слоя

Я советую вам попробовать проделать все это самостоятельно в Photoshop. Когда
редактирование слоев завершено, очень часто нужно создать из них единое изоб-
ражение. Для этого существует команда Layer > Flatten Image.

В результате выполнения этой команды все слои изображения превращаются
в один-единственный слой, который содержит все элементы изображения.

3.5. Работа с выделениями
Выделение — это очень важная операция. Изображение в Photoshop CS состоит из
точек, так как Photoshop — это растровый редактор. Цель любого инструмента
выделения — «сказать» редактору о том, с какой совокупностью точек он должен
работать. Например, если мы захотим применить какой-нибудь художественный
фильтр к цветку на переднем плане рис. 3.14, очевидно, нам сначала нужно выде-
лить этот цветок, то есть «объяснить» редактору, какую часть изображения счи-
тать цветком. Для целей выделения в Photoshop CS предусмотрено большое коли-
чество специальных инструментов. На панели инструментов есть целая группа
управляющих ими кнопок. Так, среди них можно отметить следующие.

Q Rectangular Marquee Tool — инструмент для прямоугольного выделения.

а Elliptical Marquee Tool — инструмент для эллиптического выделения.
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Q Single Row Marquee Tool и Single Column Marquee Tool — редко используемые инст-
рументы для выделения одной строки или столбца пикселов.

Q Lasso Tool — лассо, инструмент для выделения произвольных областей.

О Polygonal Lasso Tool — инструмент для выделения в виде многоугольников.

Q Magnetic Lasso Tool — магнитное лассо — инструмент сам ищет границы изобра-
жения и создает выделения.

Q Magic Wand — волшебная палочка — с ее помощью можно провести быстрое вы-
деление больших пространств.

Посмотрите на рис. 3.15. Здесь изображена уже знакомая вам открытка с выделен-
ным цветком на переднем плане.

т Adobe Photoshop - {GreetimjCanlpMl U> 102«л> (Sadcgroimd, RGB/etf >!
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Рис. 3.15. Выделение

Обратите внимание на панель свойств инструмента Lasso, который активен на
рис. 3.15. Здесь вы можете видеть несколько очень важных, общих для всех инст-
рументов выделения, параметров. Особое внимание я предлагаю уделить четырем
кнопкам в левой части панели свойств.

Так, если активна первая слева кнопка (New Selection), то новое выделение удаля-
ет старое. Если нажата вторая кнопка (Add To Selection), то новое выделение добав-
ляется к старому. При активности третьей слева кнопки (Subtract From Selection)
новое выделение вычитается из старого, а четвертая кнопка (Intersect With Selection)
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позволяет оставлять выделенными лишь пересечения существующего и нового
выделений. Это очень полезные режимы.

Например, я начал выделение цветка на рис. 3.15 при помощи Magnetic Lasso. Все
шло хорошо, но случайно сделанный двойной щелчок завершил выделение на по-
ловине. Если бы я начал новое выделение в режиме по умолчанию — с активной
кнопкой New Selection, — то старое выделение было бы потеряно.

Чтобы этого не случилось, я нажал кнопку Add To Selection и продолжил выделять
как ни в чем не бывало. После того как выделение было создано, понадобилось его
слегка откорректировать. Коррекция была проведена инструментом Lasso Tool в ре-
жимах Add To Selection и Subtract From Selection.

Параметр Feather панели свойств Lasso Tool служит для управления растушевкой
выделения. Это нужно для того, чтобы граница выделения не была резкой. То есть
получается, что наряду с выделенными и невыделенными участками изображения
могут существовать частично выделенные. Если, например, попытаться приме-
нить какой-нибудь художественный фильтр к выделенному участку изображения
с растушеванными краями, то окажется, что этот фильтр будет частично приме-
нен и к краям.

Параметр Anti Aliased служит для сглаживания границ выделения. Без этого пара-
метра непрямые линии выделения будут ступенчатыми.

В целом, для нормальной работы обычно хватает установок инструментов выде-
ления по умолчанию. Если для тех или иных целей вам понадобится тонкая на-
стройка этих инструментов — соответствующие настройки будут рассмотрены
в тексте следующих глав.

На рис. 3.15 вы можете видеть панель Channels. Подробнее об этой панели мы по-
говорим в главе о цветокоррекции. Здесь лишь хочу обратить ваше внимание на
то, что в нижней части панели расположен новый альфа-канал, который называ-
ется «Выделенная область». Как видите, он повторяет контуры выделения. Аль-
фа-канал создан для того, чтобы сохранить созданное выделение.

Предположим, что, поработав с эти выделением, мы решили сделать еще одно. Как
правило, сложное выделение создается довольно долго, да и создать второе анало-
гичное часто просто невозможно — хотя бы в мелочах, но различия будут. Сохра-
нить выделение можно в новый альфа-канал, сделать это можно, нажав на панели
Channels на кнопку Save Selection As Channel. После нажатия на эту кнопку выделе-
ние будет сохранено в виде нового альфа-канала.

Желательно сразу же дать выделению какое-нибудь осмысленное имя. Для этого
надо щелкнуть по треугольничку в правом верхнем углу палитры Channels и в по-
явившемся меню выбрать пункт C h a n n e l Options, где и изменить параметр Name.
После того как выделение сохранено, его можно снова загрузить, выделив соответ-
ствующий альфа-канал (работа с каналами изображения практически ничем не
отличается от работы со слоями в палитре слоев) и нажав на кнопку Load Channel
As Selection на палитре Channels .
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Роль дополнительных альфа-каналов заключается не только в хранении выделе-
ний. Так, Photoshop имеет так называемый режим быстрой маски. Он включается
кнопкой Edit In Quick Mask Mode на панели инструментов. Когда включается режим
создания быстрой маски, вы имеете возможность рисовать на изображении любы-
ми инструментами рисования. Их штрихи, отображаемые в виде красного полу-
прозрачного закрашивания (рис. 3.16), при переходе в обычный режим (кнопка
Edit In Standard Mode) будут преобразованы в выделение.

При нажатии на кнопку Edit In Quick Mask Mode создается новый альфа-канал, хра-
нящий информацию о выделении. После перехода в режим Edit In Standard Mode
рекомендуется полученное выделение сохранить в виде нового альфа-канала.
Кстати, альфа-каналы можно редактировать. Белые области альфа-канала означа-
ют выделенные пикселы, черные — невыделенные, а различные промежуточные
состояния символизируют растушевку.
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Рис. 3.16. Работа в режиме быстрой маски

Теперь предлагаю вашему вниманию более подробный рассказ о меню Select.

Команда Select > All позволяет выделить все изображение.

Команда Select > Deselect позволяет снять выделение.

Команда Select > Reselect позволяет восстановить выделение, снятое командой De-
select.
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Весьма полезной бывает команда Select t Inverse. С ее помощью можно инвертиро-
вать выделение, сделав выделенными не выделенные ранее области и сняв выде-
ление с выделенных областей. Например, сейчас это может быть полезным, если
на нашей открытке мы применим какой-нибудь художественный фильтр к выде-
ленному цветку на переднем плане, а потом захотим приметить другой эффект к
фону. Для того чтобы сделать это максимально аккуратно, достаточно инвертиро-
вать выделение вышеуказанной командой и работать с новым выделением.

Командой Select > Feather можно задать растушевку краев выделения после его со-
здания.
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Рис. 3.17. Результаты работы с выделениями

Остальные команды меню Select применяются достаточно редко, поэтому при не-
обходимости мы обсудим некоторые из них в соответствующем разделе. Кстати,
если щелкнуть правой кнопкой мыши по выделенной области в режиме работы
одного из инструментов выделения, появится всплывающее меню, в котором со-
браны наиболее часто используемые команды для работы с выделениями.

Итак, выделив нужный участок изображения, применим к нему фильтр Plastic
Wrap. Затем, инвертировав выделение командой Select > Inverse, к полученному вы-
делению применим фильтр Glass. После этого создадим эллиптическое выделение,
инвертируем его и применим к полученному выделению фильтр Patchwork. Резуль-
тат вы можете видеть на рис. 3.17.
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После того как мы с вами освоили основные приемы работы с выделениями, са-
мое время поговорить об инструментах коррекции и ретуши. Сразу скажу, что ре-
туши будет посвящена отдельная глава, поэтому здесь мы лишь ознакомимся с ни-
ми и разберем основные приемы работы с этими инструментами.

3.6. Инструменты коррекции и ретуши

Инструменты коррекции и ретуши предназначены для правки изображений, устра-
нения различных недостатков. Эти инструменты можно подразделить на несколь-
ко групп. Во-первых, это инструменты для коррекции резкости — Sharpen Tool, Blur
Tool и совершенно уникальный Smudge Tool. Они, соответственно, используются
для повышения, понижения резкости отдельных участков изображения и для раз-
мазывания отдельных участков изображений. Действие Smudge Tool напоминает
размазывание красок пальцем. Эти инструменты полезны для точечной коррекции
резкости, для глобальных задач, затрагивающих все изображение, удобнее исполь-
зовать соответствующие фильтры. Однако Smudge Tool нет достойной альтернати-
вы среди фильтров.

Далее, это инструменты для тоновой и цветовой коррекции. Они нужны для кор-
рекции цветов на небольших участках изображения. Среди них можно отметить
Dodge Tool, служащий для осветления отдельных участков изображения, Burn Tool —
для затемнения, и Sponge Tool, с помощью которого можно изменить насыщенность
цвета отдельных частей изображения.

Инструменты для ретуши не имеют аналогов среди фильтров. Наиболее извест-
ным среди них является Clone Stamp Tool. С его помощью осуществляется копиро-
вание определенных областей изображения на другие его части. Пользоваться им
очень легко — сначала надо навести мышь на тот участок изображения, который
вы хотите копировать, щелкнуть по нему мышью при нажатой кнопке Alt на кла-
виатуре. После этого достаточно «рисовать» инструментом по нужной области, на
которую будут копироваться выбранные в предыдущем шаге участки изображе-
ния (рис. 3.18).

Это удобный, но достаточно грубый инструмент ретуши. Более тонкую коррекцию
можно провести при помощи Healing Brush Tool, которая после копирования участ-
ка изображения на новое место автоматически подстраивает его внешний вид та-
ким образом, что он практически не отличается от новой области.

Весьма интересен инструмент Patch Tool. Это один из моих любимых инструмен-
тов для ретуши изображений. Подробнее о нем мы поговорим в следующих гла-
вах — он этого стоит.

Инструмент Color Replacement Tool предназначен для замены цветов на тех или
иных участках изображения.

Теперь осталось совсем немного рассказать об основах работы с Photoshop. А имен-
но — пара слов о тексте и «Действиях». Заодно и открытку нашу доделаем.
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Рис. 3.18. Работа Clone Stamp Tool

3.7. Работа с текстом
Текст не играет первостепенной роли в Photoshop. Но иногда на изображение тре-
буется нанести какие-то надписи. Как в нашем случае с открыткой. Для работы с
текстом существуют специальные инструменты: Horizontal Type Tool, Vertical Type
Tool, Horisontal Type Mask Tool и Vertical Type Mask Tool. Первые два предназначены для
создания горизонтального и вертикального текста. А следующие — для создания
выделений в виде текста. Такое выделение можно залить любым цветом или при-
менить к нему любые фильтры.

Настройка различных параметров текста осуществляется при помощи панели
свойств инструмента Туре. Посмотрите на рис. 3.19. Здесь вы можете видеть изоб-
ражение после добавления текста (после того как текст набран, надо нажать на
кнопку с галочкой в правой части панели свойств инструмента Туре для того, что-
бы изменения были приняты и текст был добавлен к изображению). Как вы може-
те видеть на рис. 3.19, Photoshop поддерживает вполне стандартные средства для
управления текстом — можно выбирать гарнитуру шрифта, размер, положение на
странице и так далее.

На этом обсуждение инструментов и основных средств Photoshop предлагаю счи-
тать завершенным. Для полноты изложения осталось лишь рассказать об инстру-
ментах для удаления фона и вырезания участков изображения. Это разновидио-
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ста Eraser Tool (Ластик) и Slice Tool (Вырезание фрагментов) — они практически не
будут применяться нами в дальнейшей работе. Также мы не рассматриваем здесь
инструмент Crop (Вырезать), применяемый для кадрирования изображений, инст-
рументы Measure Tool (Линейка) для измерения расстояний и углов, Eyedropper Tool
(Пипетка) -- инструмент для получения цветопроб, мы подробно поговорим о них
в соответствующей главе.

Рис. 3.19. Работа с текстом

А теперь еще несколько слов о средстве для автоматизации деятельности, которое
называется Actions или Действия.

3.8. Actions
При помощи Actions можно записывать часто используемые вами последователь-
ности действий и при необходимости выполнять их одним нажатием на кнопку.
Для работы с действиями служит палитра Actions (рис. 3.19).

Для создания нового действия достаточно нажать кнопку с изображением листа
бумаги (стандартная кнопка, обозначающая создание нового объекта в терминах
той или иной палитры) на палитре Actions. После этого появится диалоговое окно,
в котором надо задать имя действия и функциональные клавиши для его быстро-
го вызова. Затем достаточно нажать на кнопку Record в этом диалоговом окне, сде-
лать то, что требуется записать в действие, и остановить запись нажатием на кнопку
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с квадратиком на палитре Actions. Все, что было сделано, будет записано и добав-
лено в стандартный набор действий. Теперь для того, чтобы выполнить все то, что
мы делали, достаточно найти сохраненное действие и запустить его на выполне-
ние кнопкой с изображением треугольника в нижней части палитры Actions.
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Рис. 3.20. Работа с действиями

Действия позволяют автоматизировать часто выполняемые операции. Так, напри-
мер, можно написать действие для удаления каких-то определенных дефектов с
изображения. Скажем, это может быть Action для борьбы с последствиями JPEG-
сжатия. Такое действие, если вам часто приходится бороться с подобными недо-
статками, способно серьезно сэкономить ваше время. Однако ручное выполнение
операций обладает большей гибкостью, поэтому предлагаю рассматривать Action
лишь как удобное дополнение к ручной обработке графической информации.

3.9. Выводы
В этой главе мы с вами познакомились с Photoshop CS. Этих знаний вам вполне
хватит для того, чтобы выполнять достаточно продвинутое редактирование ваших
мобилографий, речь о котором пойдет дальше. Нас ждет много интересного. Пред-
лагаю начать.
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Сейчас мы приступаем к разбору интересного материала, посвященного обработ-
ке изображений. Adobe Photoshop CS — это очень мощный инструмент, который
может творить с фотографиями настоящие чудеса.
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Эта глава посвящена изменению размеров, кадрированию изображений и коррек-
ции такого распространенного «недостатка» мобилографий, как последствия силь-
ного JPEG-сжатия. Недостаток этот, если говорить о художественной ценности
мобилографий, — зачастую не такой уж и недостаток. Однако если рассматривать
мобильные фотографии с утилитарной точки зрения — с сильным сжатием надо
бороться. Что мы и сделаем, рассмотрев методику удаления следов этого сжатия.

А изменение размеров изображения и кадрирование позволят вам, с одной сторо-
ны, устранять с фотографии явно лишние предметы, оказавшиеся на ее перифе-
рии, а с другой — эффективно изменять размеры мобилографий.

4.1. Корректировка последствий сильного
JPEG-сжатия

Итак, приступим к работе с последствиями сильного сжатия изображений по
алгоритму JPEG. Для начала рассмотрим некоторые важные для нашей работы
особенности работы этого алгоритма. Так известно, что сжимаемое изображение
разбивается на квадратики 8x8 пикселов. Цветовая и яркостная информация, за-
кодированная в этих пикселах, особым образом обрабатывается.

| К Adobe Photoshop - f3»-l<HM_OTS6.Jp9 »3St№ (RGB/8*)!
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Рис. 4.1. Последствия сжатия на портрете
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В результате сильного сжатия квадратики 8x8 оказываются очень хорошо замет-
ными. Причем здесь можно отметить одно наблюдение, которое связано с чисто
физическими особенностями восприятия графической информации. Например,
на мобилографии изображен, скажем, портрет крупным планом (рис. 4.1 — увели-
ченный фрагмент портрета).

То есть изображение с достаточно большими участками со сравнительно однород-
ной окраской и фактурой. На такой фотографии последствия сильного сжатия
будут очень заметны. На фотографии же, изображающей какой-нибудь пейзаж, на-
тюрморт со множеством сравнительно мелких деталей (рис. 4.2) и так далее, сжа-
тие будет уже менее заметным.

Происходит это потому, что множество мелких линий пестрого пейзажа как бы
скрывают сильное сжатие от нашего взора, в то время как портретная съемка, на-
оборот, выявляет его. Кстати сказать, именно на мобшюграфиях, сходных по со-
держанию с портретами, сжатие корректируется лучше всего. К таким снимкам
можно применять более сильные методы коррекции.

Фотографии со множеством мелких деталей, с одной стороны, не нуждаются
в слишком сильной коррекции, а с другой, если бы и нуждались, — такая коррек-
ция может слишком сильно повлиять на их содержимое.

В Adobe «MloshOB • [24.09-84_1419дав в 350% Ш<ЭД«*)]

Рис. 4.2. Последствия сжатия на снимке с множеством мелких деталей
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Вооружившись теорией, продолжим рассматривать наш алгоритм сжатия дальше.

Известно, что, «сжимая» информацию, JPEG сильнее всего вмешивается в ее цве-
товую составляющую и гораздо меньше — в яркостную. Логично было бы исполь-
зовать для коррекции искажений такой режим работы Photoshop, при котором
есть возможность отдельно работать с цветовой и яркостной информацией изоб-
ражения. Забегая вперед, скажу, что таким режимом является цветовое простран-
ство LAB.

Для того чтобы сделать изложение более понятным, я предлагаю вашему внима-
нию рассказ о цветовых пространствах Photoshop. Эта информация, помимо нуж-
ного нам в данный момент LAB, даст опору для цветокоррекции изображений, ко-
торой будет посвящена одна из следующих глав.

4.2. Цветовые модели Photoshop
В реальности существует два типа цветных предметов. Одни из них отражают
часть падающего на них света, а другие излучают свет сами. Для цифровой обра-
ботки данных цвета предметов надо каким-то образом описывать. Дело осложня-
ется тем, что разные устройства для работы с цветом по-разному воссоздают тот
или иной цвет.

Например, изображение на мониторе формируется при помощи трех цветов -
каждая точка изображения, фактически, состоит из трех точек — красной, зеленой
и синей. Причем эти точки светятся. Принтеры могут использовать уже не три, а
четыре цвета — голубой, пурпурный, желтый и черный, — они, смешиваясь, дают
нужный оттенок. Если говорить о возможных моделях представления цвета, то
неплохо было бы иметь универсальные цветовые модели, которые не зависят от
особенностей представления цветов теми или иными устройствами и наиболее
полно и правильно описывают цвета объектов реального мира. Рассуждения, по-
хожие на вышеописанные, привели к созданию нескольких цветовых моделей,
каждая из которых по-своему уникальна и полезна. Среди них можно отметить
RGB, CMYK и уже известную вам модель LAB.

Модель RGB названа так от английских наименований трех базовых цветов — крас-
ного (Red), зеленого, (Green) и синего (Blue). Эту модель называют аддитивной.
При смешивании двух или трех основных цветов результирующий цвет получает-
ся более ярким, чем исходные, цвета как бы «складываются».

Как уже было сказано — RGB является основной моделью для отображения ин-
формации на мониторе. Надо отметить, что в этом же формате сохраняют инфор-
мацию цифровые камеры мобильников. Цветовая информация для каждой точки
изображения в формате RGB состоит из трех байт. Напомню, что один байт состав-
ляют 8 бит, то есть в результате получается 256 (от 0 до 255) вариантов яркости -
именно яркость каждого цвета символизирует соответствующий ему байт.

Если сложить красный, зеленый и синий цвета с нулевой яркостью, то получится
черный. Если с яркостью 255 — белый. Все, что находится между этими крайними



Цветовые модели Photoshop .;. 95

вариантами, дает какой-то другой цвет. Кстати, если всех трех цветов окажется
поровну, то получится серый цвет разной интенсивности — чем больше яркость,
тем более светлым будет серый. Например, 128R 128G 128В даст нам нейтральный
серый цвет.

Вышеописанный вариант модели RGB имеет название 8-битного цвета, так как
яркость каждого цвета описывается восьмибитным числом. Photoshop может ра-
ботать и с изображениями, имеющими 16-битный цвет, но в случае с мобилогра-
фией эта его возможность остается невостребованной.

В результате для описания одной точки изображения в режиме RGB требуется
информация о яркостях красной, зеленой и синей составляющих этой точки.
В Photoshop эта информация разделена на три канала. А для работы с цветовыми
каналами (кстати, не только в модели RGB) служит палитра Channels. Посмотрите
на рис. 4.3. Здесь вы можете видеть каналы мобилографии, на которой изображена
красная роза.

S1

Рис. 4.3. Палитра Channels для цветового пространства RGB

Обратите внимание на то, что в канале красного цвета роза кажется очень светлой —
это соответствует особенностям модели RGB, описанным выше. Канал каждого
цвета, фактически, выглядит как изображение в оттенках серого. Он действитель-
но является таким изображением, так как в случае с RGB несет лишь информацию
о яркости составляющей каждого из базовых цветов.

Также определенной популярностью, особенно у тех, кто занимается допечатной
подготовкой иллюстраций, пользуется цветовая модель CMYK.

Она получила свое название от четырех основных цветов, используемых при рабо-
те с ней. Это Cyan (Голубой), Magenta (Пурпурный), Yellow (Желтый) и Black (Чер-
ный). Как уже было сказано, модель CMYK актуальна для полиграфии. Иногда ее
называют субтрактивной моделью — ее цвета образованы при помощи вычитания
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из белого цветов аддитивной модели RGB. При смешивании цветов модели CMYK
результирующий цвет становится темнее, а не светлее, как при смешивании цве-
тов в модели RGB. Так, если смешать голубой, пурпурный и желтый цвета, то по-
лучится черный.

Но в реальности при смешивании этих цветов идеального черного цвета не полу-
чить, поэтому и применяется дополнительный черный цвет. Палитра Channels для
изображения в режиме CMYK показана на рис. 4.4.

Рис. 4.4. Палитра Channels для цветового пространства CMYK

В модели CMYK смысл имеет уже не яркость, а количество каждого цвета, кото-
рое нужно для получения результата.

Далее рассмотрим цветовую модель LAB, ради которой мы и затеяли здесь разго-
вор о цветах. Как вы могли заметить, модели RGB и CMYK созданы с ориентаци-
ей на аппаратные особенности тех или иных устройств. Первая наилучшим обра-
зом описывает отображение информации на компьютерном мониторе, а вторая
ориентирована на смешивание цветов при печати. То есть эти модели аппаратно
зависимы, что является их недостатком, ограничивающим, в частности, цветовой
охват той или иной модели.

В связи с этим, кстати, не рекомендуется многократный перевод изображения из
одной цветовой модели в другую при редактировании. Исключением из этого пра-
вила является модель LAB, которая создана как аппаратно независимая, отража-
ющая реальное восприятие цвета человеком и имеющая огромный цветовой охват.

Название модели LAB получено от трех компонентов цветного изображения, опи-
сываемых моделью. Это Lightness — яркость — и два хроматических (то есть цве-
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товых) компонента А и В. Аналогично названию компонентов названы и каналы
LAB-изображения в Photoshop. Канал L (Lightness) несет информацию о яркости.
Канал А показывает изменение цвета от зеленого до красного, а В — от синего до
желтого. Такое на первый взгляд странное распределение информации по каналам
наиболее полно соответствует биологическим особенностям восприятия цвета че-
ловеком.

Модель LAB очень удобна для некоторых видов коррекции. Разделение цветовой
и яркостной информации позволяет добиваться хороших результатов при некото-
рых видах коррекции резкости и так далее.

Посмотрите на рис. 4.5. Здесь изображена палитра Channels для цветовой модели
LAB и кое-что еще.
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Рис. 4.5. Палитра Channels для цветового пространства LAB

А именно на рис. 4.5 показано меню, с помощью которого осуществляется конвер-
сия изображения между цветовыми пространствами. То есть для перевода изоб-
ражения в цветовое пространство LAB надо выполнить команду Image > Mode > Lab
Color, для перевода в RGB — Image > Mode > RGB Color. Как видите, в меню Mode, по-
мимо описанных нами, есть и другие цветовые пространства.

Так, Grayscale — это изображение в оттенках серого. Кстати, если перевести изобра-
жение в режим Grayscale, то мы получим в точности то, что содержит канал яркости
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модели LAB. Режимы Bitmap, Duotone, Indexed Color доступны для Grayscale-изобра-
жений. Об их использовании мы поговорим в соответствующей главе, а пока вер-
немся к нашему изображению для коррекции.

Как вы помните, мы остановились на конверсии сильно сжатого изображения
BLAB.

4.3. Продолжаем коррекцию 8x8
Итак, переведя изображение в цветовое пространство LAB, мы получаем возмож-
ность отдельно работать с яркостной и цветовой информацией. Как вы помните,
JPEG сильнее вмешивается в цветовую информацию изображения, оставляя яр-
кость в сравнительно нормальном виде.

Для наглядности я привел здесь (рис. 4.6) увеличенные изображения канала яр-
кости для редактируемого снимка и канала А.

т Adobe Photoshop
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Рис. 4.6. Каналы L и А

Как вы понимаете, яркостный канал расположен в верхней части изображения,
а хроматический канал А — в нижней. Думаю, очевидно, что наибольшие повреж-
дения испытывает именно хроматический канал. На канал А очень похож в плане
повреждений канал В. То есть теперь мы имеем раздельное представление кана-
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Для того чтобы получить доступ к редактированию каналов, надо, переведя изоб-
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Выделив этот канал, устанавливаем в палитре Navigator 100 % масштаб изображе-
ния (это можно сделать, передвинув бегунок вправо до тех пор, пока в левом о?не
не окажется значение 100 %, или введя число 100 с клавиатуры в это же окно)
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управлять размытием. Теперь выполним команду Filter > Blur > Gaussian Blur Здесь
нам останется лишь увеличивать параметр Radius до тех пор, пока все искажения
«е буДУт размыты. Посмотрите на рис. 4.7, где изображен процесс редактирования
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Рис. 4.7. Применение фильтра Gaussian Blur

Для достижения наилучших результатов попробуйте поступить следующим обра-
зом: отметьте для себя какой-нибудь наиболее поврежденный участок изображения
и, следя за ним, увеличивайте Radius. В данном случае оказалось, что при Radius
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равном 2,8, практически все недостатки были устранены, а самое проблемное место
все еще выделялось, поэтому Radius был увеличен до 3,8.

Аналогичную операцию надо выполнить с каналом В, только каналу В хватило па-
раметра Radius, равного как раз 2,8.

А вот канал L требует уже более тонкого обращения. Несмотря на то что он выгля-
дит довольно хорошо, канал яркости также подвержен некоторым искажениям
сжатия, хотя они заметны на нем гораздо слабее. Сильно размывать его нельзя —
исчезнут детали, поэтому с ним можно поступить по-другому. Во-первых, есть
смысл использовать фильтр Filter > Noise > Depeckle. Этот фильтр должен удалять
шумы с изображения, в данном же случае он способен довольно мягко очистить
картинку, не касаясь деталей.

Применение к каналу яркости этого фильтра удаляет с него все следы сжатия. Од-
нако иногда (ив нашем случае в том числе) фильтр Depeckle оказывается слишком
сильным средством. Поэтому канал яркости есть смысл обработать очень слабым
фильтром Gaussian Blur. Его значение лежит в пределах от ОД до 0,6 пикселов. В на-
шем случае хватило 0,4 пиксела для того, чтобы избавиться от следов сжатия.

Альтернативой слабому Gaussian Blur может стать следующая техника: применить
к изображению фильтр Depeckle и сразу после этого, выбрав пункт меню Edit > Fade
Depeckle, настроить параметр Opacity, уменьшив его. Таким образом действие филь-
тра ослабляется, и мы, вместе с приемлемым удалением шумов, не вмешиваемся
слишком сильно в резкость изображения.

После всех этих манипуляций переводим изображение обратно в RGB и придир-
чиво изучаем. Иногда даже все выполненные действия, в целом весьма эффектив-
ные, не приводят к желаемому результату — кое-где на изображении остается что-то
вроде «сеточки». Эти остатки былых разрушений можно удалить, воспользова-
вшись изменением размера изображения на 50-100 пикселов. Слабая интерполя-
ция (подробности об интерполяции читайте немного ниже) разрушает физиче-
скую структуру слабых же искажений и в результате изображение выглядит если
не идеально, то, по крайней мере, лучше, чем раньше.

Для сравнения посмотрите на рис. 4.8. Здесь приведены два изображения — уве-
личенный в три раза фрагмент исходной мобилографии до коррекции (снизу)
и после нее (сверху).

Как видите, результат заметен невооруженным глазом. Однако это не самый впе-
чатляющий пример коррекции искажений 8x8. Посмотрите на рис. 4.9. Здесь при-
веден результат коррекции портрета. На портретах искажения видны сильнее, чем
на других фотографиях, поэтому результаты исправлений выглядят достаточно
хорошо. Кстати, на откорректированных снимках можно отметить некоторую раз-
мытость по сравнению с «резкостью» исходных кадров.

Если поразмыслить над этим, то окажется, что резкость страдает не слишком силь-
но, скорее мы имеем дело со зрительным обманом, когда резкие границы фрагмен-
тов 8x8 заставляют изображение казаться резче, чем оно есть на самом деле.
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Рис. 4.8. Результаты коррекции

Рис. 4.9. Результаты коррекции портрета
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Однако размытие есть размытие — даже очень слабое, оно уменьшает резкость
изображений, и с этим приходится мириться.

Резкость изображений после удаления артефактов сжатия все же можно поднять,
но об этом читайте в одной из следующих глав.

Кстати, методика коррекции искажений JPEG-сжатия в LAB может быть примене-
на для устранения легкого шума с обычных цифровых фотографий. С той только
разницей, что параметры Radius для Gaussian Blur редко превышают 1,5-2 пиксела
для каналов А и В и 0,5 для канала L.

А сейчас пришло время поговорить о кадрировании и изменении размеров моби-
лографий.

4.4. Кадрирование, выравнивание
изображений
Кадрирование обычно осуществляется при съемке. Но иногда требуется дополни-
тельное кадрирование, то есть «отрезание» лишних частей кадра. Особенно вос-
требован этот прием при редактировании документальных фотографий.

Дополнительное кадрирование может понадобиться тогда, когда в кадр попадают
явно посторонние предметы, некоторые кадры неплохо смотрятся при кадрирова-
нии в квадрат. Иногда фотограф хочет привлечь внимание зрителя к какому-то
объекту, выделить который и призвано послесъемочное кадрирование.

Конечно, если речь идет о художественной мобилографии, то однозначно рекомен-
дуется кадрировать изображения при съемке, максимально полно используя по-
лезную площадь кадра. Однако бывают случаи, когда без дополнительного кадри-
рования никак не обойтись.

Для кадрирования изображений создан специальный инструмент. Он называется
Crop. С его помощью мы и будем вырезать фрагменты изображений.

Пользоваться кадрированием очень просто. Выберите Crop на панели инструмен-
тов и нарисуйте им рамку кадрирования на изображении (рис. 4.10).

После того как рамка создана, та часть изображения, которая будет удалена, затем-
няется. Поле кадрирования можно изменять, перетаскивая соответствующие мар-
керы выделения на рамке кадрирования. Рамку можно поворачивать — для это-
го достаточно подвести курсор к угловому маркеру и, дождавшись превращения
курсора в двунаправленную изогнутую стрелку, нажать на кнопку мыши и перета-
щить курсор в нужном направлении. Перемещая маркер, находящийся в центре
выделения, можно изменять ось вращения рамки выделения.

После того как вы создали и отредактировали рамку кадрирования, достаточно
сделать двойной щелчок мышью внутри выделения, и изображение будет отредак-
тировано.
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Рис. 4.10. Кадрирование

Кадрирование с поворотом рамки вращения бывает полезным при обработке изоб-
ражений, содержащих слегка наклоненный объект. Однако для исправления на-
клонов объекта съемки (или фотографа в момент съемки) служит более продви-
нутая техника, связанная с использованием инструмента Measure Tool и механизма
поворота холста.

Холст — это как бы «рабочий стол», на котором лежит редактируемое изображение.
Его размерами и поворотом можно управлять. Так, для поворота холста на опре-
деленный угол служит группа команд Image > Rotate Canvas. Пункт Image > Rotate Can-
vas > 180° поворачивает изображение на 180°, команды Image > Rotate Canvas > 90° CW
(и CCW) служат для поворота изображения на 90 градусов по часовой стрелке
(Clockwise) и против часовой стрелки (Counter Clockwise).

Две последние команды удобно использовать для поворота изображений, снятых
в вертикальном формате из горизонтального положения в вертикальное. Из других
пунктов меню можно отметить команды горизонтального и вертикального отраже-
ния холста — Image > Rotate Canvas > Flip Canvas Horizontal и Image > Rotate Canvas > Flip
Canvas Vertical.

Вышеописанный пункт меню может принимать еще одно значение — Image > Rotate
Canvas > Arbitrary. С его помощью можно повернуть изображение на заданный угол:
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для этого его нужно ввести в поле Angle диалогового окна Rotate Canvas. Но значение
угла поворота изображения может быть введено программой автоматически. Для
этого и служит инструмент Measure Tool. Для того чтобы точно повернуть наклонен-
ное изображение, для начала надо найти на нем какие-нибудь заведомо горизон-
тальные или вертикальные объекты, которые должны быть параллельны границам
кадра. Это могут быть дверные рамы, жалюзи, кирпичная кладка и так далее.

Затем нужно провести инструментом Measure вдоль одной из этих линий (рис. 4.11).
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Рис. 4.11. Настройка Measure Tool и применение Rotate Canvas

После этого достаточно выполнить команду Image > Rotate Canvas > Arbitrary — все
параметры появившегося диалогового окна будут настроены, останется лишь на-
жать ОК. В результате изображение будет точно выровнено, а части фона, которые
могут проявиться в районе углов изображения, можно убрать обычным кадриро-
ванием (рис. 4.12).

Вы уже, наверное, обратили внимание на панель свойств инструмента Crop (рис. 4.13).
Воспользовавшись ею, мы можем кадрировать изображения не на глаз, как делали
до этого, а настроив некоторые параметры этого инструмента.

Параметры Width и Height служат для настройки ширины и высоты будущего изоб-
ражения, параметр Resolution — для настройки его разрешения. Нажав кнопку Front
Image, можно скопировать эти параметры с другого изображения — вышеописан-
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ные поля будут заполнены автоматически. Кнопка Clear очищает поля ввода. На-
пример, у нас есть удачное изображение, которое мы хотим взять за образец при
кадрировании — достаточно открыть его, выбрать инструмент Crop, нажать Front
Image для копирования параметров этого изображения. После этого мы можем
рисовать рамку кадрирования на обрабатываемом изображении.
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Рис. 4.12. Кадрирование

Рис. 4.13. Панель свойств Crop

Скажем, введя в поля Width и Height значения 10 и 15, а в поле Resolution — 300 ppi
(pixel per inch — пикселов на дюйм), мы зададим параметры стандартной фотогра-
фии 10x15, подготовленной к выводу на печать.

Если теперь нарисовать рамку кадрирования на изображении, то изменения ее гра-
ниц будут взаимосвязаны, а выделенный участок изображения будет интерполи-
рован вверх или вниз для того, чтобы в результате получилась именно картинка
10x15 см с разрешением 300 ppi. Посмотрите на рис. 4.14.

Здесь вы можете видеть изображение, которое кадрируется с параметрами Width —
10, Height — 15, Resolution — 300 ppi. Объект съемки изображен неровно, и хотя в
художественном плане это не недостаток, мы так же выровняем его по отноше-
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нию к границам кадра поворотом рамки кадрирования. В результате у нас полу-
чится изображение с заданными параметрами (рис. 4.15).
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Рис. 4.14. Кадрирование с заданными параметрами

Обратите внимание на то, что на рис. 4.14 рамка кадрирования не имеет боковых
маркеров выделения — только угловые и центральный маркер вращения. Это лиш-
ний раз показывает невозможность раздельного изменения ее длины и ширины.
Как вы можете видеть (см. рис. 4.13 и 4.14), панель свойств Crop имеет различный
вид в процессе кадрирования и перед началом рисования рамки. Так, если устано-
вить на панели в процессе редактирования флажок Perspective, вы сможете пере-
мещать угловые маркеры выделения в произвольном порядке. Это нужно для того,
чтобы корректировать перспективные искажения.

Скажем, снимая высокое здание с близкого расстояния, вы можете получить
довольно сильные перспективные сходы. Для их корректировки включите режим
Perspective и расположите границы рамки кадрирования параллельно границам
объекта, который нужно исправить. После подтверждения кадрирования объект
окажется выровненным.

Мы уже касались вопроса автоматической интерполяции изображения при кадри-
ровании. Теперь же предлагаю рассмотреть способы ручного изменения его раз-
меров. Так, для изменения размеров изображения служит команда Image > Image
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Size. Если выполнить ее, появится диалоговое окно, изображенное на рис. 4.16. Кста-
ти, это окно отражает состояние мобилографии с рис. 4.15, подвергшейся оконча-
тельному кадрированию.

Е Adobe Pholasftop - [13-ll-(M_141ijM в 24,7% {RGB/8#H
Jnege Lays- Seact Filter Вм fflndow Help

-OT-MA™- ^ ;vi:'"' <~ ><••»! I? Sv>*{ Cokir: •• QtKlr. Г?»»

Рис. 4.15. Результат кадрирования по образцу

Для нас особое значение имеют параметры группы Pixel Dimensions. В нашем слу-
чае изображение имеет размеры 1181 х 1722 пиксела. Если изменить значение окна
Width или Height группы Pixel Dimensions, то изменится и второй параметр, а после
нажатия кнопки О К изображение будет интерполировано до указанного размера.
Оно может быть как уменьшено, так и увеличено.

Посмотрите на флаг Constrain Proportions в нижней части окна изменения размеров
изображения. Если он активирован, это значит, что пропорции при изменении бу-
дут сохраняться. В нижней же части этого окна есть поле Resample Image — если оно
активировано соответствующим флагом, тогда при изменении какого-либо пара-
метра изображение будет интерполировано до нужного размера.

Если снять этот флаг, то мы сможем менять параметры, находящиеся в рамке
Document Size, не затрагивая общего размера изображения в пикселах, а лишь уп-
равляя его разрешением в ppi или размером. Это бывает полезным при подготовке
изображения к печати. Например, для печати на струйном принтере можно ввес-
ти значение 150 или 300 ppi — тогда при снятом флажке Resample Image изменится
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лишь размер готового изображения в сантиметрах, а его размер в пикселах останет-
ся неизменным. Если же флажок Resample Image не снимать, тогда изменение в лю-
бом из полей этого окна приведет к изменениям в других его полях, то есть к ин-
терполяции.

В Adobe Photoshop - ПЗ-Н-в4_1412.}1>а в -J4,/<Vi> (RGB/8#!J

', File Edit Image Layer Sdect Filter View Window
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.д]д|
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Рис. 4.16. Окно свойств средства Image Size

4.5. Изменение размеров изображения
В общем случае увеличение размера изображения программным путем ведет к ухуд-
шению его качества. Насколько сильно ухудшится качество изображения, в нашем
случае мобилографии, зависит от многих факторов.

Так, если попытаться интерполировать изображение, содержащее сильные арте-
факты сжатия, это очень серьезно скажется на его качестве. Квадратики, теперь
уже не 8x8, будут довольно хорошо видны на изображении, а для их уничтожения
описанных выше ювелирных мер будет недостаточно — их вообще практически
невозможно нормально удалить с увеличенного изображения. Точно так же, кар-
тинка с мелкими деталями не станет заметно лучше от интерполяции.

Единственный, видимо, случай, когда полезно увеличение мобилографии — это пред-
печатная подготовка портретов, сделанных крупным планом, наподобие тех, кад-
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рированием которых мы занимались в этой главе. Перед увеличением размеров
неплохо избавиться от артефактов сжатия. После этого надо попробовать изменить
размер изображения, например с 640x480 до 1600x1200. То есть с 0,3 Mpix до 2 Mpix.

Посмотрите на рис. 4.17 — здесь дан фрагмент уже редактированной нами моби-
лографии в 100 %-ном масштабе после увеличения с 640x480 до 1600x1200. Как ви-
дите, получилось не слишком плохо, особенно учитывая то, что кроме удаления ар-
тефактов в LAB и интерполяции с этой фотографией ничего больше не делали.

т Adobe Photoshop - £31-10- 04_9956U.psd (ё> 100% (Яйв/ВИ

Jeteci И!Р B«w ffijndo» tjsip
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Рис. 4.17. Интерполированное изображение

Изображение, конечно, не идеальное, но вот вам (рис. 4.18) для сравнения та же
самая фотография в 100 %-ном масштабе до коррекции. Если распечатать два
этих изображения на домашнем принтере, разница будет довольно серьезная. И
учтите, что это все же очень сильно сжатое изображение с матрицы мобильника.

Конечно, интерполяцией качества не улучшить, но возможности ручного управле-
ния этим самым качеством — серьезный аргумент в ее пользу. Кстати, из чисто
спортивного интереса то же изображение можно интерполировать и до 3 Mpix.

После изменения размеров можно и нужно попытаться провести дальнейшее
улучшение внешнего вида изображения. Возможно, увеличить резкость, в ручном
режиме отретушировать явные недостатки, вызванные шумами или артефактами,
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удалить шумы и проявления артефактов сжатия в LAB и так далее. После этого
можно получить неплохое изображение, которое можно будет печатать.

Б Adobe Ctioto4lK>o - [31- 1О-04 J»56jpg <gi 1OO% (RGB/8»}}
Fate £cfet Image Se^ct fii^er View Window H^3
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Рис. 4.18. Исходное изображение

И в данном случае преимуществом ручной интерполяции перед машинной (ведь
увеличить фотографию можно и при печати стандартными средствами вашего
фотопринтера) является возможность тонкой доводки изображения до нужного
состояния. Различные приемы ретуши изображений мы рассмотрим в следующих
главах.

До сих пор мы рассматривали лишь интерполяцию, что называется, «вверх», то
есть увеличение изображения. Точно так же фотографии можно и уменьшать.
Правда, в случае с мобилографиями это не так актуально, как увеличение. Умень-
шение размеров производится аналогично увеличению — модификацией парамет-
ров окна Image Size. Однако помимо изменения размеров при помощи Image Size
очень удобно пользоваться средством Save For Web, которое можно вызвать коман-
дой File > Save For Web (рис. 4.19).

Окно Save For Web имеет несколько вкладок, которые могут быть доступны при по-
мощи ярлыков в верхней части окна. Первая — Original, отображает состояние нео-
птимизированного изображения. В нашем случае это — 0,3 Mpix снимок с разре-
шением 640x480. Обратите внимание на данные, которые отображаются сразу под
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окном предварительного просмотра фотографии. В данном случае здесь можно
увидеть данные о размере сохраняемого изображения, уровне сжатия и времени,
которое нужно самому обычному модему для загрузки нашего изображения. Сред-
ство Save for Web прекрасно подходит для оптимизации изображения перед сохра-
нением, скажем, для отправки по e-mail.

Save For Web ПметЗ By ImageReady

Рис. 4.19. Save For Web

Средства оптимизации изображения расположены в правой стороне окна Save For
Web. На самом верху расположен список Preset — здесь можно выбрать одну из пре-
дустановок для оптимизации файлов. Однако мы не будем ими пользоваться, изу-
чив установки параметров Save For Web.

Нас будут интересовать следующие инструменты этого средства: во-первых, поле
Quality, которое позволяет устанавливать уровень сжатия (хотя речь идет именно
о том, что мы устанавливаем желаемый уровень качества, под который подбирает-
ся уровень сжатия). Если вы хотите добиться наивысшего качества изображений,
то вам нужно значение Quality 100%, однако заметить разницу между Quality 100,
и, скажем, 85, довольно сложно, особенно при сохранении отредактированных
мобилографий.

Если вы хотите уменьшить размер файла так, чтобы и качество сильно не постра-
дало, тогда вам придется, с одной стороны, использовать достаточно высокие па-
раметры Quality, а с другой — уменьшать размеры файла в пикселах.
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В нилсней части окна Save For Web есть группа параметров New Size. Наиболее инте-
ресны здесь параметры Width, то есть ширина изображения, Height — высота. Если
галочка Constrain Proportion установлена, то, изменяя высоту или ширину изобра-
жения, вы одновременно изменяете и другой его параметр. Иногда удобно ввести
новое значение в поле Percent, которое отображает то, сколько процентов от перво-
начального изображения составляет оптимизированное.

Изменяя вышеописанные поля, вы можете эффективно управлять размером изоб-
ражения, и, что так же немаловажно, тут же видеть результаты оптимизации в окне
предварительного просмотра.

Для отправки изображения по электронной почте желательно найти компромисс
качества и размера изображения, при котором размер (в байтах) находится где-то
в районе 50 Кбайт. Если вы, скажем, отправите десяток таких фотографий по элек-
тронной почте, то размер письма будет под 700 Кбайт, а это уже немало. Особенно
для пользователей DialUp-соединений, то есть обычных модемов. А вот сохраняя
изображение для печати и локального хранения, можно пользоваться максималь-
ными уровнями качества.

Если говорить об изменении размеров изображения, то их можно провести как
в окне Save For Web, так и вышеописанными инструментами Image Size — и тот и
другой способы могут использоваться с равной эффективностью. Однако Image
Size подразумевает возможность ручной правки изображения, которая дает ему
преимущества перед увеличением при помощи Save For Web.

4.6. Выводы
В этой главе мы с вами научились проводить кадрирование, изменение размеров
изображений и поборолись с одним из главных недостатков многих мобилогра-
фий — артефактами JPEG-сжатия. На очереди приемы тоновой и цветовой кор-
рекции изображений.



Рис. 1. Дмитрий Резван, «Первая мобилография»

Рис. 2. Эрнест Брендель, «Beautiful Stranger»



Рис. 3. Эрнест Брендель, «Stil Life»

Рис. 4. Эрнест Брендель, «September»



Рис. 5. Эрнест Брендель, «Every time»

Рис. 6. Дмитрий Резван, «Мобилография»



Рис. 7. Дмитрий Резван, «Мобилография»

Рис. 8. Эрнест Брендель, «Onlytime»



Рис. 9. Эрнест Брендель, «Old country»

Рис. 10. Разные варианты цветокоррекции



Рис. 11. Разные варианты цветокоррекции

Рис. 12. Художественная обработка мобилографии



.

Рис. 13. Художественная обработка мобилографии

Рис. 14. Создание рамок и надписей



Рис. 6.15. Коллаж

Рис. 16. Дмитрий Резван, «Мобилография»
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Q Тоновая коррекция
О Глобальная цветокоррекция
G Местная цветокоррекция
Q Выводы
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Мобилографии очень часто отличаются просто ужасной цветопередачей. Помимо
цветовых странностей, камерам мобильника свойственны и обычные тоновые не-
приятности — слишком светлые или темные снимки, например. Обо всех этих ве-
щах и будет говориться в данной главе.

5.1. Тоновая коррекция
Перед проведением тоновой коррекции полезен предварительный анализ изобра-
жения. Помимо чисто визуального осмотра для целей анализа полезно использо-
вание гистограмм яркости. Гистограммы яркости отражают распределение пиксе-
лов изображении по яркости. Нас они интересуют по нескольким причинам. Для
начала они позволяют достаточно объективно оценивать состояние изображения
с точки зрения выдержки, а с другой — при помощи гистограмм можно довольно
успешно заниматься цветовой и тоновой коррекцией изображения. Хотя полезны
они преимущественно для тоновой коррекции, так как цветокоррекцию гораздо
удобнее и естественнее проводить при помощи цветовых кривых.

т Adobe Photoshop -{»- 10-M_J847.JP9 » 88,7<К> {RSB/8#}J
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Рис. 5.1. Гистограмма яркости

Для предварительного анализа изображения можно использовать палитру Histogram.
Посмотрите на рис. 5.1. Здесь вы можете видеть гистограмму довольно темного
изображения.
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«Холм» на изображенной гистограмме сдвинут влево — это значит, что в изоб-
ражении преобладают темные цвета. Если бы наблюдался сдвиг вправо, это оз-
начало бы наличие большого количества более светлых цветов. И наконец, бо-
лее-менее равномерное распределение яркостей может говорить о нейтральном
изображении.

Однако, не глядя на саму фотографию, довольно сложно сделать окончательный
вывод о ней, если принимать во внимание лишь гистограмму распределения ярко-
стей. Например, гистограмму, изображенную на рис. 5.1, может иметь и вполне
благополучная фотография, на которой снят темный предмет.

Посмотрите на рис. 5.2. Здесь изображена недодержанная мобилография (на са-
мом деле она не совсем недодержанная, но нижняя часть фотографии вышла имен-
но такой). Подобные ситуации встречаются довольно часто. Здесь причиной не-
додержки (то есть недостаточной выдержки) стал тот факт, что аппарат установил
экспопараметры, ориентируясь на сравнительно ярко освещенное небо. За счет
этого небо вышло нормально экспонированным, а вот земля, особенно ее нижняя
часть, оказалась слишком темной.

Ш Adobe Photoshop - [09-01-05 lbSei.jpg ё> 110% (Kt,B/B) j

Рис. 5.2. Недодержанная фотография

Причем, если посмотреть на фото повнимательнее, окажется, что некоторые участ-
ки неба вышли передержанными. То есть при том, что кадр оказался интересным,
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ему свойственны определенные недостатки. Обратите внимание на гистограмму
распределения яркостей. Она имеет явно выраженный «холм» в левой части, хотя
другие ее части распространены достаточно равномерно. Другой «холм», помень-
ше, расположен справа, что говорит о наличии ярких участков.

Сейчас мы попытаемся исправить недостатки этой фотографии. Для начала по-
пробуем настроить яркость и контрастность изображения. Возможно, это как раз
то, что нам нужно. Коррекцию яркости и контаста, равно как и другие виды кор-
рекции, лучше всего проводить при помощи корректирующего слоя. Поэтому со-
здадим корректирующий слой, который отвечает за настройку яркости и контраст-
ности при помощи пункта меню Layer > New adjustment layer > Brightness/Contrast.

В процессе тоновой коррекции изображения желательно держать палитру Histogram
на видном месте — так вы будете лучше представлять себе воздействие корректи-
рующих процедур на изображение.

Здесь позволю себе немного отвлечься от темы тоновой коррекции и подробнее
рассказать о том, как по внешнему виду диаграммы судить о возможном измене-
нии качества изображения. Так, на том же рис. 5.2 можно видеть фотографию с
достаточно широким динамическим диапазоном — на изображении присутствуют
цвета разной яркости, от очень ярких до очень темных. Гистограмма сплошная, без
пропусков — это свидетельствует о высоком исходном качестве материала.

Если в процессе коррекции внешний вид гистограммы станет похож на гребенку,
примерно, как на рис. 5.3, это будет означать сильные повреждения изображения,
серьезные потери качества и то, что сделать с изображением что-то серьезное бу-
дет очень сложно.

Иногда гистограмма изображения не имеет ярко выраженных сдвигов. Практически
все ее столбцы собраны где-то в центре или, если все изображение слишком свет-
лое или темное, ближе к правому или левому краю изображения соответственно.
Например, на рис. 5.3 изображена гистограмма снимка, который имеет очень уз-
кий динамический диапазон и, к тому же, сам по себе довольно темный и тусклый.

Navigator 1 Ыо 1 Histogram

Рис. 5.3. Потери качества при коррекции Рис. 5.4. Гистограмма темного и тусклого
изображения

С таким изображением очень сложно что-то сделать — любая модификация то-
нальных параметров приводит к сильным потерям качества. Однако можно попы-
таться «растянуть» динамический диапазон подобного изображения для его улуч-
шения. А теперь вернемся к нашему изображению с рис. 5.2.
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Мы добавляем к набору его слоев слой для коррекции яркости и контрастности.
После выбора пункта меню Layer > New adjustment layer > Brightness/Contrast появит-
ся небольшое окошко с некоторыми параметрами корректирующего слоя — их
можно оставить по умолчанию и нажать ОК. Теперь к набору слоев изображения
добавится новый корректирующий слой, а на экране появится окошко Brightness/
Contrast, содержащее пару бегунков. Первый из них, Brightness, отвечает за яркость,
а второй, Contrast, — за контрастность.

Перемещая их вправо и влево, можно соответственно повышать и понижать зна-
чения яркости и контрастности изображения. Нужные значения яркости и контра-
стности можно ввести в поля ввода, сопровождающие бегунки.

Если в окошке Brightness/Contrast установлена галочка Preview, то модификация его
параметров будет немедленно отражаться на внешнем виде изображения и на гис-
тограмме яркости палитры Histogram.

Посмотрите на рис. 5.5. Здесь вы видите изображение, окно Brightness/Contrast и ги-
стограмму изображения после модификации яркости и контрастности.

К Adobe Photoshop - [09-01-OS_16<»I.jpg в ПОД (Brightness/Contrast 1, Layer Мж*/в)1
1j| Fite B*l Jmase (.aya- Select Filer V«»

10 12 14 It №

Рис. 5.5. Изображение после коррекции

Теперь посмотрите на палитру Histogram. Гистограмма оказалась сдвинута вправо
и слегка сжата. Увеличение яркости сдвигает гистограмму вправо, уменьшение
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сдвигает ее влево. Увеличение контрастности растягивает гистограмму, а умень-
шение — сжимает.

Понимание модификаций гистограммы яркости, которые являются результатами
настройки яркости и контрастности, очень важно для следующего метода коррек-
ции подобных снимков, более продвинутого.

В нашем случае мы действуем достаточно грубо, хотя при обработке благополучных
фотографий средства Brightness/Contrast обычно хватает. Мы улучшили рис. 5.5
при помощи модификации яркости и контрастности, но очевидно, что, например,
в области неба, и так достаточно яркой, яркость можно было бы и не поднимать, а
вот дополнительный контраст, который не нужен нижней части картинки, небу бы
не помешал. А раз так — попытаемся использовать для коррекции этого изображе-
ния другое средство.

Добавим к изображению новый корректирующий слой командой Layer > New ad-
justment Layer > Levels. Посмотрите на рис. 5.6. Здесь вы можете видеть окно Levels,
отображающее гистограмму нашего изображения, и другие, уже знакомые вам окна.

I» Adobe Photoshop - {W-01-O5_160Sl.tpa * 1184V (levefe I, layer Mask/8>l

fj| fit Ml [шаге Lay» Setecl Bter Vta» Wirafcw Hefc
10 12 14 IS IS IB 112 I»

'' ' ' ' ' ' ' '.--

l.jgi
JgJ^SJ

IS 18 ES 02

Channel: RGB

Input Levels: o оо .1255

Рис. 5.6. Тоновая коррекция при помощи Levels

Обратите внимание на окно ввода Channel. Здесь осуществляется выбор канала
изображения, который будет участвовать в преобразованиях. В нашем случае вы-
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браны все три канала модели RGB, а если заниматься с помощью этого средства
цветокоррекцией, каналы придется выбирать по отдельности.

Сразу под окном C h a n n e l расположены три поля с цифрами, названные Input
Levels, — они характеризуют входные уровни черного и белого. В нашем случае они
равны 0 для черного и 255 — для белого цвета. Под гистограммой расположены бе-
гунки для настройки уровней черного, белого и уровня серого цвета или гаммы
изображения.

При перемещении серого треугольника средние тона изображения сдвигаются
в сторону большей либо меньшей яркости, а динамический диапазон изображения
остается прежним.

Теперь мы начинаем перемещать серый бегунок в сторону теней, то есть влево.
Посмотрите на рис. 5.7.

Е**>Ье Photoshop [O'J 01-05„16081,}рв в IJO%(Lcvf)sl, layer Hask/S>I

Ш 9е &*' %"*ве lWer Sf*a Чет Sew Window Kelp

Channel: ] R56

Input UveteHT 17.38"' Hiss

Рис. 5.7. Коррекция при помощи Levels

При сдвигании средних тонов в сторону меньшей яркости происходит перерас-
пределение тонов между светлыми и темными, на изображении становится боль-
ше светлых тонов. Посмотрите на гистограмму распределения яркостей в окне
Histogram — гистограмма ухудшается, но не слишком сильно. Однако дальнейшее
перемещение серого треугольника в область теней приведет к чрезвычайно сильным
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повреждениям изображения. А то, что мы получили здесь, выглядит неплохо даже
без дополнительной обработки.

Перемещая черный и белый треугольники, можно растягивать динамический ди-
апазон изображения в области теней или светов. Прием растягивания динамиче-
ского диапазона можно использовать для коррекции тусклых изображений, гис-
тограмма яркости которых не имеет явных сдвигов в света или тени. Посмотрите
на рис. 5.8.

tt Adobe Photoshop - IZ6- M- 04 Jf04S,j[N) в 1<X№ {tev«te 1, Uyer Hask/B)] ,шт
JSJ^J

Рис. 5.8. Тусклая фотография

Как видите, это тусклая фотография, ее гистограмма красноречиво свидетельству-
ет об этом. Сейчас мы попытаемся растянуть динамический диапазон этого фото,
сблизив черный и белый треугольники в окне Levels. Черный подведем к самой
границе «холма», а белый — немного дальше. Посмотрите на рис. 5.9.

Как видите, гистограмма изображения действительно растянулась, не без серьез-
ных потерь, естественно. Обратите внимание на то, что склон «холма» очень кру-
той со стороны теней — это значит, что даже небольшое дополнительное переме-
щение черного квадратика вправо способно очень сильно растянуть динамический
диапазон изображения и ухудшить его качество. Говоря о модификации динамиче-
ского диапазона изображения, нельзя не отметить наличие градиентной полоски в
нижней части окна Levels, которая позволяет управлять параметрами Output Levels.
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Рис. 5.9. Результат коррекции

Она также имеет пару треугольников — черный и белый. Их перемещение позво-
ляет сжимать динамический диапазон изображения. Перемещение белого треу-
гольника смещает диаграмму в сторону теней, а черного — в сторону светов.

А вот еще более интересное средство тоновой коррекции. Это Curves — кривые. Для
добавления к изображению корректировочного слоя Curves надо выбрать пункт
меню Layer > New Adjustment Layer > Curves. Кривые замечательны тем, что позволя-
ют модифицировать произвольные яркостные диапазоны. Фактически, в тоновой
коррекции участвует лишь одна кривая. Различные участки кривой соответству-
ют различным яркостным диапазонам изображения.

Когда окно Curves отображается на экране, вы можете водить мышью по изображе-
нию. Мышь в это время принимает вид пипетки. Если щелкнуть ею по какой-ни-
будь точке изображения, то на кривой будет отмечено место, которому соответ-
ствует данная точка изображения.

Если вы хотите сделать это место светлее, щелкните по отмеченному ранее участ-
ку кривой и перетащите его вверх, наблюдая за изменениями картинки. Аналогич-
но, перетащив вниз нужный участок кривой, вы сделаете соответствующие ему
точки на изображении темнее.

Посмотрите на рис. 5.10.
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Рис. 5.10. Тоновая коррекция и Curves

Обратите внимание на палитру Histogram. Фактически, мы слегка сжали при по-
мощи сдвига нижней точки кривой вверх (сделали тени светлее), верхней — вниз
(света — темнее), и одновременно, в пределах новых границ, растянули динами-
ческий диапазон изображения (дополнительные точки на кривой). Произошло
перераспределение яркостей в сторону более светлых пикселов, однако самые яр-
кие области фотографии сделаны не такими яркими.

Из всех вышеописанных кривые являются, видимо, наиболее мощным средством
тоновой коррекции сложных изображений, напоминающих рис. 5.10. А сейчас мы
приступим к цветокоррекции.

5.2. Глобальная цветокоррекция

Цветокоррекция — это один из наиболее сложных и интересных приемов рабо-
ты в Photoshop. Даже дорогие цифровые фотоаппараты, не говоря уже о фотомо-
бильниках, довольно часто страдают цветовыми проблемами. В случае же с мо-
бильной фотографией цвет часто бывает прямо-таки удивительно искаженным.
Для начала надо отметить, что очень часто на мобилографиях можно увидеть цве-
товые искажения, затрагивающие лишь некоторую их часть. Например, один из
углов фото вдруг уходит в синеву — при том, что остальные части фотографии мож-
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но назвать более-менее нормальными. Причем и их «нормальность» порой доволь-
но условна — из-за сильных искажений сложно бывает определить истинный цвет
изображенных на мобилографиях объектов.

Сейчас мы с вами разберем несколько методов простой цветокоррекции. Среди
них автоматическая цветокоррекция всего изображения, тонирование и местная
коррекция цвета.

Photoshop CS имеет очень мощное средство автоматической цветокоррекции. Его
можно запустить, выбрав пункт меню Image > Adjustments > Auto Color. После выпол-
нения этой команды большинство фотоснимков преображаются. Так, обратите вни-
мание на рис. 10 цветной вклейки, первый слева фрагмент (псевдоним автора
V-dyMkax). Если присмотреться к этой неплохой в общем-то фотографии, то ока-
жется, что в ней многовато зеленого. Запустив автоматическую цветокоррекцию, мы
получили то, что вы видите на рис. 10 цветной вклейки (центральный фрагмент).

Я не могу сказать, что результат работы автоматической коррекции цвета идеален.
Но он, по крайней мере, приемлемо исправляет достаточно сильные искажения.
Для того чтобы хотя бы приблизиться к такому результату вручную, потребовал-
ся бы, возможно, не один час экспериментов. Однако мы можем усовершенство-
вать процедуру автоматической цветокоррекции следующим методом.

Для начала запустим средство Curves командой Image > Adjustments > Curves. На-
жмем кнопку Options, и в появившемся окне Auto Color Correction Option установим в
качестве параметра Algorithms пункт Find Dark & Light Colors и выберем галочку Snap
Neutral Midtones (рис. 5.11).
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Рис. 5.11. Настройка автоматической цветокоррекции

Также здесь есть возможность настраивать цвета, которые приобретут тени, света
и полутона при автоматической обработке. Фактически, программа находит,
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например, тени и присваивает им значение цвета, указанного в поле Shadows, соот-
ветствующим образом изменяя другие цвета изображения. Если щелкнуть по это-
му полю (черный прямоугольник после слова Shadows), то появится окно, в кото-
ром можно установить значение теней.

Мы установим здесь значения 12R 12G 12В, с тем же успехом можно установить
немного превышающие это значение параметры или, наоборот, меньшие. На мой
взгляд, тени, установленные вышеописанным образом, выглядят достаточно хоро-
шо, поэтому остановимся на этом значении.

Аналогично надо настроить значения для нейтрального серого цвета, например вве-
дя параметры 128R 128G 128В, и белого, например, остановившись на 240R 240G
240В (рис. 5.12).

^ Select target highightcolor

—

Н: [о '

S: [ 6 % f a: JO

Г 8: ["55™ % Г Ь: |о

С К: [240~ C:f4 4S

Г G: [240~ М:|1 %

В: ПЯЗГ Y: Гз %

K | j

Г™ Save ss defaults

Рис. 5.12. Настройка автоматической цветокоррекции

Установив эти параметры, не забудьте поставить флажок Save As Default для того,
чтобы не пришлось вводить их каждый раз заново для запуска автоматической
коррекции цвета. После настройки всех параметров автоматической цветокоррек-
ции достаточно нажать на кнопку Auto в окне Curves, и программа самостоятельно
найдет на изображении опорные точки и модифицирует цветовые кривые. То есть
будет проведена автоматическая цветокоррекция с заданными параметрами.
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Теперь вы сможете легко и быстро корректировать изображения. Если сравнивать
автоматическую коррекцию с ручной, то ее преимущества (для домашней обработ-
ки фотографий, естественно) начинаешь видеть при столкновении с действитель-
но сложным для коррекции изображением, когда на снимке нелегко найти тени,
света, и в особенности серые участки.

На рис. 10 цветной вклейки (первый справа фрагмент) вы можете видеть резуль-
таты автоматической цветокоррекции с настройкой. На мой взгляд, наиболее
удачным оказалось именно это изображение, то есть то, которое получено при по-
мощи автоматической цветокоррекции с настройкой.

5.3. Местная цветокоррекция
Коррекция цвета в масштабах всего изображения нужна не всегда. Например, от-
корректировав какое-нибудь изображение автоматически, можно заметить нали-
чие посторонних оттенков на каких-либо его частях. Для исправления подобных
недостатков служат инструменты для выборочной цветокоррекции отдельных
участков изображения. Посмотрите на рис. 5.13. Здесь изображены инструменты
для выборочной цветокоррекции.

Рис. 5.13. Инструменты для выборочной цветокоррекции

Инструмент Dodge Tool предназначен для осветления участков изображения. По-
смотрите на рис. 5.14. Здесь изображена панель свойств для Dodge Tool.

Jill, Г i вляЫ * Ы j Rsna«: |м*й=«т« TJ

Рис. 5.14. Панель свойств Dodge Tool

Параметр Brush панели свойств Dodge Tool позволяет настраивать размер и форму
кисти. Интересен параметр Range — он определяет диапазон цветов, на который
будет воздействовать Dodge. Установленного по умолчанию значения Midtones (сред-
ние тона) обычно хватает, но иногда нужно редактировать света (Highlights) или
тени (Shadows), устанавливая соответствующие значения параметра Range. Пара-
метр Exposure позволяет настроить силу воздействия кисти Dodge, а если нажать на
кнопку с изображением распылителя, то Dodge будет работать в режиме распыли-
теля. Самая правая кнопка на панели свойств Dodge служит для тонкой настройки
параметров кисти.

Посмотрите на рис. 5.15. Здесь вы можете видеть панель свойств для инструмента
Burn Tool, который предназначен для осветления участков изображения. Она ни-
чем не отличается от панели свойств Dodge Tool.
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Рис. 5.15. Панель свойств Burn Tool

А вот панель свойств инструмента Sponge Tool достойна более подробного рассмот-
рения (рис. 5.16).

Рис. 5.16. Панель свойств Sponge Tool

Инструмент Sponge Tool по умолчанию настроен на обесцвечивание изображений.
За обесцвечивание отвечает параметр Mode. В данном случае он установлен в зна-
чение Desaturate. А если его переключить на Saturate, то интенсивность окраски
фрагмента изображения, обрабатываемого кистью Sponge Tool, будет повышаться.

К инструментам местной цветокоррекции мы отнесем кисть Color Replacement Tool
(рис. 5. 17).

Рис. 5.17. Color Replacement Tool

Пользоваться этой кистью очень легко — установите в качестве цвета рисования
нужный вам цвет и перетаскивайте Color Replacement Tool по участкам изображения,
где требуется сделать цветозамену. Предметы, по которым вы провели этой кистью,
будут перекрашены.

Похожего эффекта можно добиться при помощи обычной Brush Tool.

Посмотрите на рис. 5.18. Здесь изображена панель свойств Brush Tool, настроенная
соответствующим образом. А именно параметр Mode установлен в значение Color.
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Рис. 5.18. Настройка Brush Tool для замены цветов

Теперь, если попробовать рисовать этой кистью на изображении, она будет менять
его цвет, оставляя фактуру неизменной.

А сейчас мы попытаемся исправить с помощью всех этих средств коррекции ре-
альную мобилографию. Посмотрите на рис. 1 1 цветной вклейки. В его правой части
вы можете видеть неотредактированный фрагмент фотографии, изображающей
кошку (автор Александр Ищенко). Кошка, думаю, это хорошо заметно, вышла
очень уж розовой. Таких кошек у нас в России не водится.
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Для начала попробуем провести автоматическую цветокоррекцию этого фото.
Выбираем пункт меню Image > Adjustments > Curves и в появившемся окне нажима-
ем кнопку Auto. Все бы хорошо, но часть белой кошки остается розоватой. Если
сделать видимой палитру Info и поводить мышью по шерсти кошки, окажется, что
на некоторых ее частях вместо примерно равного количества красного, зеленого и
синего наблюдается сильный уход в красное, при том что остальные участки шер-
сти являются белыми.

Видимо, автомат уже не в состоянии выправить такой поворот дел. Цвета других
деталей фотографии мы можем оценить лишь условно — нас в данный момент
интересует именно кошка. После того как автомат сделал некоторую часть работы
за нас, пришло время заниматься ручной доводкой этой фотографии.

Наша задача следующая: сделать кошку белой. В качестве дополнительного зада-
ния сделаем глаза животного чуть более зелеными. Когда цели и задачи оконча-
тельно определены, приступаем к их выполнению. Для начала берем инструмент
Dodge, устанавливаем параметр Mode на панели его свойств в Desaturate, наст-
раиваем размер кисти и начинаем аккуратно водить по шерсти кошки. Постепен-
но она становится белой. Кстати, за обесцвечиванием можно следить на палитре
Info — белые участки будут выражаться примерно одинаковым количеством крас-
ного, зеленого и синего (рис. 5.19).

15 Adobe Photoshop - [0024! .jsx> 9110% <R<;e/8)1
f j j Ffc Edit image Layer Select Filter Vie»; Window Help

Рис. 5.19. Коррекция изображения
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После того как шерсть кошки стала белой, настало время заняться ее глазами, сде-
лав их немного позеленее. Они у кошки желтые, но в нашем учебном примере ста-
нут зелеными.

Для этого выбираем инструмент Brush, устанавливаем в качестве цвета рисования
зеленый, настраиваем размер кисти, устанавливаем параметр Mode в режим Color,
Opacity ставим процентов на 60 и начинаем аккуратно подкрашивать кошке глаза
(рис. 5.20).

Если вдруг окажется, что мы перестарались и глаза слишком уж яркие, их можно
слегка обесцветить инструментом Sponge, которым мы уже пользовались для об-
работки кошки.

/Adobe Photoshop УШ

Рис. 5.20. Раскрашиваем кошке глаза

После всех этих манипуляций мы получим белую кошку с зеленоватыми глазами
из розовой кошки с глазами янтарного цвета (см. рис. 11 цветной вклейки, пра-
вый фрагмент). Таким же методом можно перекрашивать любые другие предме-
ты на фотографии, скажем, рубашку из синей в красную, или раскрашивать чер-
но-белые фото.

Правда, раскраска черно-белых снимков не входит в наши планы, поэтому, про-
должая разговор о работе с цветом в мобилографии, расскажу о тонировании изоб-
ражений.
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Для тонирования изображения различными цветами очень удобно пользоваться
инструментом Hue/Saturation. Для вызова окна Hue/Saturation можно воспользовать-
ся командой меню Image > Adjustments > Hue/Saturation. А потом, установив галоч-
ку Colorize, перемещать бегунки Hue, Saturation и Lightness до достижения нужных
результатов (рис. 5.21).

Hue/Saturation

Hue; №~
OK

Saturation: 67

Cancel

Load...

Save...

Ughtness:

F Colorize
f? Preview

Рис. 5.21. Настройка параметров окна Hue/Saturation

Бегунок Hue (Тон) отвечает за цвет, Saturation (Насыщенность) — за насыщенность
цвета, a Lightness управляет яркостью цвета, которым тонируется изображение.

5.4. Выводы
Мы с вами разобрали весьма важную часть коррекции мобилографий. Тональные
и цветовые проблемы довольно часто сопутствуют мобильным фотографиям. Те-
перь вы умеете с ними бороться. А следующая глава познакомит вас с методами
ретуши мобилографий и еще кое-чем интересным.
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Эта глава будет посвящена различным специальным методам обработки мобило-
графий. Например, снимали мы пейзаж или портрет. И в кадр, на самое видное ме-
сто, попало нечто совершенно постороннее. Приемы ретуши, обсуждаемые в этой
главе, помогут вам справиться с посторонними деталями ваших мобилографий.
Также мы обсудим вопросы управления резкостью и рассмотрим цифровые спец-
эффекты.

6.1. Ретушь
Перед началом активного вмешательства в пространство фотоснимка предла-
гаю вам открыть этот снимок в Photoshop и немного подумать над ним. Для на-
чала надо ответить себе на вопрос, касающийся цели ретуши. То есть опреде-
лить, что именно на рассматриваемой фотографии вас явно не устраивает. Перед
проведением ретуши неплохо провести устранение последствий сильного JPEG-
сжатия, которое мы уже обсуждали. Возможно, некоторые кадры будут нуж-
даться в дополнительном кадрировании. После подготовки изображения можно
попытаться воспользоваться инструментами ретуши. Собственно говоря, наш рас-
сказ о ретуши будет одним большим примером, иллюстрирующим применение
этих инструментов. Посмотрите на рис. 6.1. Здесь вы можете видеть мобилогра-
фию для ретуши.

И ДаоЬеPhotoshop-i09-OJ-»S_lW81.jpe в 110%» (Lab/8)}

Рис. 6.1. Фотография для коррекции



132 •> Глава 6. Ретушь, резкость, спецэффекты

Этот пейзаж уже как-то нам попадался. На нем мы разбирали особенности тональ-
ной коррекции. Теперь же мы подвергнем его ретуши.

Вообще, самым близким для мобильников жанром является портрет, снятый при-
мерно с полуметра от модели. При таком раскладе можно получить фотографию,
хотя бы сравнимую с результатами работы очень дешевых цифровых мыльниц.
Собственно говоря, если рассматривать чисто утилитарные цели, то мобильник
для этого и нужен.

Но если использовать его для художественной мобилографии, то окажется, что
техническое качество изображений порой очень далеко от идеала. Например, на
рис. 6.1 практически нет мелких деталей. Но с этим трудно что-либо сделать. Сей-
час же мы рассмотрим методику удаления ненужных предметов с изображения —
а именно, с фотографии мы удалим автомобиль, едущий по дороге, и провода на
фоне неба. Начнем с проводов.

Возьмем инструмент Clone Stamp Tool, настроим его размер так, чтобы он был не-
много больше, чем диаметр проводов на фоне неба, и, увеличив изображение для
удобства работы с ним, проведем коррекцию. Делается это так: берется копия фона
сначала с одной стороны от провода, потом с другой и все аккуратно ретуширу-
ется.

Для того чтобы взять копию фона при работе Clone Stamp, достаточно нажать Alt,
щелкнуть мышью по нужному месту, а потом рисовать кистью Clone Stamp там, где
нужна ретушь.

Кстати, в процессе работы бывают нужны разные размеры кисти Clone Stamp. Для
того чтобы быстро изменять размеры кисти, можно воспользоваться кнопками «[»
и «]» на клавиатуре. Только обратите внимание на то, что язык ввода должен быть
английским.

Посмотрите на рис. 6.2. Здесь мы довольно успешно боремся с проводами на фоне
неба при помощи Clone Stamp Tool.

Однако одного Clone Stamp Tool для подобной коррекции недостаточно. Обычно
такие вещи лучше всего делать в два прохода. Первый, довольно грубый, выпол-
няемый при помощи Clone Stamp Tool, служит для того, чтобы убрать резко выделя-
ющиеся посторонние фрагменты с изображения. А второй, выполняемый при по-
мощи Healing Brush Tool или Patch Tool, помогает сделать следы ретуши практически
незаметными и придать изображению максимально естественный вид.

Healing Brush Tool работает точно так же, как и Clone Stamp Tool, с той лишь разницей,
что Healing Brush не просто копирует участки изображения, а еще подстраивает их
цвет под новое окружение. В результате получается очень даже неплохо. А вот
Patch Tool работает весьма интересно.

При работе с Patch Tool сначала надо выделить ретушируемый участок изображе-
ния, а потом, прижав мышью этот участок, «перетащить» его туда, где находится
образец для копирования. В процессе перемещения внутри выделенного фрагмен-
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та можно наблюдать изображение того участка фотографии, над которым находит-
ся указатель мыши.

К/WobePhotoshop - |09-01-05_160в11ля1 в 286% {RGB/8}}
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Рис. 6.2. Процесс коррекции

Если вы еще не поняли, о чем идет речь, — посмотрите на рис. 6.3. Здесь я пытаюсь
убрать часть фонаря вышеописанным методом. Пытаюсь, однако, неправильно,
так как перед этим данный участок надо грубо обработать при помощи Clone Stamp
Tool для того, чтобы Patch Tool не руководствовался в подгонке скопированного
изображения цветами объектов, которые нам не нужны. Но в учебных целях, ду-
маю, этот рисунок оправдан.

Если вы умеете пользоваться Clone Stamp Tool, Healing Brush и Patch Tool, это значит,
что вы в состоянии выполнить практически любую ретушь мобилографий. Я не
буду рассматривать здесь сложные методы ретуши с использованием слоев, так
как в применении к мобилографиям они зачастую бесполезны. Сказывается все то
же низкое техническое качество исходного материала.

С использованием Patch Tool и Clone Stamp Tool ретушь проводов ведется элементар-
но. Через некоторое время их как не бывало.

Теперь займемся автомашиной. Последовательность действий здесь точно такая
же. Но на примере машины мы рассмотрим еще один прием ретуши.
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Рис. 6.З. Понимание принципов работы Patch Tool
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Рис. 6.4. Ретушь выделенной области
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Так как она довольно большая, есть смысл перед ретушью, а именно перед первым
проходом ретуши — использованием Clone Stamp Tool, — выделить область, занимае-
мую автомашиной. Сделать это можно при помощи Lasso Tool. Выделив область ав-
томашины, аккуратно обрабатываем ее Clone Stamp Tool, воссоздавая фон (рис. 6.4).

Выделение здесь нужно для того, чтобы ограничить ретушируемую область и не
подвергать ненужной коррекции пространство вокруг автомашины.

После этого можно сделать тонкую доводку при помощи Patch Tool. И на финаль-
ной стадии коррекции изображения автомашины можно немножко пройтись по
месту ретуши инструментом Blur Tool. Результат вы можете видеть на рис. 6.5.

Рис. 6.5. Результат ретуши

Теперь, после того как недостатки изображения исправлены, попробуем поднять
его резкость. Изначально это было не самое резкое изображение. Последствия уда-
ления JPEG-сжатия не прошли даром. А раз так, значит попробуем повысить рез-
кость этого изображения.

Для повышения резкости существует масса техник. Здесь же мы рассмотрим две.

6.2. Управление резкостью: High Pass
Для изображения с рис. 6.5, на мой взгляд, лучше всего подходит способ повыше-
ния резкости с использованием дополнительного слоя, обработанного фильтром
High Pass.



136 •:• Глава 6. Ретушь, резкость, спецэффекты

Чтобы реализовать этот способ, надо скопировать слой с изображением в палитре
Layers (это можно сделать, перетащив слой изображения на кнопку с листком бумаги).
После того как копия будет сделана, надо перейти в режим редактирования ново-
го слоя и применить к нему средство Desaturate (Image > Adjustments > Desaturate),
которое обесцветит изображение этого слоя. Теперь, оставаясь в режиме редакти-
рования этого обесцвеченного слоя, применим к нему фильтр Fiter > Other > H i g h
Pass. Посмотрите на рис. 6.6.

К Adobe Photoshop - l09-«-as_I60811.pKi»ll»«>{Backsraundcopy, Я68Ш
Rie £dt Image Lay» Select Nter ttew Window Heb

Рис. 6.6. Настройка фильтра High Pass

Здесь изображена настройка фильтра High Pass. Наша задача — подобрать такое
значение параметра Radius, при котором на изображении будут проявляться гра-
ницы объектов, но без лишних деталей и особенно шума.

После того как High Pass сделал свое дело, остается лишь изменить режим наложе-
ния слоя с Normal на Overlay. После переключения режима наложения окажется, что
резкость изображения возросла. Для дальнейшего повышения резкости можно
попытаться скопировать High Pass-слой. Правда, большое количество копий этого
слоя начинают выявлять слишком много посторонних шумов, поэтому мы огра-
ничимся одним корректирующим слоем.

Посмотрите на рис. 6.7. Здесь вы можете видеть результат коррекции резкости
данного изображения.
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Рис. 6.7. Результат коррекции резкости

Кстати, применение вышеописанной техники смягчает тона изображения, делая
света темнее, а тени светлее. Думаю, это очевидно, особенно если сравнить рис. 6.6
с рис. 6.7. После всех этих преобразований наш пейзаж выглядит уже неплохо (для
мобилографии, естественно). Но мне все же хочется еще что-нибудь с ним сделать
для того, чтобы улучшить эту мобилографию.

Долго выбирая и рассматривая, я остановился на художественном фильтре Film
Grain — Filter > Artistic > Film Grain. Причем применил я его к слою, который уже был
обработан фильтром High Pass. Это дало очень интересный эффект, который вы мо-
жете наблюдать на рис. 12 цветной вклейки. По-моему, такую картинку уже мож-
но распечатать на А4 и, заключив в походящую рамку, повесить на стенку.

Мы немного отвлеклись от темы коррекции резкости. А сейчас мы к ней все же
вернемся.

6.3. Управление резкостью: USM
Весьма популярным и мощным средством для повышения резкости изображений
является фильтр Unsharp Mask — Filter > Sharpen > Unsharp Mask. Этот фильтр, кото-
рый иногда называют USM, позволяет очень тонко управлять резкостью.
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Посмотрите на рис. 6.8. Здесь вы можете видеть окно USM. Его применение, как
уже было сказано, оправдано на фотографиях, изображающих достаточно крупные
объекты.

Рис. 6.8. Окно USM

В этом окне есть три параметра. Amount, или интенсивность, отвечает за интенсив-
ность применения фильтра. Чем он больше, тем сильнее будет увеличена резкость
изображения. Но на достаточно больших его значениях, в особенности при боль-
шом значении Radius и маленьком Threshold, изображение выглядит сильно повреж-
денным за счет ненормальной искусственно увеличенной резкости.

В принципе, возможна установка любого доступного значения Amount, но, как пра-
вило, на практике используются достаточно маленькие его значения, в пределах
200 %. При значении меньше 40-50 % действие фильтра выглядит недостаточным.

Параметр Radius отвечает за область увеличения резкости, определяя количество
пикселов вокруг контура, резкость которых надо повысить, или так называемого
ореола. Он очень сильно влияет на результат коррекции. Конечно, с ним можно
экспериментировать, но в большинстве случаев 4-5 пикселов являются едва ли не
максимальными его значениями, а для мобилографий и того меньше.

И наконец, параметр Threshold отвечает за то, насколько сильно пикселы контура
будут отличаться от пикселов фона. Чем он меньше, тем сильнее результаты уве-
личения резкости при помощи USM. Очевидно, максимальный эффект при про-
чих равных условиях будет достигнут при Threshold, равном нулю, но здесь же воз-
можно появление шумов.
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Сейчас мы попытаемся поднять резкость мобютографии с рис. 6.9.

IB Adobe Photoshop -£М»9в4_14т1,и»з fr I1!K'»(RGB/8)1
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Рис. 6.9. Мобилография для коррекции

Я не буду приводить здесь никаких готовых параметров USM, так как каждое изоб-
ражение индивидуально, и самым правильным путем его коррекции будет ручной
подбор параметров USM.

Перед подбором для оценки влияния увеличения резкости рекомендуется устано-
вить 100%-ный масштаб для изображения. После этого можно подбирать значе-
ния параметров. Причем лучше всего начинать с параметра Amount, установив его
для начала на максимум, потом поставить максимальный по действенности
Threshold, равный 0, и Radius величиной в 1 пиксел.

Теперь надо постепенно поднимать значение Threshold — это позволит избавиться
от шумов, и увеличивать Radius, тем самым увеличивая резкость. Когда вы увиди-
те, что результат похож на то, что вам нужно — можете начать уменьшать параметр
A m o u n t до достижения нужного результата или не уменьшать его, если все выгля-
дит хорошо, хотя 500 %, как правило, это много.

Посмотрите на рис. 6.10. Здесь вы можете видеть результат коррекции рис. 6.9.
К изображению был применен USM с параметрами A m o u n t — 87%, Radius — 0,4
и Threshold — 0.
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Рис. 6.10. Результат коррекции резкости

В данном случае был использован очень маленький Radius — всему виной доста-
точно маленькие размеры объектов, резкость которых надо повысить. Если кор-
ректировать при помощи USM, например, резкость портрета, то Radius практиче-
ски гарантированно будет где-то в районе 1,5-2 пиксела.

6.4. Карандашный рисунок
Откорректировав рис. 6.9, я решил превратить его в рисунок карандашом. Сделать
это можно при помощи следующей методики. Во-первых, надо обесцветить изоб-
ражение. Можно это сделать при помощи Image > Adjustment > Desaturate, но лучше
использовать средство Channel Mixer. Дело в том, что используя Channel Mixer, мож-
но управлять процессом перевода цветного изображение в изображение в оттен-
ках серого.

На рис. 6.11 изображено окно Channel Mixer. Для перевода изображения в оттенки
серого установите галочку Monochrome и настраивайте уровни каналов каждого
цвета, которые будут влиять на результат. Для сохранения яркости оригинала сум-
ма значений должна равняться 100%, но вполне допустимы другие ее значения.
Для конверсии моего изображения в оттенки серого я дал 24 % красному каналу,
62 — зеленому и 20 % — синему. На мой взгляд, так оно выглядит лучше всего.
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Рис. 6.11. Окно Channel Mixer

После перевода изображения в оттенки серого надо сделать копию слоя с изобра-
жением и инвертировать эту копию командой Image > Adjustment > Invert. Далее
переключаем режим наложения инвертированного слоя с N o r m a l на Color Dodge.
Теперь, не обращая внимания на исчезновение изображения, запускаем фильтр
Gausian Blur для инвертированного слоя и начинаем увеличивать параметр Radius.

С увеличением радиуса размытия на изображении начинают проявляться штрихи
будущего рисунка. Увеличивайте Radius до тех пор, пока картинка не примет жела-
емый вид. Я остановился на параметре Radius, равном 7,2 пиксела. Теперь можно
объединить слои командой Layer > Flatten Image. Карандашный рисунок получился.

Далее я его немного раскрасил при помощи Image > Adjustment > Hue/Saturation
(Hue — 256, Saturation — 34, Lightness 7, галочка Colorize установлена). По-мое-
му, получилось красиво. Результат смотрите на рис. 13 цветной вклейки. Дальше
мы рассмотрим простой но эффективный метод создания рамок для ваших моби-
лографий.

6.5. Создание рамок
Создавать рамку можно на самой мобилографии, тогда она перекроет часть изоб-
ражения, и путем увеличения холста. Первый метод мы уже рассматривали, когда
изучали основные средства Photoshop, а второй рассмотрим сейчас.

Для увеличения холста надо выполнить команду Image > Canvas Size. В появившем-
ся окне Canvas Size есть много параметров (рис. 6.12).

Нас будут интересовать параметры группы New Size. Установив галочку Relative,
мы получим возможность менять размеры холста в относительных единицах. На-
пример, введя в поле Width значение прироста ширины холста, равное 1 см, а в поле
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Height — прироста высоты также в 1 см, в результате мы получим рамку шириной
0,5 см, которая охватывает все изображение.

Current Size: 900,OK : ~:
Width: 22,58 cm

Height: 16,93 on

Mew Size: 9QO,OK

Width: 0 ern

Height: | 0 j cm

F? Relative
Anchor:

_£]

Canvas extension color | Background

Рис. 6.12. Окно Canvas Size
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Рис. 6.13. Создание рамки
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Интересен параметр Canvas Extension Color — если оставить его по умолчанию, то
наша рамка будет заполнена цветом фона. После всех этих манипуляций и нажа-
тия О К вокруг нашей мобилографии появится рамочка; рис. 6.13.

Теперь ее можно выделить инструментом Rectangular Marquee Tool, инвертиро-
вать выделение командой Select > Inverse (рис. 6.14) и делать с рамкой все, что
душе угодно — заливать различными заливками, раскрашивать, применять к ней
фильтры.

Если, выделяя рамку, вы ошиблись и не выделили ее с первого раза, можно щелк-
нуть по ней правой кнопкой мыши, выбрать пункт всплывающего меню Transform
Selection и отредактировать рамку. После выделения я залил рамку, используя
в качестве образца цветную бумагу Blue Specs.

т ftdobe Photoshop - t26-MW»4_lS14.f>s<i в J07* {HGB/8#)|
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Рис. 6.14. Заливка рамки

Для выбора такого варианта заливки надо включить инструмент Paint Bucket Tool,
на панели его свойств изменить параметр Fill на Pattern, а в поле Pattern найти нуж-
ный шаблон заполнения. Потом, снова инвертировав выделение, чтобы выделить
изображение, применил к нему художественный фильтр Watercolor.

Результаты всего этого вы сможете увидеть на рис. 14 цветной вклейки. Но преж-
де чем вы посмотрите на эту картинку, позвольте рассказать вам о простом, но эф-
фективном методе создания надписей.
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6.6. Создание эффектных надписей
Для начала напишем что-нибудь на изображении при помощи Horizontal Type Mask
Tool, применим к тексту какой-нибудь спецэффект — например, изогнем его в виде
флага; рис. 6.15. После добавления текста надо нажать на галочку в правой части
панели свойств Type Mask Tool.

fj Adobe Photoshop - ГгЬ-10-<М_151"«4К«» * It»?1*» (RGB/8«!

e Edit Image Layer Select «ter Veft Window :Hel

Рис. 6.15. Добавление и форматирование текста

После того как текст в виде выделения добавлен, выполняем следующую команду
Layer > New > Layer Via Copy. Теперь в палитре Layers активируем новый слой, выби-
раем для него свойства слоя и начинаем экспериментировать. В данном примере я
включил для этого слоя параметры Drop Shadow, Outer Glow, Inner Glow, Bevel And
Emboss и Contour. Текст получился интересным — светящиеся грани, эффект про-
зрачности, тени.

Посмотрите на рис. 6.16 — здесь вы можете видеть процесс настройки текста.
Я очень советую вам поэкспериментировать с установками свойств слоя, так как с
их помощью с текстом можно сделать практически все, что может прийти в го-
лову.

Если вам нужна тень — обратите внимание на разделы Drop Shadow и Inner Shadow.
Особенно интересна Drop Shadow, так как буквы начинают отбрасывать довольно
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реалистичную тень, которой можно управлять. Хотите, чтобы контуры букв све-
тились, — поинтересуйтесь разделами Inner Glow и Outer Glow.

......

R ]?s |?e •
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Рис. 6.16. Создание текста

Если нужна надпись, сделанная как-бы небрежно, — тогда вам в раздел Satin.

Хотите залить буквы цветом или текстурой? Тогда обратитесь в разделы Color
Overlay и Gradient Overlay. Особенно мне нравится Gradient Overlay — красота просто.
Если вас больше тянет на заполнения шаблонами, тогда посмотрите на Pattern
Overlay — там этого добра навалом.

И наконец, раздел Stroke позволит обвести буквы разными цветами или градиен-
тами. Нечто вроде стеклянного текста вам поможет сделать раздел Bevel and Emboss.

Посмотрите на рис. 14 цветной вклейки. Здесь вы можете видеть результат обра-
ботки мобилографии в цвете.

А сейчас попытаемся создать огненный текст. Мне очень нравится этот эффект.
В процессе создания огненных букв вы глубже поймете мощь фильтров Photoshop,
применение которых не всегда так очевидно, как кажется на первый взгляд.

Для начала создадим новый документ, например, размером 640x480, — для того
чтобы максимально приблизить формат нашей работы к разрешению типичных
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мобилографий. Зальем фон черным цветом и на черном фоне напишем нужное
нам слово. В данном случае это будут буквы WMS.

Для написания выберем шрифт Tahoma размером 120 pt. После того как буквы на-
писаны, объединим слои изображения командой Layer > Flatten Image. Посмотрите
на рис. 6.17 — все готово к началу преобразований текста.

К Adobe Ик>ЬяЬо1> - [O»«ted-l * ««*» (ВаАдгомЦ, RGe/8}J
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Рис. 6.17. Подготовка текста

Теперь повернем холст на 90 градусов по часовой стрелке командой Image > Rotate
Canvas ¥ 90°CW. Далее запускаем фильтр Filter > Stylize > Wind с параметрами Method,
равным Wind, и Direction — From the left. Этот фильтр создает эффект ветра, как бы
«сдувая» части изображения (рис. 6.18).

Первое применение фильтра может оказать слабое влияние на изображение, по-
этому его можно применить столько раз, сколько нужно. При помощи этого филь-
тра мы определяем, какой высоты будет пламя горящих букв. Причем, чем больше
размер букв, тем больше проходов фильтра вам может понадобиться. Учтите, од-
нако, что даже один проход Wind дает в результате довольно высокое пламя. Так,
в нашем примере я ограничился именно одним проходом этого фильтра.

После обработки фильтром W i n d изображение может показаться вам некачествен-
ным. Но пока не обращайте на это внимания, так как нам предстоит произвести
еще довольно много преобразований нашего изображения.
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Рис. 6.18. Применение фильтра Wind

Теперь повернем изображение обратно, в более привычное положение, командой
Image > Rotate Canvas > 90°CCW и применим к нему фильтр Filter > Distort > Ripple со
значениями Amount — 55% и Size — Large. Это нужно для того, чтобы пламя слегка
колебалось, чтобы его языки не поднимались строго вертикально от букв, а горели
более реалистично. К тому же этот фильтр сделает буквы как бы созданными из
огня — они будут расплываться под воздействием «высокой температуры».

Дальше применяем фильтр Filter > Stylize > Diffuse с параметром Mode, равным
Lighten Only, — это нужно для того, чтобы пламя охватывало буквы не только сна-
ружи, но и изнутри, а параметр Lighten Only позволяет меньше затронуть языки
пламени. Здесь вполне допустимо применение параметра Darken Only, который в
данном случае будет делать языки пламени немного короче. Можете поэкспери-
ментировать с этими параметрами.

После всех этих манипуляций остается лишь применить Filter > Blur > Gaussian Blur,
с параметром Radius 0,7. Это позволит сгладить языки пламени и убрать все недо-
статки, которые появились на изображении в результате предыдущих манипуля-
ций. Цель данной операции — увеличить визуальное качество изображения и сде-
лать языки пламени сплошными, не имеющими пустых мест. Но после всех этих
манипуляций мы по-прежнему видим черно-белое изображение (рис. 6.19), кото-
рое, очевидно, еще нужно раскрасить, для того чтобы придать ему огненный вид.
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Рис. 6.19. Текст, подготовленный к раскрашиванию

Здесь мы поступим немного нетрадиционно, воспользовавшись режимом Indexed
Color. Для этого надо выполнить следующее: выбрать пункт меню Image > Mode > In-
dexed Color, в появившемся окне оставить все без изменения и нажать ОК. При по-
мощи этой манипуляции мы переведем изображение из цветовой модели RGB в
цветовую модель, поддерживающую ограниченное количество цветов, в данном
случае — это 256 цветов. После перевода изображения в режим Indexed Color оста-
ется лишь выбрать пункт меню Image > Mode > Color Table и установить параметр
Mode в позицию Black Body.

Цвета изображения, которых в данном случае 256, будут заменены на красно-жел-
то-черные, которые идеально подходят для окраски огня. Кстати, вы имеете воз-
можность самостоятельно создавать наборы цветов в Indexed Color, что, кроме всего
прочего, значит еще и то, что огонь можно сделать и зеленым, с соответствующи-
ми оттенками, и синим и так далее. После окрашивания переводим изображение
снова в RGB командой Image > Mode > RGB color. Затем применяем к нему легкий
Gaussian Blur с параметром Radius, равным 0,7 пиксела, для того чтобы сгладить все
неровности и сделать наш огненный текст более качественным. Вот что у нас по-
лучилось (рис. 6.20).

Создание огненного текста на черном фоне — это полдела. Такой текст, как бы
эффектно он ни смотрелся, все же остается лишь заготовкой для чего-то больше-
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го. Например, интересно было бы внедрить этот текст в существующее изображе-
ние так, чтобы не осталось никакого черного фона, а был виден лишь огонь.
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Рис. 6.20. Огненный текст

Задача это довольно простая, особенно если знать, что и в какой последовательно-
сти делать. Но прежде чем заниматься внедрением нашего текста в другое изобра-
жение, создадим это изображение. Ниже мы рассмотрим один эффективный при-
ем создания коллажей из мобилографий, а на финальной стадии рассмотрения
вернемся к нашему тексту.

6.7. Создание коллажей
Методика создания коллажей основана на управлении прозрачностью слоев. Она
позволит вам создавать коллажи из нескольких изображений, для совмещения
которых очень полезно научиться управлять прозрачностью слоев. Такие вещи,
например, довольно часто можно увидеть на рекламных плакатах. Управляя про-
зрачностью слоев, мы заставляем одно изображение «просвечивать» сквозь другое,
в результате соединяя их воедино. Как правило, коллажи предназначены для вы-
ражения какой-то мысли, идеи, показа динамики и сущности различных явлений
в видении этих явлений создателем коллажа. Например, попытаемся создать кол-
лаж на тему «Мобилография».
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Для этого возьмем несколько изображений, относящихся к этой тематике, и попыта-
емся их совместить. А именно возьмем пару мобилографий с разрешением 640x480,
какую-нибудь подходящую фотографию того же размера и изображение камерофона.

Мобилографий будут символизировать мобилографию как искусство, фототеле-
фон — ее основной инструмент, а фон из обычной фотографии будет показывать
преемственность мобилографий и то, что ее родоначальником является обычная
фотография.

Открыв нужные изображения в Photoshop, скопируем их все на то изображение,
которое будет являться фоном нашего коллажа. Это будет фотография неба. Кста-
ти, эта фотография изначально была 3-мегапиксельная. Для того чтобы уменьшить
ее до 640x480, была применена техника интерполяции изображения уже нами об-
суждавшаяся.

Командой Image > Image Size было вызвано окно для изменения размеров изобра-
жения, где в качестве нового размера изображения было введено 640x480. Анало-
гично были изменены размеры изображения камерофона. Камерофон был изобра-
жен на белом фоне, а нам хотелось бы использовать его без этого. Что делать?

Можно выделить его, инвертировть выделение, а потом при помощи Eraser Tool сте-
реть все лишнее. Так можно поступить, но есть способ лучше. Называется он
Filter > Extract. Это замечательный фильтр, который позволяет извлекать изображе-
ния различных предметов с фотографий.

Посмотрите на рис. 6.21. Здесь вы можете видеть окно средства Extract с открытым
в нем изображением для извлечения.

Главным рабочим инструментом Extract является маркер (Edge Highlighter Tool, пер-
вая кнопка сверху в окне Extract). С его помощью нужно указать программе об-
ласть, в которой нужно искать края. По умолчанию маркер «рисует» зеленым по-
лупрозрачным цветом. Для выделения областей, где следует искать края, надо
просто провести маркером по соответствующим местам изображения.

В большинстве случаев очень удобен режим, который включается при помощи га-
лочки Smart Highlights. В этом режиме вы можете установить достаточно толстую
кисть и, ни о чем не задумываясь, водить ей по краям изображения. Выделение бу-
дет создаваться автоматически.

Это очень удобно, но изображение с рис. 6.21 я выделил в обычном режиме рабо-
ты Highlighter Tool. В данном случае изображение имеет достаточно четкие края,
поэтому провести по ним при помощи достаточно толстой кисти не составило тру-
да. А вот если нужное изображение имеет сложную структуру, тогда применение
Smart Highl ight способно весьма облегчить создание правильного контура.

После того как создан замкнутый контур, который символизирует наличие краев,
его можно отредактировать. Если вы вдруг отметили маркером не то место, его все-
гда можно стереть ластиком (Eraser Tool). Для этого надо нажать соответствующую
кнопку в левой части окна Extract.
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Рис. 6.21. Окно Extract

Для удобства выделения краев вы можете увеличивать изображение (Zoom Tool)
и перемещать (Hand Tool) его в окне редактирования при помощи соответствующих
кнопок.

Итак, создав замкнутый контур, выбираем инструмент Fill (вторая кнопка сверху)
и заливаем им область для извлечения. В данном случае достаточно щелкнуть им
внутри выделения. Теперь остается лишь нажать кнопку О К, и через пару секунд
вы увидите извлеченный фрагмент изображения. Посмотрите на рис. 6.22. Здесь
извлечение произошло достаточно качественно, лишь немного нижняя часть изоб-
ражения была отредактирована при помощи инструмента Eraser Tool, другой кор-
рекции не требуется.

Обратите внимание на то, как была проведена коррекция. При помощи инструмен-
та выделения Rectangular Marquee Tool была выделена область, подлежащая коррек-
ции, и достаточно мягкой кистью Eraser Tool было сделано несколько корректиру-
ющих движений. В результате мы добились ровной кромки стирания. Если не
пользоваться при подобных операциях выделением, то сделать все так же аккурат-
но вряд ли получится.

Раз уж мы принялись рассматривать инструмент Extract, нельзя не рассказать
о том, каким образом могут быть восстановлены нужные участки изображения, ко-
торые были удалены при извлечении. Посмотрите на рис. 6.23. При извлечении
этого изображения часть исходного снимка была утеряна.
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Рис.6.22. Коррекция изображения
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Рис. 6.23. Восстановление утраченных фрагментов изображения
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Для коррекции таких изображений очень удобно использовать кисть истории -
History Brush Tool. Это очень мощный инструмент, который мы практически не ис-
пользовали в этой книге. Дело в том, что его применение серьезно ограничено тех-
ническим качеством мобилографий, а кисть истории — инструмент весьма тонкий.
Она позволяет проводить очень деликатную коррекцию фотографий, полезна при
сложных приемах обработки фотоматериала, которые зачастую просто неприме-
нимы к мобилографйям.

Итак, после извлечения фрагмента надо переключиться на кисть истории и акку-
ратно «закрасить» ею те участки изображения, которые были утрачены при извле-
чении. Особенность кисти истории заключается в том, что она «рисует» фрагмен-
тами изображения, которые были на нем до проведения какой-либо операции. То
есть берет информацию из старого изображения и возвращает ее на новое.

Я советую вам поэкспериментировать немного с этой кистью для того, чтобы луч-
ше понять принципы ее действия. Другого применения этой кисти в случае с мо-
билографиями я, честно говоря, просто не вижу. Посмотрите на рис. 6.24. Здесь вы
можете видеть слегка откорректированное изображение после извлечения.

К МоЫ-НюПкЬор - («НИ «И 1511.jpg » Ш<*> (layer О, Rbd/B»)!
. 5* £**• SeSect Filter \?te« &in Heip

Рис. 6.24. Отредактированное изображение

Для копирования изображений был использован прием перетаскивания мини-
атюр слоев на целевое изображение. Посмотрите на рис. 6.25. Здесь вы можете ви-
деть состояние изображения перед началом работы. Но вернемся к нашему колла-
жу. Следующим этапом нашей работы будет создание градиентных масок слоя,
при помощи которых мы будем управлять прозрачностью слоев. Градиенты нужны
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для того, чтобы задавать прозрачные, непрозрачные и частично прозрачные участ-
ки слоя. Для добавления к слою маски слоя служит кнопка Add Vector Mask (вторая
слева в нижней части палитры слоев). Когда маска слоя добавлена, ее нужно опре-
деленным образом обработать инструментом Gradient Tool.

т Adobe Photoshop - It»oe36s.)>s<i е> ид% (layer з, R6BW)

• ' : • • " • .

Рис. 6.25. Состояние изображения перед началом работы

Итак, когда теория создания коллажа немного освещена, переходим к практике.
Скопировав все нужные изображения на фоновое, скроем ненужные на данном
этапе работы слои и оставим лишь два — фоновый слой и слой, содержащий сле-
дующее изображение. В нашем случае это будет изображение телефона. Далее,
добавляем к изображению фототелефона маску слоя щелчком по соответству-
ющей кнопке палитры Layers.

Затем переключаемся в режим редактирования маски слоя щелчком по ее мини-
атюре и, выбрав инструмент Gradient Tool, проводим линию в направлении той об-
ласти нашего слоя, которая должна стать прозрачной. Посмотрите на рис. 6.26.
Здесь вы можете видеть процесс редактирования изображения телефона, накла-
дываемого на изображение неба.

Так же для редактирования маски слоя можно использовать различные кисти, пре-
имущественно с мягкими краями. Мягкие края нужны для того, чтобы не было
резких переходов между прозрачными и непрозрачными участками слоя. Собствен-
но, это все, что надо знать для создания коллажей с использованием Photoshop —
теперь все зависит лишь от вашей фантазии. Готовый коллаж вы можете видеть на
рис. 6.27.
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Рис. 6.26. Редактирование маски слоя

т Mabe Diotoshop -1 tKOOSS^m) ® IMS* (Uvcr з, layer Ha«k/e)}
*̂ido«

Рис. 6.27. Коллаж
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Посмотрите на рис. 6.28. Здесь дана отдельно палитра Layers для того, чтобы вы
могли оценить редактирование масок слоев, которое привело к получению резуль-
тирующего коллажа.

Рис. 6.28. Палитра Layers с отредактированными масками слоев

Еще раз обращаю ваше внимание на то, что чем светлее градиент на маске слоя -
тем непрозрачнее изображение в этом месте. Заметьте, что в левом верхнем углу
третьего слоя видны следы дополнительного редактирования. Это результат обра-
ботки мягкой кистью инструмента Burn Tool с целью увеличения прозрачности
слоя в месте обработки.

Дело в том, что верхняя часть третьего слоя оказалась слишком темной, и для мяг-
кого исправления этого недостатка была применена вышеописанная техника. Как
вы понимаете, на самом деле мы увеличили прозрачность темного угла третьего
слоя и через него стал сильнее «проглядывать» фоновый слой.

Теперь, когда коллаж создан, переходим к внедрению в него нашей огненной над-
писи.

6.8. Внедрение надписи в коллаж

Итак, у нас есть изображение, содержащее огненный текст, который мы хотим вне-
дрить в наш коллаж. Для начала предлагаю немного поразмыслить над этим, ско-
пировав слой с буквами в наше изображение.
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Перед копированием проведем кадрирование, для того чтобы таким нехитрым
способом избавиться от излишков черного фона. Собственно говоря, именно этот
черный фон и является нашей главной проблемой. Нам нужно устранить его, ос-
тавив на изображении лишь огненные буквы.

Посмотрите на рис. 6.29. Здесь вы можете видеть изображение перед началом экс-
периментов по удалению ненужного черного фона.

R Adobe Photoshop - f OSOrafeS-pud ® П У» (layer 4, RGB/8) I

'3 Bte № Juage Laysr Jeiec!

Рис. 6.29. Изображение перед коррекцией

Можно попытаться выделить буквы каким-нибудь инструментом выделения, из-
влечь все то, что не является черным, потом попытаться устранить артефакты вы-
резания. Но тогда внедрение надписи в наш коллаж превратится в весьма сложное
и скучное занятие, результат которого будет непредсказуем.

Если попробовать настроить прозрачность слоя в палитре Layers, то окажется, что
черный фон, хотя и ослабленный, все равно хорошо заметен, а букв практически
совсем не видно. Однако нашу проблему довольно легко решить при помощи
стандартных свойств слоя. Собственно говоря, этот пример призван продемонст-
рировать полезность творческого использования свойств слоя.

Для того чтобы модифицировать соответствующие параметры, нажимаем кнопку
свойств слоя на панели Layers и выбираем параметр Blending Options. В появившемся
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окне (рис. 6.30) не трогаем ничего, кроме бегунка This Layer из группы параметров
BLend If.

В данном случае нам надо сделать прозрачным черный цвет фона, поэтому пере-
таскиваем окно Blend Option так, чтобы был виден наш текст, и начинаем потихонь-
ку перемещать черный треугольник вправо. Перемещаем его до тех пор, пока не-
желательный черный цвет фона не исчезнет вовсе.

т Adobe Photoshop - [DSOl»6S.p«J ig> 1 IS î. (1луи 4, ftGS/в)!
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Рис. 6.30. Настройка прозрачности слоя

Как видите, здесь я перетащил черный треугольник очень сильно влево. В резуль-
тате с изображения был устранен не только темный фон, но и темные оттенки огня.
Остались лишь контуры горящих букв.

Теперь можно слегка настроить общую прозрачность слоя с огненной надписью
для того, чтобы она не слишком контрастировала с общей «полупрозрачностью»
коллажа. Далее, к слою с буквами я применил Gaussian Blur с параметром Radius,
равным 0,3 пиксела, чтобы слегка сгладить неровности, и изменил их размер.

Для изменения размера я, выделив буквы инструментом Rectangular Marquee Tool,
после щелчка правой кнопкой по выделению выбрал режим Free Transform и из-
менил размер букв до нужного мне. После всех этих действий осталось лишь
объединить слои командой Layer > Flatten Image и немного отрегулировать яркость
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и контрастность этого изображения. Результат всего того, что мы делали, вы мо-
жете видеть на рис. 15 цветной вклейки.

С помощью вышеперечисленных методик создания надписей можно достаточно
легко создать ледяной текст. Окрасить в нужный цвет его можно при помощи Hue/
Saturation, сделать «сосульки» при помощи фильтра W i n d (только направленного в
другую сторону, если сравнивать с созданием огня) и добавить блестящие фраг-
менты, воспользовавшись специально подобранной кистью.

Способы работы с текстами в Photoshop, рассмотренные нами, позволят вам экс-
периментировать с различными надписями в очень широких пределах. Кстати,
продолжая разговор о надписях, обратите внимание на то, что я здесь не касался
других фильтров. Буквы, например, пользуясь первой методикой (создание ново-
го слоя путем копирования выделений в виде букв) и не настраивая свойства слоя,
можно обработать фильтрами художественных эффектов, залить какой-нибудь
краской, а потом слегка размыть или воспользоваться фильтром Emboss для при-
дания буквам объема и так далее. Учтите, можно и не создавать новый слой из
выделенной области, а применять фильтры прямо на выделенных буквами участ-
ках изображения.

6.9. Выводы
На этом позвольте закончить разговор о правке мобилографий. Думаю, теперь вы
сможете сделать с ними практически все, что можно и уместно делать с мобило-
графиями. А нам осталось лишь разобраться с особенностями демонстрации ва-
ших мобилографий, о чем читайте в следующей главе.
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Когда последние штрихи ретуши сделаны, кадрирование завершено, мобилогра-
фии сохранены и для надежности записаны на CD, пришло время заняться их де-
монстрацией. Ведь, согласитесь, приятно, если кто-нибудь разделит с вами то, что
вы увидели, когда делали фото вашим телефоном. Для демонстрации фотографий
существует довольно много способов.

Можно воспользоваться средствами Photoshop — и только ими. Этот способ под-
ходит тогда, когда вам надо срочно устроить презентацию ваших фото, а других
средств под рукой не оказалось. Другим, более длительным, но, в конечном счете,
оправдывающим себя способом является создание разного рода презентаций.

Особенно интересны PDF-презентации — учитывая повсеместную распространен-
ность Adobe Acrobat Reader'a и некоторые продвинутые возможности этих презен-
таций. Одним из способов демонстрации мобилографий всем желающим в любой
точке земного шара являются разного рода web-галереи, мы рассмотрим некото-
рые из них.

7.1. Демонстрация фотографий
средствами Photoshop
Если вы дочитали до этого места, то Photoshop CS почти наверняка установлен
у вас на компьютере. А раз так, значит вполне логично использовать его средства
для демонстрации мобилографий окружающим.

Photoshop CS вполне можно сделать пригодным для эффективного просмотра
фотографий. Общая идея такой «переделки» заключается в том, чтобы, во-первых,
убрать из рабочего окна Photoshop все лишнее, а во-вторых, обеспечить навигацию
между фотографиями. Ведь если, скажем, каждый раз для показа новой фотогра-
фии вам придется открывать File Browser, искать нужный файл и так далее, это бу-
дет уже не демонстрация фотографий, а демонстрация быстродействия вашего
жесткого диска и мыши.

Photoshop имеет особый режим работы, называемый Full Screen Mode — полноэк-
ранный режим. При работе в этом режиме на экране остается только редактиру-
емое изображение. Для перевода рабочего окна в такое состояние существует
кнопка на панели инструментов, называемая Full Screen Mode. Для удобства можно
перейти в этот режим, несколько раз нажав клавишу F на клавиатуре.

После того как вы перевели окно Photoshop в этот режим, все что осталось сде-
лать — это убрать с экрана палитры инструментов, чтобы они не мешали просмот-
ру. Сделать это можно, просто закрыв их, но это слишком долго. Лучше всего для
скрытия палитр воспользоваться нажатием клавиши Tab, которая позволяет скры-
вать и отображать все палитры. В результате вы получите чистое изображение во
весь экран за пару нажатий клавиш.

Посмотрите на рис. 7.1 (Дмитрий Резван, «Мобилография»). Здесь вы можете ви-
деть просмотр изображения именно в таком режиме. Этот режим иногда удобно



162 •:• Глава 7. Демонстрация мобилографий

использовать для редактирования изображений, чтобы, выбрав какой-нибудь ин-
струмент, спокойно, не отвлекаясь ни на что, работать с программой.

Рис. 7.1. Демонстрация фотографий в полноэкранном режиме

Когда с просмотром одного изображения мы разобрались, обсудим просмотр не-
скольких. Открыв их все, переведем все фотографии в полноэкранный режим на-
жатием комбинации клавиш Shift+F или щелчком по кнопке Full Screen Mode на па-
нели инструментов при нажатой клавише Shift.

Теперь все, что остается сделать — это перемещаться по изображениям при помо-
щи команды Ctrl+Tab.

При просмотре очень удобно пользоваться инструментом Zoom для увеличения
частей изображений. Особенно удобной возможностью Zoom Tool является то, что
выделив им определенный участок изображения, можно увеличить этот участок
до размеров всего экрана.

Посмотрите на рис. 7.2 (Дмитрий Резван, «Мобилография») — здесь вы можете
видеть один из этапов просмотра. Выделенный при помощи Zoom Tool участок
изображения после того, как кнопка мыши будет отпущена, окажется размером во
весь экран. Очень удобно.
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Для того чтобы выбрать инструмент Zoom Tool в полноэкранном режиме, не вызы-
вая на экран палитры, можно воспользоваться клавишей Z, а для того чтобы Zoom
не увеличивал, а уменьшал изображение, можно щелкать по изображению при на-
жатой клавише Alt.

fite Ed* Iroage layer Seiect FSter v,«w Window Heip

Рис. 7.2. Использование инструмента Zoom при просмотре фото

Используя вышеописанную методику просмотра изображений, вы получите дос-
таточно простое и удобное средство для демонстрации ваших мобилографий.

Главный недостаток этого метода просмотра заключается в том, что новые фото-
графии меняются достаточно резко, что вызывает ощущение некоторого диском-
форта. Все же Photoshop CS — это в первую очередь графический редактор, а не
средство демонстрации большого количества фотографий.

К тому же, если Photoshop не установлен на ПК, скажем, если вы пришли в гости
и принесли CD с фотографиями, этим методом вы уже не воспользуетесь. Но
Photoshop позволяет создавать PDF-презентации и обычные PDF-документы, со-
держащие ваши фото, определенным образом упорядоченные. Они позволяют
просматривать фотографии везде, где есть Adobe Acrobat Reader.

Кстати, бесплатно распространяемый дистрибутив Acrobat Reader, который мож-
но найти едва ли не на каждом диске с программным обеспечением, вы можете
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записать на CD вместе со сгенерированной презентацией. Сделав это, вы сможете
показать ваши фото на любом компьютере. Подробности о PDF читайте дальше.

7.2. Создание PDF-презентаций

PDF-презентации — это очень удобно. Они создаются при помощи стандартного
средства Photoshop для построения презентаций. Запускается оно посредством
выбора пункта меню File > Automate > PDF Presentation.

Посмотрите на рис. 7.3. Здесь вы можете видеть окно PDF Presentation. Рассмотрим
подробнее его параметры, так как они непосредственно влияют на нашу будущую
презентацию.

РЮ= Presentation

•••• Source Hies
Г ftttd open

Save

Cancel

Irowse..

r~ Output Options — •
j Ssve as: С Mufe'-̂ age Document <• Presentation

I P View PDF aftef Saving

t- Presentadon Optaons ——' ;—

| f? Advance Every §5 Seconds

I Г" Loop after Last Page

Transition:

Рис. 7.З. Окно PDF Presentation

Группа параметров Source Files определяет исходные файлы, на основе которых
будет создана презентация. Если поставить галочку Add Open Files, в окно выбора
файлов будут добавлены открытые файлы. Файлы из этого списка можно удалять,
пользуясь кнопкой Remove. Добавить файлы, хранящиеся на диске в презентацию,
можно при помощи кнопки Browse. После нажатия на эту кнопку появится окно
Open, при помощи которого можно выбирать файлы для включения в презентацию.



Создание PDF-презентаций •:• 165

После того как нужные файлы выбраны, самое время настроить параметры груп-
пы Output Options. Если поставить переключатель в положение Multi-Page Document,
тогда будет создан обычный PDF-файл, содержащий ваши фотографии. А вот по-
ложение переключателя Presentation позволяет сделать собственно презентацию
работой, которой мы сейчас и занимаемся.

Галочка View PDF after Saving принципиального значения не имеет, так как позво-
ляет запустить созданный документ для просмотра сразу после создания, что вы
без проблем можете сделать вручную.

Если в предыдущей группе параметров выбран пункт Presentation, тогда стано-
вятся доступными опции презентации, которые находятся в группе параметров
Presentation Option.

Параметр Advance every X seconds позволяет включить автоматическую смену изоб-
ражений через указанное количество секунд. Если его отключить, тогда вам при-
дется щелкать мышкой по изображению каждый раз для смены фотографии.

Другой параметр, Loop after Last Page, позволяет прокручивать изображения снова
и снова после достижения последнего фото.

Весьма интересен параметр Transition. Управляя им, вы можете выбрать один из
видеоэффектов, которые сопровождают смену изображений. То есть, возвращаясь
к просмотру нескольких фотографий при помощи Photoshop, создавая PDF-пре-
зентацию, вы можете получить плавно сменяющие друг друга фото, а не резкую
перерисовку экрана при просмотре средствами Photoshop.

Советую поэкспериментировать с разными значениями параметра Transition и выбрать
тот, который понравится вам больше всего. В качестве универсального варианта
можете поставить параметр Random Transition — система будет выбирать случайный
видеоэффект для каждой фотографии. По крайней мере, такая презентация полу-
чится немного необычной за счет большого количества эффектов.

Однако я все же советую вам попробовать разные эффекты, так как применение
Random Transition выглядит слишком уж пестро. А если вы собираетесь демонстри-
ровать что-то серьезное, тогда тем более нужно выбрать что-то одно.

После того как параметры установлены, остается лишь нажать на кнопку Save —
тут же появится новое окно, где необходимо выбрать папку для сохранения доку-
мента и дать документу имя.

Задав документу имя, вы, однако, не получите готовую презентацию сразу. Дело
в том, что указаны еще не все параметры для ее создания. После нажатия на кноп-
ку Сохранить в окне сохранения документов появится еще одно окошко (рис. 7.4).

Наиболее полезными для нас параметрами этого окна станут параметры группы
Encoding. Остальные предлагаю оставить по умолчанию, а на этих остановимся под-
робнее. Если в группе Encoding выбрать пункт ZIP, тогда изображения будут сжаты
без потерь по алгоритму ZIP. Делать это есть смысл лишь тогда, когда размер
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будущей презентации вас не интересует, а на первом месте стоит качество изобра-
жений.

)f Options '•*•••••• ~''::.:: ••••: :. ••.- '--•- .'•" ' . . . ' . • • ; . ;; : >

•••• Encoding
Г ZIP

> JPEG

Quality: flO~ j Maximum jj

•H-r:A4i

OK

Cancel

Г
Г

Г" Downgrade Color Profile

!~ PDF Security 'Acuity'

. Г" Include

j . Г Bit®

i ГЧ^о

Рис. 7.4. Окно PDF Encoding

Если выбрать параметр JPEG и установить параметр Quality на 10-12, то измене-
ний в качестве вы тоже не заметите, хотя файл получится меньше. Не обращать
внимание на размер файлов можно тогда, когда вы создаете презентацию для за-
писи ее на CD. Конечно, если вы собираетесь создать огромную презентацию, со-
держащую половину вашего цифрового фотоархива, тогда размер имеет значение,
а так — что 5 Мбайт, что 15 — особой разницы нет.

Состояние дел меняется, если вы создаете презентацию для последующего выкла-
дывания ее на ваш интернет-сайт или для пересылки по электронной почте. Здесь
вам уже, видимо, придется экспериментировать с установкой Quality.

Обычно где-то на 5-7 изображения начинают выглядеть немного хуже, а то, что
меньше 5, уже портит картинки довольно сильно. Хотя здесь все зависит от сюже-
та фотографий. Видимо, для интернет-целей и для целей электронной почты наи-
более оправданная установка Quality находится в районе 60. Но это, опять же, если
размер имеет значение. Если нет — ставьте 10 или 12, и фотографии будут выгля-
деть просто замечательно.
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После манипуляций с окном PDF Options нажимаем OK, наблюдаем некоторое вре-
мя работу Photoshop и идем в указанный на этапе задания имени файла каталог за
готовой презентацией, У меня получилась презентация на 1647 Кбайт, содержа-
щая 22 мобилографии 640x480 при уровне качества JPEG 10. Уменьшив уровень
качества до 6, в результате я получил размер такой же по содержанию презента-
ции уже в 920 Кбайт.

По качеству при сравнении этих двух презентаций выигрывает, конечно, первая,
но не настолько сильно, чтобы не оставить второй никаких шансов. Для e-mail
и размещения в Интернете такая презентация подойдет отлично.

Когда PDF-файл получен, достаточно просто сделать по нему двойной щелчок,
и будет запущена полноэкранная презентация. Фотографии будут сменяться с за-
данной периодичностью и с заданным эффектом. Для того чтобы ускорить смену
фотографий, можно щелкать мышью, не дожидаясь автоматической смены. Для
того чтобы выйти из режима презентации, можно нажать кнопку ESC на клавиату-
ре. Тогда ваша презентация примет вид обычного PDF-документа (рис. 7.5).

Adobe Reader •! Иге«чЛа1иш.ю»П

S £3е tdtt View Qocument Toos V^ndow Н

ifg eB«*s - ijjf ' Picture Tasks

Options •» x

Рис. 7.5. PDF-презентация

Выбрав вкладку Pages, вы можете осуществлять быструю навигацию между стра-
ницами, а пункт меню Window > Full Screen View запустит автоматическую презента-
цию снова.
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7.3. Создание web-галерей
Применение web-галерей оправдано тогда, когда вы, например, создаете простую
галерею для организации онлайнового доступа к ней. Photoshop позволяет авто-
матизировать рутинные операции по созданию web-страниц, системы навигации
и оптимизации страниц для web.

Если говорить о других способах применения web-галерей, то их точно так же, как
и PDF-презентации, можно использовать для демонстрации фотографий. С той
только разницей, что софт для просмотра web-страниц гарантированно будет при-
сутствовать на любом современном компьютере.

Еще одним преимуществом web-галерей перед PDF-презентациями является тот
факт, что при создании галереи вы имеете возможность настройки гораздо боль-
шего количества параметров, относящихся к свойствам отдельных изображений.

Например, вы можете добиться достаточно высокого качества и маленьких разме-
ров изображений не за счет сильного сжатия (которое ухудшает качество), а за
счет меньшего сжатия и уменьшения размеров изображения в пикселах. При этом
я никак не против PDF-презентаций — они тоже удобны и имеют право на суще-
ствование.

Итак, разрекламировав вам средство Photoshop по созданию web-презентаций,
приступаю к его описанию.

WEB Photo Gallery — так выглядит полное название этого инструмента. Вызвать его
можно при помощи команды File > Automate > Web Photo Gallery. После выполнения
этой команды вы увидите главное окно Web Photo Gallery (рис. 7.6).

Практически все настройки будущего сайта делаются в этом окне.

Очень интересным является параметр Styles. С его помощью вы можете выбрать
один из предустановленных стилей будущего фотосайта. Выбирая стиль из списка
Styles, вы получаете возможность увидеть, как будет выглядеть ваш сайт в неболь-
шом окошке сразу под кнопками ОК и Cancel. To есть оценить внешний вид web-
галереи вы сможете еще до ее создания. Обратите внимание на параметр Gorisontal
Slide Show — он позволит вам создать галерею, которая автоматически показывает
картинки. Стили, в названии которых есть слово Feedback, создают галерею с фор-
мой обратной связи.

Однако, на мой взгляд, наиболее актуальным стилем для создания простых web-
галерей является Simple — он выбран на рис. 7.6. Это, как следует из названия, про-
стой стиль — ничего лишнего, только тумбнайлы (миниатюры изображений), кар-
тинки и пара фраз в заголовке окна. Стиль этот универсальный, простой и очень
удобный. Однако, поэкспериментировав с другими стилями, вы, возможно, найде-
те что-нибудь наиболее полно соответствующее вашим потребностям.

Сразу под списком Styles вы можете увидеть окно для ввода вашего e-mail. Введи-
те его в это окошко, если вы хотите, чтобы те, кто смотрит вашу галерею, могли
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с вами связаться. Для интеграции полученной галереи в существующий web-сайт
заполнение этого поля необязательно.

Web Photo GaBenr

Site OK

E-mail: j

г™ Source Images

I- Use: JFolder

Reset

growse...]

P include All Subfofdeis

Qestiratton...

Options: General

Extension: j.htm J

Г Use UTF 8 Encoding for URL

F Add Width and Height Attributes for Images

Г" Preserve all metadata

Рис. 7.6. Окно средства Web Photo Gallery

В группе параметров Source Images можно увидеть параметр Use, значения которо-
го выбираются из одноименного списка. Если перед запуском средства Web Photo
Gallery вы запустите File Browser и выделите в нем несколько файлов, вы сможете
выбирать из параметров Selected Images From file Browser и Folder. Первый позволяет
создать галерею на основе файлов, выделенных в File Browser, а второй дает возмож-
ность указать папку, содержимое которой будет использовано для создания web-
галереи.

Лучше всего, если вы хотите создать web-галерею, предварительно подготовить
все нужные файлы, поместив их в отдельную папку. Для выбора папки с данными
в группе параметров Source Images надо нажать кнопку Browse и указать нужный
каталог. Так же нужно выбрать папку назначения, в которую будут скопированы
файлы, создаваемые в процессе работы средствами Web Photo Gallery.
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Интересна в плане влияния на результирующий проект группа параметров Options.
Выбирая название группы значений из списка Options, вы получаете возможность
изменять некоторые параметры готовой галереи. В принципе, можно оставить по
умолчанию практически все, хотя некоторые из параметров могут нуждаться в на-
стройке. Например, выбрав параметр Banner, вы сможете настроить название ва-
шей web-галереи (параметр Site Name), при желании написать свое имя (Photo-
grapher), контактную информацию, дату съемок.

Весьма полезными и важными параметрами средства Web Photo Gallery являются
Large Images, где вы можете настроить размер будущих изображений, уровень
JPEG-сжатия; T h u m b n a i l s — группа параметров, которая отвечает за размер тумб-
найлов и некоторые другие параметры. Обычно параметры Thumbnails достаточно
соответствуют нуждам пользователей, будучи установленными по умолчанию.
Это те самые параметры, возможность настройки которых выгодно отличает Web
Photo Gallery от средства для создания PDF-презентаций. Посмотрите на рис. 7.7.
Здесь вы можете видеть окно настроек Thumbnai l s .

Web Photo байеп.
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Styles: [Simple

i-rrsii: )

Source Images •

~3
Reset

US|B: j Folder

growse...

W Include All Siibfolders

DestratkHi...
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Size: [Medium "! i?5

Columns: j"i Sows: 13

Banter Size: \u pixels

Tittes Use: f7 ггймгпе Г

pixels

Г Г.,:

Г О
г

Рис. 7.7. Окно свойств параметра Thumbnails
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Тут решающее значение имеет параметр Size, определяющий размеры будущего
тумбнайла.

После настройки Web Photo Gallery остается лишь щелкнуть на кнопке ОК и, понаб-
людав за виртуозной работой Photoshop CS, перейти в папку, содержащую гото-
вую web-галерею. Посмотрите на рис. 7.8. Вот что у меня получилось.

[-Я Adobe web Phnto Gaiter» - Microsoft Internet Exntorer- Гйвтектюя» pafioral

Правке gwc к̂ранное Серзис ^правка

Избранное ^ j * Меди
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Рис. 7.8. Web-галерея

Работа с этой галереей ничем не отличается от работы с обычными web-странич-
ками.

Но способы демонстрации своих фотографий окружающим на этом не заканчива-
ются. Например, фотографии можно выложить на каком-нибудь сайте, специаль-
но для этого предназначенном.

7.4. Использование Online-фотоальбомов

Для демонстрации собственных фотографий в Сети вполне можно создать соб-
ственный же web-сайт. Но содержание сайта — это непростое занятие, даже если
сайт состоит из пары страничек. Возня с хостингом, всякие FTP-клиенты, необхо-
димость разбираться с HTML и прочие подобные вещи не позволяют назвать соб-
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ственный сайт однозначно рекомендуемым местом для ваших фото. К тому же не
всем такой сайт нужен.

То ли дело специальные ресурсы, ориентированные на фотолюбителей и мобило-
графов. Там собираются люди, которые затем и пришли на сайт, чтобы посмотреть
чужие фото, показать свои, пообщаться с единомышленниками.

Например, сайтом, предназначенным специально для мобилографов, то есть для
всех, кто делал снимки своим мобильником, является сайт Всемирного Общества
Мобилографов http://www.mobilography.com.

Для регистрации на сайте надо перейти по ссылке Регистрация на первой странич-
ке сайта. После того как вы перешли по этой ссылке, появится окно регистрации,
предельно простое — вам нужно лишь пару раз ввести свой e-mail в соответствую-
щее поле (рис. 7.9).

3МоЬЛщпцЛу-ихи (Registering) • Microsoft Internet Explorer

Правка {Зид Избражое

* Медиа

-;-:,1: . . 3 О i Оыякм

который в дальнейшей будут приходить уведомления системы, два раза. После этого *•}
нажать кнопку "Регистрация". После этого на указанный почтовый ящик придёт писъ
с зктивизационным паролей. Зайдите на сайт, ссылка "Активизировать экхаунт" и
введите там активизационный пароль. Затем останется только заполнить свои данны*
поязив^ейся форме, обращая особое а-нимзние на обязательные поля, и нажать кног
"Зарегистрироваться". Всё, теперь вы участник проекта! Добро пожаловать!

Регистрация с телефона
Для регистрации на сайте через нашу программу Mobtlography нужно указать в ней сг
e-mail в меню "Настройки", Затем сделать из программы какой-нибудь снимок, сохрани
его (нажав кнопку выбора/подтверждения) в галерее и послать его оттуда на сайт,
нажав 1 или выбрав в меню "Функции" пункт "Послать на сайт". После этого на
указанный почтовый ящик придет письмо с активизационнык паролем. Зайдите на cat
ссылка "Активизировать эккаунт" и введите там зктивизационный пароль. Затем
останется только заполнить свои данные в появившейся фор^е, обращая особое
внимание на обязательные поля, v- нажать кнопку "Зарегистрироваться", Всё, теперь
участник проекта! Добро пожаловать!

Регистрация по e-mati
Для регистрации на сайте через e-mail вам необходимо послать писымо со влохенной-
нобилографией ка адрес graph@mobilography.com. В ответ вы получите письмо с
активизационным паролем. Зайдите на сайт, ссылка "Активизировать экхаунт" и введ!
таи зктивизационный пароль. Затем останется только заполнять свои данные е
появившейся форме, обращая особое внимание на обязательные поля, и нажать кног
"Зарегистрироваться". Всё, теперь вы участник проекта! Добро пожаловать!

* о ?-юби;-югр>афии
*- моби

t сообщества
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Рис. 7.9. Регистрация в проекте

После нажатия на кнопку Получить активационный пароль на ваш электронный адрес
будет выслано письмо, содержащее этот самый пароль. Его нужно ввести в поле
А к т и в а ц и о н н ы й пароль окна, которое появится после нажатия на кнопку Получить
активационный пароль (рис. 7.10).
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Рис. 7.10. Активация аккаунта

Теперь, нажав на кнопку Активировать аккаунт, вы оказываетесь в новом окне, где
обязательными для заполнения являются всего три поля — «никнэйм» и два раз-
дела для пароля и подтверждения. Заполняете их, и вы в системе. Теперь вы мо-
жете создавать альбомы мобилографий, добавлять мобилографии в альбомы, ре-
дактировать их и так далее.

Например, для того чтобы добавить новую мобилографию, надо щелкнуть по ссыл-
ке Добавить мобилографию в левой части окна, заполнить небольшую форму, глав-
ным полем которой является поле Файл. Нажав на кнопку Обзор..., вы запускаете
стандартное средство Windows для открытия файлов, ищете нужный файл, а по-
том, нажав кнопку Закачать, загружаете мобилографию на сайт (рис. 7.11).

Все, после нажатия на кнопку Закачать мобилография будет добавлена в альбом,
указанный при заполнении формы загрузки. А в нашем случае она была добавле-
на в альбом Основной. Для того чтобы попасть в этот альбом, надо щелкнуть по
ссылке Альбомы в левой части окна.

Появится список альбомов. Если щелкнуть по миниатюре альбома, он будет от-
крыт и появится возможность редактировать информацию о мобилографиях, со-
держащихся в альбоме, удалять их и так далее.
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Рис. 7.11. Добавление мобилографий

Для того чтобы все желающие могли просмотреть ваши альбомы, нужно, чтобы
они знали ваш никнэйм. На сайте есть раздел Мобилографы — достаточно найти
ваш ник там и щелкнуть по нему, выбрать ссылку Альбомы, и ваши альбомы и мо-
билографий можно будет просмотреть.

Проект http://www.mobilography.com сейчас претерпевает изменения, реорганизует-
ся, поэтому, вполне возможно, что когда вы войдете на него, что-нибудь будет из-
менено в лучшую сторону. На сайте действуют сообщества, система рейтингов —
это для тех, кто хочет заниматься мобилографией серьезно.

Неплохим web-сервисом для ведения фотоальбомов является http://photofile.ru/.
Интерфейс сайта весьма прост и понятен, очень похож на вышеописанный, кста-
ти. Поэтому при желании разместить на нем свои фото вы сможете сделать это за
считанные минуты.

Сервис обладает хорошей справочной системой, администрацией сайта создана спе-
циальная программа для автоматизации загрузки и оптимизации фотографий. Это
сервис общей направленности, поэтому если вы ищете именно мобилографические
фотосайты — обратите внимание на вышеописанный http://www.mobilography.com/.
Теперь, думаю, наш разговор о мобилографий подошел к логическому заверше-
нию — осталось лишь выразить благодарности тем, кто помогал мне работать над
этой книгой, и рассказать о том, как подключить мобильный телефон к компьютеру.
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7.5. Заключение и благодарности
Наш разговор о мобилографии почти закончен. Надеюсь, вы нашли здесь для себя
что-нибудь интересное. Если вы читаете эти строки, а ваши мысли уже где-то рядом
с вашим камерофоном, это значит, что я не зря писал эту книгу. А сейчас позволь-
те познакомить вас с теми, без кого эта книга вряд ли появилась бы на свет. Я хо-
тел бы сказать здесь несколько слов благодарности этим замечательным людям.

Спасибо Дмитрию Резвану (рис. 7.12). Дмитрий — это человек, увлеченный моби-
лографией и увлекающий за собой всех, кто способен воспринять идеи этого со-
временного направления фотоискусства.

7.12. Дмитрий Резван

Весной 2004 года он основал Всемирное Общество Мобилографов (World Mobilo-
graphy Society, WMS), призванное объединить мобилографов всего мира. Центр
Всемирного Общества Мобилографов находится в Москве. И, надо сказать, дви-
жение мобилографов набирает популярность. Проводятся различные культурные
мероприятия в Сети и за ее пределами, мобилографией начинает интересоваться
все большее и большее количество людей, а развитие WMS предусматривает со-
здание собственного печатного органа.

В интервью для ArtElectronics Дмитрий говорил:

«Мобилография — больше, чем какое-то направление в искусстве, это
коммуникационная, творческая среда, в которой будут рождаться как но-
вые виды искусств, так и новые технологии. И то и другое будет очень ди-
намичным и развивающимся. Появившиеся за последние несколько лет
технические средства коренным образом меняют представление об ис-
кусстве в принципе.

Мобилография уже создает новые формы различных видов искусств. На-
пример, у нас на сайте будет страница комиксов. Разумеется, комиксы
существовали и раньше. Но Мобилография значительно расширяет воз-
можности именно коллективного творчества. Люди из разных стран смо-
гут работать над одним и тем же проектом. Это создание новой коммуни-
кации в искусстве — мгновенной доставки информации.

В традиционной фотографии, прежде чем выставить свои работы, человек
должен был снять, проявить, напечатать. Даже цифровая съемка подразу-
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мевает некие действия, которые совершаются не мгновенно. Мобилогра-
фия же дает новый качественный уровень коммуникации: человек создал
произведение, тут же отправил его во всемирную сеть, и оно сразу начи-
нает принимать участие в художественной жизни как самостоятельное
произведение или как часть коллективного, интерактивного проекта».

Дмитрий предоставил мне свои лучшие работы, думаю, вы не могли их не заме-
тить. Общение с ним привнесло много нового в мое видение мобилографий. Да,
вот еще одна из его замечательных мобилографий (рис. 16 цветной вклейки).

Благодарю Михаила Рейфмана (рис. 7.13), замечательные фотографии которого
послужили отличными иллюстрациями к некоторым разделам этой книги.

Рис. 7.13. Михаил Рейфман

Михаил родился в 1961 году в Харькове, окончил Харьковское государственное
художественное училище, защитил диплом по портрету. Он учился у живописца
Григория Ивановича Батия и графика Анатолия Павловича Луценко. Также Ми-
хаил имеет второй диплом — архитектора. Думаю, вы оценили влияние художе-
ственного образования на видение мира — работы Михаила тому красноречивое
подтверждение. Сейчас он живет и работает в США. Михаил занимается реклам-
ным дизайном и фотографией, рекламные кампании, основанные на его снимках
и дизайнерских решениях, печатаются в нескольких центрально-отраслевых жур-
налах более чем в 20 штатах.

Спасибо Эрнесту Бренделю (рис. 7.14). Каждый раз, когда я вижу его новые рабо-
ты, меня так и тянет написать что-нибудь новое и проиллюстрировать это новое
его снимками. Эрнест начал заниматься фотографией с 14 лет, потом, после пере-
рыва, в 2000 году вернулся к художественной фотографии. Его любимые жанры —
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пейзаж, город с жанровым уклоном, натюрморт, портрет. Эрнест родился и про-
вел детство в России, в 1992 году переехал в Литву, в данный момент живет в Виль-
нюсе, Литва.

Рис. 7.14. Эрнест Брендель

Благодарю Александра Каасика (рис. 7.15). Его фотографии, такие спокойные
и чистые, никого еще не оставляли равнодушными.

Рис. 7.15. Александр Каасик
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Работал фотографом, преподавателем, агрономом, руководил хлебозаводом. Не-
давно Александр приобрел цифровую фотокамеру и теперь снимает много и пло-
дотворно. Особенно он любит фотографировать природу.

Благодарю Александра Ищенко. Его мобилографии неплохо помогли мне. Алек-
сандр живет в Тихорецке, Краснодарский край, Россия. В качестве инструмента
мобилографа он использует телефоны от Siemens и, похоже, не собирается менять
своих пристрастий.

Спасибо мобилографу, скрывающемуся под псевдонимом V-dyMkax. Он родом из
города Заволжье Нижегородской области и снимает преимущественно фотомо-
бильной техникой от LG.

Хочу поблагодарить Алексея Калиберду из Екатеринбурга, Россия. Он снимает
аппаратом от Sony Ericsson и оказал мне содействие в написании приложения.

Когда идейных вдохновителей, фотографов и мобилографов я поблагодарил, пе-
рехожу к тем, кто участвовал в съемках для этой книги.

Хочу сказать спасибо Екатерине Тищенко (рис. 7.16) — она, одна из немногих, все-
гда рада была фотографироваться.

Рис. 7.16. Екатерина Тищенко
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Мобильник с камерой, конечно, не такое «пугающее» устройство, как обычный
фотоаппарат, но и он способен заставить многих будущих фотомоделей закрывать-
ся руками и стараться убежать из кадра. А Катя прямо-таки сама просилась в кадр.
За что ей спасибо.

Катя живет в Тихорецке, Краснодарский край, Россия.

Благодарю Юрия Бугримова (рис. 7.17) — он добровольно участвовал в динами-
ческих съемках, а это — серьезное испытание, особенно после десятого дубля.

Рис. 7.17. Юрий Бугримов

Динамические эффекты мобилографии способны вызвать панический ужас у мно-
гих, но только не у него, за что ему огромное спасибо. Юра живет в Тихорецке,
Краснодарский край, Россия.

Благодарю также всех, кто чувствует себя причастным к этой книге — на самом
деле этих людей очень и очень много. И то, что я их не перечислил здесь, не зна-
чит, что я о них забыл. Ничего подобного, я все помню и благодарю вас всех.

Спасибо Московской редакции ИД «Питер» — с вами приятно работать.

Вот, похоже, и все. Да, спасибо вам, уважаемые читатели, за то, что вы есть.
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ВашА. 3. (рис. 7.18).

Рис. 7.18. Фото автора

До новых встреч на страницах книг Издательского дома «Питер».
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Одной из довольно распространенных проблем, с которыми сталкиваются пользо-
ватели фототелефонов, является соединение сотовых с ПК. Это, на самом деле, не
такая уж и большая проблема, и ее решением мы займемся в данном приложении.
Здесь будет дана информация, которая поможет вам в деле соединения мобиль-
ника и компьютера.

Способы подключения

На сегодняшний день актуально несколько способов соединения сотового и ПК.
Исторически первым способом стало использование дата-кабеля.

Дата-кабель
Дата-кабель (рис. П.1) представляет собой кабель, при помощи которого сотовый
подключается к ПК. Для разных моделей сотовых существуют разные кабели.
В редких случаях кабель от одной модели телефона подходит к другой. Как пра-
вило, они довольно сильно специализированы. Исключение, пожалуй, составля-
ют лишь аппараты от Motorola, которые в качестве одной из альтернатив подклю-
чения позволяют использовать Mini-USB кабель, подходящий ко всем моделям
этой фирмы, имеющим соответствующий интерфейсный разъем.

Рис. П.1. Дата-кабель

Если говорить об интерфейсе сопряжения с ПК, то здесь существует два варианта.
Первый — дата-кабель для СОМ-порта, все еще встречается для некоторых теле-
фонов, но стремительно вытесняется USB-кабелями. В принципе, если говорить о
скорости передачи данных, то для работы с фотографиями что СОМ, что USB —
разницы особой нет. Дело в том, что в подавляющем большинстве случаев USB-
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подключение является эмулятором СОМ-порта, то есть система думает, что рабо-
тает с СОМ, а физически данные передаются по USB. Скорости передачи, кстати
сказать, практически всегда хватает для комфортной работы с данными.

Если вопросы скорости передачи оказываются непринципиальными, то сам спо-
соб подключения, то есть СОМ или USB, порой оказывается важным. Например,
если вы хотите «подружить» современный сотовый с современным ноутбуком.
В новых ноутбуках СОМ-порт встречается все реже и реже, поэтому здесь лучше
всего подойдет USB-кабель. Однако если у вас уже есть СОМ-кабель, сотовый,
программное обеспечение для связи телефона и компьютера, то подключить такой
кабель к современному ноутбуку можно, купив соответствующий переходник
COM-USB.

Существующие на рынке дата-кабели условно можно разделить на три категории.
Первая, наиболее предпочтительная, порой и самая дорогая, — это дата-кабели
производства фирм — создателей телефона. Если сотовый имеет коммуникацион-
ный порт, это значит, что для него будет выпущен дата-кабель и создано соответ-
ствующее ПО. Дата-кабели фирменного производства комплектуются CD с со-
фтом. На компакт-дисках, идущих в комплекте с кабелями, есть программы для
работы с содержимым телефона, необходимые драйверы — небольшие программки,
которые позволяют компьютеру общаться с телефоном, наборы картинок, мело-
дий, иногда игры и так далее.

Если вы купите фирменный дата-кабель, то заранее можно сказать, что проблем
с подключением сотового к ПК у вас быть не должно. Естественно, при условии,
что кабель, сотовый и компьютер находятся в исправном состоянии. Немного
ниже мы обсудим особенности подключения различных моделей телефонов, а
пока перейдем к характеристике следующей категории дата-кабелей, которые
выпускаются теперь уже не фирмами-производителями телефонов, а сторонними
производителями.

Итак, второй группой кабелей в нашей классификации является продукция сто-
ронних фирм. Причем не всех, а лишь фирм известных своей продукцией. Напри-
мер, среди них можно назвать Mobile Action — продукция этой компании позволяет
соединять с ПК огромное количество сотовых. Фирма выпускает и поддерживает
большое количество программного обеспечения для связи сотовых и ПК. Иногда
работать с ним даже удобнее, чем с фирменными программами, хотя это дело
вкуса.

Покупая фирменный дата-кабель от Mobile Action, вы практически гарантиро-
ванно получаете надежную и удобную связь сотового с ПК. Только при покупке
обязательно нужно знать производителя и модель вашего телефона, так как для
разных аппаратов созданы разные комплекты ПО и дата-кабелей. Эти кабели,
как правило, стоят практически столько же, сколько и от фирм-производителей
аппаратов, однако и здесь такая стоимость (обычно находящаяся где-то в районе
900-1400 рублей) вполне оправдана.

Третья группа кабелей производится, грубо говоря, неизвестно кем (качество порой
бывает очень плохим), стоит часто гораздо дешевле, может не иметь в комплекте
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поставки программного обеспечения. То есть, покупая дешевый кабель в надежде
самостоятельно найти софт для него (может, кстати, возникнуть ситуация, требу-
ющая переделки самого кабеля), вы рискуете потратить гораздо больше времени,
а возможно и денег, на доводку его до ума. Хотя я не исключаю случаев нормаль-
ной работы подобных кабелей.

Когда с дата-кабелями все более-менее понятно, перейдем к другим методам свя-
зи ПК и сотового. Среди них — инфракрасный порт и Bluetooth-адаптер.

Инфракрасный порт
Многие модели сотовых телефонов оборудованы инфракрасным портом. Его мож-
но использовать для связи сотового с ПК. Инфракрасные порты очень мало рас-
пространены среди настольных ПК (они частые гости в ноутбуках, хотя не во
всех). Поэтому для связи при помощи инфракрасного порта вам придется купить
соответствующий адаптер, который обычно представляет собой внешний инфра-
красный порт, подключаемый при помощи USB к ПК.

Посмотрите на рис. П.2. Здесь вы можете видеть внешний инфракрасный порт,
подключаемый к ПК.

Рис. П.2. Инфракрасный порт

При выборе подключаемого инфракрасного порта наилучшей альтернативой, ви-
димо, является продукция известных производителей — той же Mobile Action, ко-
торая выпускает комплекты для инфракрасной связи, содержащие все необходи-
мое ПО.

Единственным недостатком при использовании инфракрасного способа связи
в сравнении с дата-кабелем является тот факт, что инфракрасные порты двух уст-
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ройств (сотового и ПК) должны быть расположены в пределах прямой видимости
друг от друга и на расстоянии до 1 метра (чем ближе — тем лучше).

Если потревожить сотовый в момент передачи данных по инфракрасному порту,
скажем, передвинуть его, то почти наверняка связь будет прервана. Однако инф-
ракрасные порты являются достаточно удобным средством для связи сотовых
с компьютерами, хотя, похоже, постепенно теряющим популярность.

Другим средством связи, которое становится все популярнее и популярнее, явля-
ются Bluetooth-адаптеры. Ими сейчас в основном комплектуют достаточно доро-
гие аппараты, хотя уже довольно скоро ВТ можно будет встретить в очень и очень
многих моделях.

Bluetooth-адаптер
Bluetooth — это беспроводной радиоинтерфейс. То есть стены и другие предметы
для него не помеха. Мобильник может лежать где-нибудь в сумке, а вы сможете
скачивать с него фотографии при помощи коммуникационного ПО. В общем слу-
чае дальность связи, обеспечиваемая ВТ, находится где-то в пределах 10 метров,
реально обычно больше. Это очень удобный интерфейс, и если ваш мобильник его
поддерживает, это значит, что Bluetooth стоит отдать приоритет.

Стоимость ВТ-адаптеров, если смотреть на нижнюю ценовую категорию, находит-
ся также в районе 1000-1200 рублей и доходит до 2500 рублей и более.

Посмотрите на рис. П.З. Здесь изображен Bluetooth-адаптер, подключенный к но-
утбуку.

Рис. П.З. Bluetooth-адаптер
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Когда интерфейсы подключения мы обсудили, поговорим об особенностях уста-
новки программного обеспечения для работы с телефоном.

Работа с программным обеспечением
Для начала позволю себе разъяснить несколько общих моментов, касающихся
установки любых периферийных устройств, сотовых — в том числе.

Установка драйверов и программ: общие понятия
Для того чтобы компьютер мог работать с периферийным устройством, необходи-
мо выполнение по меньшей мере двух условий. Первое — наличие физического
подключения, о котором мы говорили выше, а второе — наличие соответствующе-
го программного обеспечения.

В свою очередь ПО можно разделить на два класса программ. Первый — это драй-
веры, предназначенные для конкретного оборудования, а второй — собственно
программы, при помощи которых пользователь имеет возможность работы с уст-
ройством. Драйверы нужны для того, чтобы компьютер «знал», как «объяснить»
каждому конкретному устройству команды пользователя.

Общепринятым порядком установки новых устройств является следующий: сна-
чала устанавливаются драйверы, потом — пользовательский софт.

Здесь я хочу сделать замечание по поводу различных видов ПО, присутствующих
на рынке. Эти виды очень похожи по сути на вышеописанную классификацию
дата-кабелей. Есть фирменное ПО, кстати, не всегда являющееся наилучшим вы-
бором, есть программы сторонних разработчиков вроде той же Mobile Action и есть
софт «народных умельцев».

Как правило, программное обеспечение серьезных сторонних разработчиков мо-
жет смело конкурировать с фирменным ПО. А вот удобство и надежность работы
всего остального находится под вопросом.

Я с уважением отношусь к тем энтузиастам, которые разрабатывают собственные
коммуникационные программы для тех или иных телефонов. Это интересное и
полезное занятие, добавляющее нам с вами альтернативы в выборе софта. В то же
время, такой софт иногда бывает очень сложно настраивать — вручную модифи-
цировать реестр, править какие-нибудь конфигурационные файлы и так далее.
Здесь мы рассмотрим особенности работы с продукцией фирмы Mobile Action.

Продукция Mobile Action
Mobile Action выпускает три типа коммуникационных комплектов. Это комплек-
ты, основанные на дата-кабелях, инфракрасных портах и ВТ-адаптерах. Стоимость
комплектов находится в районе 1000 рублей за вариант с дата-кабелем или инф-
ракрасным портом и около 2000 за ВТ-вариант.
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Политика фирмы в области ПО и коммуникационного оборудования выглядит сле-
дующим образом: на сайте http://global.mobileaction.com/en/ вы можете бесплатно
загрузить ПО и драйверы для любого поддерживаемого компанией телефона. Но
работать это программное обеспечение будет только с фирменными аксессуарами
компании — дата-кабелем, инфракрасным портом или ВТ-адаптером.

Например, вы купили телефон от Sony Ericsson с поддержкой ВТ и коммуникаци-
онный ВТ-комплект от Mobile Action для него. А потом поменяли телефон на ап-
парат от Nokia, поддерживающий все тот же Bluetooth. Для того чтобы пользовать-
ся тем же комплектом связи, вы идете на сайт, скачиваете новое программное
обеспечение, устанавливаете его и все — вы сможете работать с новым телефоном.

Продукция от Mobile Action отличается достаточно высоким качеством и продуман-
ностью процесса установки. Фактически, вам достаточно лишь вставить прила-
гающийся к дата-кабелю, инфракрасному порту или ВТ-адаптеру диск в CD-при-
вод и следовать указаниям установщика. Здесь мы рассмотрим основные этапы
установки различных коммуникационных комплектов.

Но для начала позвольте представить вашему вниманию несколько таблиц, содер-
жащих информацию о поддерживаемых компанией моделях сотовых телефонов.
Когда вы будете читать эти строки, Mobile Action уже выпустит много нового, так
как она отличается высокой скоростью реагирования на рыночные новинки, хотя
нижеприведенная информация еще довольно долго будет достаточно актуальной.
USB Data Suite, как следует из названия, поддерживает связь с ПК посредством
USB дата-кабеля, Infrared Data Suite — посредством инфракрасного порта, a Blue-
tooth Data Suite — при помощи Bluetooth.

Нижеприведенные табл. П.1-П.З призваны помочь вам при подборе коммуника-
ционного оборудования для вашего сотового телефона. Зная производителя и мо-
дель вашего телефона, вы сможете определить, какой продукт от МА соответству-
ет ему, и заниматься целенаправленными поисками этого продукта.

Таблица П.1. Модели телефонов, поддерживаемые USB Data Suite от Mobile Action

Производитель телефона

LG

SHARP

SAMSUNG

Продукция MA

МА-8020Р

МА-8110Р

МА-8120С

МА-8130С

МА-8220

Поддерживаемые модели

G5500 / G7050

GXlOi / GX20-GX21-GX22

GX15 / GXT15 / GXL15 / GX25 /
GX30 / GX31 / GX32 / GXE30 /
GXT25

GX15 / GXT15 / GXL15 / GX25 /
GX30 / GX30i / GX31 / GX32 /
GXE30 / GXT25

D410-D418 / ЕЗОО / Е310 / Е600 /
Е710-Е715 / Р100 / Р400-Р408 /
S300-S307-S308 / V200-V206 /
Е600-Е608

Окончание
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Таблица П. 1 (окончание)

Производитель телефона

NOKIA

PANASONIC

SAGEM

SIEMENS

MOTOROLA

SONY ERICSSON

Продукция MA

MA-8230P

MA-8250P

MA-8620E

MA-8630

MA-8310P

MA-8320P

MA-8330

MA-8350

MA-8520P

MA-8720C/P

MA-8730P

MA-8830P

MA-8860C

MA-8870

MA-8910C/P

Поддерживаемые модели

E100 / E700-E708 / S500-S508 /
X100-X108 / X460 / X600-XG08 /
E800-E808-E820

P510-P518

3100-3120 / 3108 / 3200 / 3220 / 5100
/ 5140 / 6100 / 6108 / 6200 / 6220 /
6610 / 66101 / 6800 / 6810 / 6820 /
7200 / 7210-7250-72501 / 7260

6230/7600/7610

GD87-GD88-GU87

X70-X88-P3411

X300

X100/X500

My X-2 / My X-5 / My X-6 / My X-7 /
My V-55 / My V-65 / My V-75 /
My X3-2 / My X5-2 / My X8

A60-C60 / C55-2128 / C62 /
C65-C65V / CF62 / CX65-M65 /
M55 / MC60 / S55 / S57 / SL55 / SL65

A60 / A65 / C55 / C60 / C62 / C65 /
C65V / CF62 / CX65 / M55 / M65 /
MC60 / S55 / S57 / S65 / SL55 / SL65

V690 / V878

V300-V303-V400 / V600-V80/
V500-V501-V505-V525 / E398

V3 / V220 / C650

K5001-F5001/ K7001 / S7001 / T230 /
T300-T310 / T39 / T610-T616-T618-
T628-T630 /T65 / T68 / T681 / V800 /
Z1010

Таблица П.2. Модели телефонов, поддерживаемые Infrared Data Suite от Mobile Action

Производитель телефона Продукция МА Поддерживаемые модели

NOKIA МА-660 3200 / 5100 / 5140 / 5210 / 6100 /
6108 / 6200 / 6210 / 6220 / 6230 /
6250 / 6260 / 6310-63101 / 6500-6510
/ 6600 / 6610 / 66101 / 6800 / 6810 /
6820 / 7110-7190 / 7200 / 7210-7250-
72501 / 7650-3650-3600-3660 / 7600
/ 8210-8290 / 8250 / 8310-8390 /
8850-8890 / 8855 / 8910 / 89101
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Производитель телефона

SIEMENS

SONY ERICSSON

SAMSUNG

SHARP

PANASONIC

LG

SAGEM

MOTOROLA

Продукция MA

MA-660

MA-660

MA-660

MA-660

MA-660

MA-660

MA-660

MA-660

Поддерживаемые модели

S35i-3568i / SL42-SL45-6688 / S45-
ME45-6618-3618 / SL55-SL5C / SX1
/ SL56 / S65 / SL65

R320sc / R520 / SVOOi / T39 / T68 /
T68i / T300-T310-T312 / T306-T316
/ K500i-F500i / K700i / P800 / P900
/ P910i / T300-T310 / T610-T616-
T618-T628-T630 / V800 / Z600 /
Z1010

E100 / E105 / V200-V206 / A300-
A308-A400-A408 / E300 / E310 /
P100 / P400-P408 / S500-S508 /
E700/E715-E710-E810/
E800-E808-E820 / P810-P815 /
E600-E608

GX20-GX21-GX22

X70-X88

G5410/G7100/G7030

M y X 5 - 2 / M y X 8

Timeport 260 / P7389i

Таблица П.З. Модели телефонов, поддерживаемые Bluetooth Data Suite от Mobile Action

Производитель телефона

NOKIA

SIEMENS

SONY ERICSSON

PANASONIC

MOTOROLA

SHARP

Продукция MA

MA-700

MA-700

MA-700

MA-700

MA-700

MA-700

Поддерживаемые модели

3600-3620 / 3650-3660-7650 / 6230 /
6260 / 6310-6310! / 6600-6620 / 6620
/ 6670 / 6810 / 6820 / 7600 / 7610 /
8910/89101

S55/S65/SX1

K700i / P800 / P900 / P9101 /
S7001 / T39 / T68 / T68i /
T610-T616-T630-T637 / V800 /
Z600/Z1010

Х70-Х88-Р34П

E398 / E550 / V500-V501-V505-
V525 / V80-V600 / V551 / V6001

GX15 / GXT15 / GXL15 / GX25 /
GXT25 / GX301

Вся продукция Mobile Action оснащается русскоязычными инструкциями. В ком-
плекты входит коммуникационное устройство и диск с ПО.

Теперь рассмотрим особенности подключения сотовых к ПК с использованием
коммуникационных комплектов от Mobile Action.
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Установка ПО и процесс подключения
Приобретая коммуникационный комплект от Mobile Action, вы получаете CD
с программным обеспечением и дата-кабель, внешний инфракрасный порт или
Bluetooth-адаптер в зависимости от комплектации. Ниже будет рассмотрена про-
цедура установки этого оборудования.

Установка дата-кабеля и загрузка обновлений
Этот раздел не случайно называется «Установка дата-кабеля». Дело в том, что
дата-кабели от Mobile Action для своей работы требуют установки специальных
драйверов. Это, фактически, особое USB-устройство.

Как вы понимаете, сделано это для того, чтобы фирменным ПО компании можно
было пользоваться только посредством фирменных же аксессуаров.

Итак, ниже описан процесс установки дата-кабеля. Он выглядит следующим обра-
зом (здесь и далее будут рассмотрены особенности установки и настройки обору-
дования в Windows XP).

.Ĵ -

Motorola C650

Выберите язык jРусский

Выберите нодель
телефона

Выберите кабель

ОК.

~3

Рис. П.4. Выбор модели телефона и типа кабеля

Перед подключением дата-кабеля к компьютеру необходимо установить программ-
ное обеспечение для него. Для этого надо вставить CD, прилагающийся к кабелю,
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в дисковод. После этого запустится программа инсталляции ПО — вам нужно бу-
дет выбрать следующее действие (Установка).

Теперь запустится форма выбора параметров установки, где надо выбрать язык
установки (Русский), ваш мобильный телефон и тип кабеля (рис. П.4). Начнется
установка программного обеспечения для кабеля.

После начала установки появится окно, которое содержит информацию о ваших
дальнейших действиях (рис. П.5)

«S8 Cable Setup

Пожалуйста, сначала включите свой мобильный телефон. Подключите МА-8870 (USB
Port) к телефона и затем подключите его к рагьемуиЗВ на компьютере.
Если МА-8870 (USB Port) уже подсоединен к ПК, то отсоедините его и подождите 3
секунды. Затем снова подсоедините его к разъема USB.

Установка драйвера может занять несколько минут, пожалуйста, подождите.

1IIBIIII1IIIIII1I

Рис. П.5. Установка оборудования

После того как дата-кабель и телефон установлены (установка проводится в авто-
матическом режиме, вам остается лишь следовать указаниям, которые даются в
процессе установки), можно приступать к установке Handset Manager (или Ме-
неджера телефона, в русском переводе) — то есть тех самых программ для взаимо-
действия с телефоном.

Установка Менеджера телефона ничем не отличается от установки любой другой
Windows-программы. Ответив несколько раз Далее на вопросы программы, вы ус-
танавливаете его на свой ПК (рис. П.6).

После установки вы можете воспользоваться программой для решения ваших за-
дач. В частности, вы можете копировать фотографии из вашего телефона на ком-
пьютер. Прежде чем обсудить возможности этого ПО, расскажу о том, как прово-
дить обновление программного обеспечения с использованием сайта компании.

Как я уже говорил, все желающие могут скачивать программное обеспечение от
МА с сайта компании, для того чтобы смена телефона не приводила к необходи-
мости покупки нового коммуникационного оборудования. В случае с дата-кабеля-
ми это справедливо лишь отчасти, так как они обладают ограниченной совмести-
мостью. А вот если говорить о ВТ и инфракрасных портах, то здесь пользователь
может ощутить преимущества такого подхода в полной мере.

Итак, для того чтобы загрузить программное обеспечение для вашего нового теле-
фона, надо ввести в строку «Адрес» вашего web-браузера адрес сайта компании —
http://mobileaction.com/ — вы попадете на стартовую страничку. Здесь необходи-
мо перейти по ссылке Download (рис. П.7).
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Установка программы для MOTOROLA C65O

Добро пожаловать в программу установки
Менеджера Телефонной трубки для
MQTQROLACS50. Эта программа установит
Менеджер Телефонной трубки на Ваш
компьютер.

Закройте все припэзвгния Windows перед запукам
программы установим.

Наэшите ОТМЕНА для вывода из программы установки,
закройте все приложения. Нажмите ЛДПЕЕ для
продолжения установки.

ВНИМАНИЕ Эта про грамма защищена в соответствии с
законом об авторском праве и мелдашрздными
соглашениями.

Несанкционированной использование или
распространение этой программы наказывается
штрафом и преследуется по закону.

Дзпзе > j| Отиена

Рис. П.6. Установка Handset Manager

£$ Mobile Action— - Htcrasoft Internet t xpiorer

©зил Орзвка Ё1ад избранное Св»ис

Назм " v ' ; : -' Поио!

Mobile Action has been developing mobile management sortv^are and marketing
Handsel Manager &\\ over Ehe v\orld as Ihe leading brand in this industry. We thank
you for your support and interest in Mobile Action We \-wjlcvoine you to visit our wsb
site and knowrnore about us.

Интернет

Рис. П.7. Переход на страницу загрузки ПО
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После того как вы перешли по вышеуказанной ссылке, вы попадете на страницу
выбора телефона. Здесь вам надо выбрать производителя телефона и его модель
(рис. П.8).

| Hebtte Action— - Microsoft Internet Explorer

Правка Вид Избранное Сервис ^правка

|'0 Пои« - избранное

ZJ

Search

"• s

Search for Product Information & Software

[Motorola

l

Рис. П.8. Выбор производителя и модели

Система автоматически определит набор подходящих программных модулей, ко-
торые вам возможно понадобиться скачать. То есть, если телефон поддерживает
только кабельное соединение, вы сможете скачать софт только для него, а если, на-
пример, еще и ВТ-соединение, тогда у вас будет альтернатива.

В нашем случае (выбран телефон Motorola C650, поддерживающий только соеди-
нение через дата-кабель) будет возможность скачать лишь обновление ПО для
дата-кабеля (рис. П.9).

Обратите внимание на табличку Compatible Devices в верхней части рис. П.9. Здесь
вы можете видеть данные о том, какие операции вы сможете осуществлять с те-
лефоном при помощи скачиваемого ПО.

Здесь можно прочесть, что МА-8870 для Motorola C650 поддерживает работу с те-
лефонной книгой (галочка в поле Phone Book), сообщеними (Message), звуками
(Sound), альбомом (Album), календарем, поддерживает передачу файлов (File Mana-
ger — как раз то, что нам нужно для передачи фотографий на ПК), модем (Modem
Support) и не поддерживает работу с MMS (крестик в поле MMS).
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£айл Оравка

1*4

Any software that is made avatlaote to download from Mobfl* Action websites ('* Software") is

the copynghted worK of Mobile Action. The Software is made available for download safer* for

use by end users ассогйпд to tne License Agreement Without any wntten consent from

МооЗе Action, any reproduction or redstributton of the Software is expressly prohibited by

taw and may result in severe civil and criminal penalties. Violators wif be prosecuted ю the

maximum extent possible.

bacK to dcwnlsad selection

Compatible Devices

;;.. - fanciest fiS Moc«m

Driver Oowntoads

ЗДМНДО'МККС

Рис. П.9. Страница загрузки ПО

эп Ifrternet f xpkMVr

фбрлнное Сервис Справка

j*Jj |2§ И : ^-'-'я»** *•£!

D£ : iwCftfKl!

-4.

Driver Downloads

Same?

Software Downloads

Рис. П. 10. Загрузка Handset Manager
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На странице загрузки нужно скачать, во-первых, драйвер для кабеля (он включа-
ет в себя драйвер модема) — в нижней части рис. П.9 можно видеть табличку для
загрузки этого драйвера.

Для загрузки надо нажать на значок в правой части таблицы (столбец Download).
Далее, загрузив эти драйверы, надо прокрутить страницу немного ниже (рис. П. 10)
и аналогичным образом загрузить ПО Handset Manager (рис. П.10).

После того как ПО загружено, надо установить сначала драйверы, потом — Handset
Manager. Установка этих компонентов соответствует вышеописанной.

Теперь, когда софт установлен, приведу краткое описание его составных частей.
А после этого мы рассмотрим особенности установки Bluetooth-адаптеров и инф-
ракрасных портов от МА.

Возможности ПО от Mobile Action

Подключив телефон к ПК и запустив Handset Manager, вы получаете возможность
работы с вашим телефоном посредством этого ПО. Посмотрите на рис. П.11. Здесь
вы видите рабочее окно Handset Manager.

Рис. П.11. Рабочее окно Handset Manager

В его правой части есть несколько кнопок. Они отвечают за вызов тех или иных
функциональных блоков программы.
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Так, первая кнопка с изображением телефона позволяет вам работать с телефон-
ной книгой. Работа с телефонной книгой осуществляется при помощи кнопок
в верхней части окна программы.

Вторая кнопка позволяет работать с SMS-сообщениями.

Третья — отвечает за синхронизацию органайзера (или календаря) телефона и MS
Outlook.

Четвертая, с изображением палитры, предназначена для создания логотипов
и анимированных заставок для вашего телефона.

Пятая (с барабаном) — для создания сигналов вызова. Здесь вам будет предложе-
но удобное средство для микширования существующих на компьютере сэмплов
(образцов звуков), записи фрагментов с микрофона и загрузки того, что получи-
лось, в телефон.

И наконец, самая нижняя кнопка предназначена для вызова средства управления
файлами. Переключившись в Менеджер Файлов (File Manager), вы увидите два окош-
ка — одно отображает файловую систему вашего телефона, другое — компьютера.

Выделив нужный файл или группу файлов в телефоне (или компьютере) вы мо-
жете скопировать их в компьютер (соответственно, при копировании с компьюте-
р а — в телефон).

Для копирования нужно нажать соответствующую кнопку: со стрелочкой, направ-
ленной вверх — для загрузки файлов в телефон, со стрелочкой, направленной
вниз — для выгрузки из телефона.

Теперь рассмотрим особенности установки средств связи телефона и ПК на осно-
ве Bluetooth и инфракрасного порта.

Установка и особенности настройки инфракрасного порта
Порядок установки коммуникационного комплекта для инфракрасного порта вы-
глядит следующим образом. Установив с прилагаемого к комплекту CD Менеджер
Телефона, вы устанавливаете драйверы для инфракрасного порта. Весь этот про-
цесс сопровождается подсказками системы.

Потом, после перезагрузки компьютера, вам нужно подключить USB-адаптер ин-
фракрасного порта к вашему ПК, система автоматически найдет новое оборудова-
ние и настроит его.

После установки инфракрасного порта вам достаточно активировать функцию
инфракрасной связи в вашем телефоне (порядок включения инфракрасного пор-
та в разных телефонах различается — обратитесь к документации вашего аппара-
та, если не знаете, как это сделать).

Теперь разместите ваш телефон так, чтобы инфракрасные порты двух устройств
находились как можно ближе в условиях прямой видимости. Далее можете запус-
кать Менеджер телефона и работать с вашим аппаратом так, как это описано выше.
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Для некоторых аппаратов требуется особая настройка инфракрасного порта. Пре-
имущественно это касается скорости передачи данных.

Для того чтобы настроить скорость передачи данных (в Windows XP), надо выпол-
нить следующие действия.

1. Перейти по следующему пути: Пуск > Панель управления > Система > Оборудова-
ние > Диспетчер устройств > Инфракрасные устройства > Mobile Action MA-660 USB
Infrared Adapter (наименования пунктов могут быть немного другими, смысл
этого всего заключается в том, чтобы найти в Диспетчере устройств установлен-
ный инфракрасный порт).

2. В настройках инфракрасного порта надо найти вкладку Advanced (Дополнитель-
но) и на этой вкладке отредактировать параметр Maximum Connection Speed (Мак-
симальная скорость соединения).

Итак, когда мы умеем настраивать скорость инфракрасного порта, самое время
рассказать об особенностях настройки некоторых аппаратов. Эти данные собраны
компанией Mobile Action по результатам обращений клиентов.

Так, для установки соединения с LG 7030 рекомендуется установить в свойствах
инфракрасного устройства (в Панели управления) опцию Image Transfer и отключить
параметр Use Wireless Link to transfer images from a digital camera to your computer, пос-
ле чего нажать OK и запускать Handset Manager.

Для телефонов Panasonic X70/X88 рекомендуется устанавливать скорость пере-
дачи данных инфракрасного порта 57 600 бит/с.

Для Samsung E100 рекомендуется устанавливать скорость передачи 115 200 бит/с.

Для Samsung E105/E715/P400/P408/V200/V206/V208 рекомендуется устанав-
ливать скорость передачи данных 57 600 бит/с.

Действуя таким образом, вы можете установить и настроить инфракрасный порт
от МА. Дальше рассмотрим установку Bluetooth-адаптера.

Особенности установки и настройки Bluetooth-адаптера

Установка Bluetooth-адаптера от М А во многом похожа на установку дата-кабеля.

Для начала надо установить драйверы для Bluetooth, потом подключить адап-
тер к ПК.

Затем нужно выполнить поиск Bluetooth-устройств — в Bluetooth-менеджере для
этого служит кнопка Find Bluetooth Device in the Neighborhood (Найти Bluetooth-уст-
ройства). Если в это время поблизости находится сотовый телефон, поддержива-
ющий Bluetooth, система найдет его.

Далее нужно нажать на кнопку Pair With The Bluetooth Device (Соединиться с Blue-
tooth-устройством). После того как соединение будет установлено, можно запускать
Менеджер телефона и работать с аппаратом.
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Для Symbian-телефонов предусмотрена особая процедура установки. Здесь перед
запуском Менеджера телефона необходимо установить на мобильник специальное
приложение maBTAgent, которое следует запустить на мобильном устройстве перед
запуском менеджера на персональном компьютере.

Надо сказать, что процесс установки этого ПО очень хорошо проработан — вы по-
лучите все необходимые инструкции во время инсталляции. К тому же, на CD,
прилагающемся к комплекту, имеется подробная инструкция на русском языке.

Фирменное программное обеспечение
Фирмы-производители сотовых телефонов, как уже было сказано, так же занима-
ются производством ПО. В большинстве случаев это достаточно качественные
продукты, своеобразные и довольно удобные. Они, как правило, могут работать с
любым коммуникационным оборудованием. Если, скажем, софт от Mobile Action
откажется работать со встроенным инфракрасным портом ноутбука, то фирмен-
ный софт обычно не грешит такой разборчивостью.

Многие производители выкладывают свое ПО для свободного скачивания, считая,
что если уж человек приобрел их телефон, то программы к нему он может скачать
бесплатно.

Неплохим вариантом подключения сотового к ПК является использование фир-
менных коммуникационных комплектов. Порой они недешевы, но вероятность
того, что все заработает с первого раза, очень высока.

Кстати, покупая дата-кабели и ПО к ним, старайтесь делать покупки в крупных
торговых центрах, центрах абонентского обслуживания местных операторов свя-
зи и в других подобных местах, заслуживающих доверия. Так выше вероятность
того, что в случае возможных неприятностей с кабелем вы получите сервис надле-
жащего уровня и консультации специалистов.

Скажу еще о консультациях. Если что-то не получается — задавайте вопросы
в сервисном центре, читайте документацию. Главное помните, что работа с ком-
пьютером, в особенности, когда речь идет о подключении к ним других устройств,
установке драйверов и ПО, редко когда может быть описана четкой инструкцией.
Поэтому учитесь мыслить творчески и не бояться трудностей.

Ниже, в табл. П.4, будут даны ссылки на сайты производителей сотовых теле-
фонов.

Таблица П.4. Сайты производителей сотовых телефонов

Наименование компании

Alcatel

Benefon

LG

Сайт

http://www.alcatel.com/, http://www.alcatel.ru/

http://www.benefon.com/, http://www.benefon.com/russia/

http://www.lge.com, http://ru.lge.com/
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Наименование компании

Motorola

Nokia

Panasonic

Sagem

Samsung

Sendo

Siemens

Sony Ericsson

Voxtel

Сайт

http://www.motorola.com/, http://www.motorola.com/ru/

http://www.nokia.com/, http://www.nokia.ru/phoncs/models/

http://www.panasonic.com/, http://www.panasonic.ru/

http://www.sagem.com/

http://www.samsung.com/, http://www.samsung.ru/

http://www.sendo.co.uk/

http://www.sicmens.com/, http://www.siemens.ru/

http://www.sonyericsson.com/

http://www.voxtel.ru/

Большинство производителей сотовых телефонов имеют русскоязычные сайты.

Такие сайты, как правило, содержат информацию о локализованных версиях про-
дукции, аксессуаров, данные о сервисном обслуживании и так далее.

Большинство из вышеперечисленных сайтов содержит также ПО для свободной
загрузки.

Каталог камерофонов
Теперь, когда мы с вами ознакомились с сайтами производителей сотовых, пришло
время дать краткую характеристику актуальных на данный момент фототеле-
фонов.

В нижеприведенной табл. П.5 представлены камерофоны различных производи-
телей с характеристикой их фотовозможностей.

Таблица П.5. Каталог камерофонов

Марка и модель аппарата

Alcatel

Alcatel One Touch 556

Alcatel One Touch 557

Alcatel One Touch 735

Alcatel One Touch 735i

Alcatel One Touch 756

Alcatel One Touch 835

LG

LG G5600

Разрешение матрицы

640x480

640x480

322x288

322x288

640x480

640x480

640x480

Продолжение
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Таблица П. 5 (продолжение)

Марка и модель аппарата

LG G7050

LG G7100

LGL1100

LG G7070

LGG7120

LG G8000

LG T5100

Motorola

Motorola C650

Motorola E365

Motorola E390

Motorola E398

Motorola MPx 100

Motorola MPx220

Motorola RAZR V3

Motorola V220

Motorola V300

Motorola V500

Motorola V600

Motorola V80

Nokia

Nokia 3200

Nokia 3220

Nokia 3230

Nokia 5140

Nokia 6020

Nokia 6 170

Nokia 6220

Nokia 6230

Nokia 6260

Nokia 6600

Nokia 66101

Разрешение матрицы

640x480

640x480

640x480

640x480

640x480

352x288

1,3 Mpix

640x480

640x480

640x480

640x480

1,3 Mpix

1,3 Mpix

640x480

640x480

640x480

640x480

640x480

640x480

352x288

640x480

1,3 Mpix

352x288

352x288

352x288

352x288

640x480

640x480

640x480

352x288
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Марка и модель аппарата

Nokia 6630

Nokia 6820

Nokia 7200

Nokia 7250i

Nokia 7260

Nokia 7270

Nokia 7280

Nokia 7600

Nokia 7610

Nokia 7700

Nokia 77 10

Panasonic

Panasonic EB-GD87

Panasonic EB-X70

Panasonic EB-X700

Pantech

Pantech G500

Pantech G600

Pantech G900

Pantech G800

Pantech Gil 00

Samsung

Samsung SGH-D410

Samsung SGH-D500

Samsung SGH-E300

Samsung SGH-E330

Samsung SGH-E600

Samsung SGH-E630

Samsung SGH-E700

Samsung SGH-E7 10

Samsung SGH-E800

Samsung SGH-E810

Разрешение матрицы

1,3 Mpix

352x288

640x480

352x288

640x480

640x480

640x480

640x480

1 Mpix

640x480

1,3 Mpix

132x176

132x176

640x480

640x480

640x480

640x480

640x480

1,3 Mpix

640x480

1,3 Mpix

640x480

640x480

640x480

640x480

640x480

640x480

640x480

640x480

Окончание



202 * Приложение

Таблица П.5 (окончание)

Марка и модель аппарата

Samsung SGH-E820

Samsung SGH-P100

Samsung SGH-P400

Samsung SGH-P5 10

Samsung SGH-P730

Samsung SGH-X600

Samsung SGH-X610

Siemens

Siemens C65

Siemens CFX65

Siemens CX65

Siemens CX70

Siemens M65

Siemens MC60

Siemens S65

Siemens SL65

Siemens ST55

Siemens ST60

Siemens SX1

Sony Ericsson

Sony Ericsson K500i

Sony Ericsson K700i

Sony Ericsson FSOOi

Sony Ericsson P900

Sony Ericsson P910i

Sony Ericsson S700i

Sony Ericsson T610

Sony Ericsson T630

Sony Ericsson V800

Sony Ericsson ZSOOi

Sony Ericsson Z600

Разрешение матрицы

640x480

352x288

352x288

640x480

l,3Mpix

640x480

640x480

352x288

640x480

640x480

640x480

640x480

352x288

1,3 Mpix

640x480

640x480

640x480

640x480

640x480

640x480

640x480 f

640x480

640x480

1,3 Mpix

288x352

640x480 (интерполированное)

1,3 Mpix

640x480

288x352
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Вы можете заметить, что подавляющее большинство аппаратов, представленных
в таблице, имеют разрешение светочувствительной матрицы, равное 640x480 пик-
селов.

Такое разрешение иногда называют VGA, а если перевести его в мегапикселы, то
выйдет 0,3 Mpix. Данное разрешение является на сегодняшний день наиболее ак-
туальным на российском рынке. Оно позволяет заниматься мобилографией без
всяких ограничений.

Все реже встречаются телефоны с разрешением 352x288. Как правило, это либо
достаточно ранние модели, либо примеры обновления аппарата путем оснащения
его цифровой камерой. Это разрешение, кстати, тоже вполне подходит для мобиль-
ной фотографии.

Кстати, чисто визуально съемка, например Sony Ericsson Z600, который имеет как
раз такую матрицу, выглядит очень хорошо. И я не могу сказать, что снимки, по-
лученные тем же Z600, выходят плохими из-за маленького разрешения матри-
цы. Более того, если вам хочется сделать из фотографии 352x288 снимок 640x480,
то при некоторой доле старания вы вряд ли заметите серьезную разницу.

Как вы помните, мы делали даже более серьезную интерполяцию, когда рассмат-
ривали изменение размеров изображения. Здесь решающую роль играет исходное
качество фотоснимков и сюжет. Кстати, у того же Z600 снимки хорошо подходят
для увеличения.

Если говорить о существующих аппаратах и разрешениях, то для чисто мобильно-
го использования наиболее логичным разрешением матрицы цифрового фотоап-
парата, встроенного в мобильник, было бы такое, которое максимально приближа-
ется к разрешению его дисплея.

По этому принципу созданы некоторые камерофоны от Panasonic. И, если гово-
рить о процессе съемки и о том, как изображение смотрится на экране, то надо от-
метить его достаточно высокое качество.

Видимо, сказывается то, что нет необходимости интерполировать изображение
и таким образом немного ухудшать его качество. Правда, новые модели Panasonic
комплектуются уже наиболее популярной матрицей — 640x480.

Несмотря на то что 640x480 вполне соответствует нуждам мобилографии, рынок
движется к телефонам с большими разрешениями: 1 Mpix, 1,3 Mpix, 2 Mpix, 3 Mpix,
6 Mpix. Камерофон с разрешением матрицы больше 1,3 Mpix пока вызывает у мно-
гих удивление. Оснащенный качественной, по сравнению с обычной «камерофон-
ной>>, оптикой и большой матрицей такой аппарат становится прямым конкурен-
том недорогих любительских цифровиков.

Причем если учесть то, что за оптику для фотомобильников берутся такие фир-
мы, как Canon (я уже не говорю о собственных разработках ведущих производи-
телей сотовых), то скоро грани между любительскими цифровиками и продвину-
тыми камерофонами будут стерты окончательно.
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Думается, самое главное — это чтобы гонка мегапикселов не превратила фототе-
лефон в цифровик и не разрушила очарование 0,3-мегапиксельной мобилографии.
Хотя это вряд ли произойдет.

По всей видимости, через пару лет сегодняшние камерофоны 640x480 превратят-
ся в раритетные исторические ценности. А в 3-мегапиксельных фотомобильниках
будет предусмотрен «режим совместимости» с нашими сегодняшними аппарата-
ми. Такой «режим совместимости», наверное, будет включать в себя интерполя-
цию 3-мегапиксельного изображения до 640x480, программное ухудшение каче-
ства картинки и сильное JPEG-сжатие.

Кстати, довольно скоро могут появится фотокамеры со встроенными мобильни-
ками. Почему этого до сих пор не произошло, для меня остается загадкой. Но, ви-
димо, еще немного, и такое чудо техники все-таки появится на свет. Зеркальная
полупрофессиональная фотокамера со встроенным мобильным телефоном — зву-
чит неплохо.
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